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CHAPTER 1  

GPS-X Preview 

STARTING GPS-X 

Start GPS-X by either double-clicking on the GPS-X v8.0 icon on the 

desktop, or by accessing the “Hydromantis GPS-X 8.0” program group in the 

Windows “Start Menu”, and selecting “GPS-X 8.0”   

ELEMENTS OF THE MAIN WINDOW 

 The basic elements of the GPS-X window are: 

• Title bar 

• Menu bar 

• Toolbar 

• Drawing Board 

• Simulation Toolbar (in Simulation Mode only) 

• Modelling/Simulation toggle button 

A short description of each of these elements is provided below. 

TITLE BAR 

In addition to the buttons that control the appearance of the main window; the title bar area 

contains information about the version of GPS-X, the current layout being edited, and the library 

that this layout is using. 

GPS-X 8.0  [<layoutname>] - <library> 

MENU BAR 

Most of the features of GPS-X are accessed from one of these six menus. 

• File 

• Edit 
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• View 

• Layout 

• Tools 

• Library 

• Help 

 

Figure 1-1 –Menu Bar 

A brief description of each menu and their associated item(s) is provided below. 

FILE MENU 

The File menu contains items for performing file handling and manipulation. 

 

Figure 1-2 - File Menu 

New 

Create a new session with a blank drawing board. 

Open… 

Opens a file browser where you can browse to and select an existing GPS-X layout file.  
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A preview pane is on the right which shows you the drawing board image of the selected 

layout file. 

The Files of Type drop down box can be used to show only GPS-X layout files (.lyt 

extension) or only GPS-X archived layouts (.zip extension). 

Sample Layouts… 

Allows you to select from the 50+ pre-configured layouts that come with a licensed 

version of GPS-X.  

 

Figure 1-3 – Sample Layouts Dialog 

Close 

Closes the current layout. If any changes have been made, you are prompted about saving 

or discarding the changes. 

Save 

Saves the current layout to a file. This command will overwrite the existing layout file 

having the same name (shown in the title bar) with the current layout information. 

Save As… 

This opens a file browser, which allows you to enter a layout file name and location 

before saving. The current layout information is saved to the specified file. 

Archive 

Creates an archive file (i.e. zip compatible file) of all the GPS-X files pertaining to the 

layout currently open. This is useful when transferring files between computers, or when 

sending files as attachments via email. 
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History… 

A tool for managing multiple versions of a GPS-X layout. The option “Enable layout 

history” must be checked in the View > Preferences > Layout menu to allow access to 

the layout history management tools. Further details on the History menu can be found in 

CHAPTER 2 (Layout History Database)  

Report… 

Create a report with information about the current layout. See the Generating a Report 

section in CHAPTER 7 for more information. 

Print Layout 

Used to send an image of the layout to a printer. 

Database Setup 

See the Using an SQL Database with GPS-X section in CHAPTER 13 for details. 

Recent File List… 

A list of recently-opened layouts is shown at the bottom of the File menu. The number of 

layouts shown here can be set in the View > Preferences >Layout tab, under the Settings 

header. 

Exit 

Exits the program.  You will be prompted to save or discard any unsaved changes to the 

layout. 

EDIT MENU 

The Edit menu includes items related to manipulation of objects on the drawing board. 

 

Figure 1-4 - Edit Menu 
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Cut 

Cuts the currently selected process(es) from the drawing board and places it on the 

clipboard. 

Copy 

Copies the currently selected process(es) from the drawing board and places it on the 

clipboard. 

Paste 

Pastes process(es) from the clipboard onto the drawing board. 

Delete 

Deletes the currently selected process(es) from the drawing board. 

Rotate 

Rotates the currently selected process(es) 90 degrees in the counterclockwise direction. 

Mirror 

Horizontally flips the currently selected process(es). 

Find 

The Find menu item brings up the “Find” dialog, which can be used to search for GPS-X 

variables by entering part of the plain text or cryptic variable name.  

VIEW MENU 

The View menu button provides control over the look of the drawing board and how the 

object icons are displayed. 

 

Figure 1-5 – View Menu 
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Preferences 

The Preferences menu item brings up the “Preferences” dialog, which contains a series 

of tabbed sheets including the Layout, Input/Output, Build, and Python tabs. This 

window is used to set the default preferences for new layouts including the default library 

at start up: 

Layout details on default libraries, directories, etc., at startup, as well 

as settings for the look and feel of objects on the GPS-X 

drawing board. 

Input/Output default input controller and output graph types, plus details on 

report generation options. 

Build  details on FORTRAN compiler and ACSL model build options. 

Python Details on the Python instance being used by GPS-X 

Toolbars → Process Table 

Gives you the ability to hide/show the process table. 

The process table consists of a collection of unit processes and control points that are 

used to build the model layout for a wastewater treatment plant. One or more copies of 

each object in this table can be dragged onto the drawing board. 

The objects are arranged in groups of similar unit processes, such as Primary 

Treatment, Suspended Growth Processes, and Biosolids Treatment. Click on the 

group name to open the group and display the available objects. 
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Figure 1-6 – Process Table 

Zoom 

The Zoom menu item contains a series of options for adjusting the level of zoom applied 

to the drawing board. The total drawing board consists of a grid 32 blocks wide by 32 

blocks high, with each block capable of containing one object icon. The displayed area is 

normally only a small portion of the total area available, as most models require fewer 

than 20 layout objects. 

The Locator option will open a window which provides a convenient way of zooming in 

or out of the drawing board. To zoom in on a specific region of the drawing board, click 

and drag the pointer within the Locator window around the area of interest. If the 

selected area is larger than the area displayed on the drawing board, the effect will be to 

zoom out. 

The Zoom to Selection/Plant option is used to automatically zoom on the plant, such 

that an empty block appears around the edge of the plant. If an area has been selected on 
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the drawing board, this option will zoom in such that the selected area fills the drawing 

board. 

The Zoom Out option is used to zoom the drawing board out by adding a row of blocks 

to each edge of the drawing board. 

The Zoom In option is used to zoom in on the plant by removing a row of blocks from 

each edge of the drawing board.  

Display Grid 

Gives you the ability to hide/show the grid lines on the drawing board. 

Display Labels 

Hides/shows the object and/or stream labels. 

Each process’s connection stream on a layout is automatically assigned a label.  

In contrast, the processes themselves do not automatically receive a label, but may be 

assigned a label by the user. It is sometimes important to view the labels assigned to an 

object or connection point.  

Window Selection 

Used to select, bring forward, and give focus to any window in the modelling or 

simulation environment. It is useful for retrieving windows that may have fallen behind 

other windows during the setup of graphs and controllers. 

LAYOUT MENU 

The Layout menu includes items used to set global simulation parameters, user-defined 

customization code, and common plant wide properties. 

 

Figure 1-7 – Layout Menu 

General Data 

The General Data menu item contains a series of sub-menus including the System, User 

and User Files sub-menus.  
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The System sub-menu is used to gain access to the global simulation parameters, such as 

parameters related to the operation of the steady-state solver and the optimizer. 

The User sub-menu is used to gain access to the user-defined variables. 

The User Files sub-menu is used to define custom code and user-defined variables. 

Site Properties 

The Site Properties item allows users to customize the physical input parameters of the 

plant (Plant Site Properties tab) and the simulation date (Simulation Setup tab). 

Additional plant information can also be saved under the Plant Information tab.  

Data Files 

The Data Files menu is only available in Simulation Mode and is used to manage the 

files used in the active scenario (see Using Scenarios).  From this menu you create new 

datafiles, add existing data files to the scenario or remove data files from the scenario. 

You can also edit data files, but if the file is used in multiple scenarios, it will change the 

information in all of them. 

TOOLS MENU 

The Tools menu includes items related to the setup and use of a plant model. 

  

Figure 1-8 – Tools Menu 

Define 

Allows you to interactively specify an equation for calculating one of six different layout-

wide variables including the Solids Retention Time (SRT) and Food/Microorganism 

ratio (F/M). In practice, it is found that formulation of the defining equations for these 



16 Specifying Object Data 

GPS-X User’s Guide 

variables is plant specific. The Define feature allows you to interactively specify how 

these variables are to be calculated for a specific layout. 

Build 

There is an “auto-build” feature which knows when to build and rebuild model code. 

However, if users wish to force a model build, it can be done from this menu. 

This translates the flow sheet to binary executable code. GPS-X uses a special procedure 

to convert the graphical images in the drawing board first to a high-level simulation 

language (ACSL) code and then to a FORTRAN binary executable program.   

Analyze 

(This feature is available only to those who have purchased the Analyzer module) 

 

Figure 1-9 – Analyze Menu 

Used to test the ‘model validity’ by conducting sensitivity analyses on selected 

parameters.  

The Analyzer is turned ‘on’ by selecting the Analyze Mode checkbox in the Analyze sub 

menu, or by clicking on the Analyze button on the toolbar. 

With the Analyzer active, four options exist for the analysis: 

Steady State conducts a steady state simulation for different values of 

independent variable 

Phase Dynamic calculates state variables at a specified point in time for 

different values of the independent variable. 

Time Dynamic  conducts a dynamic simulation for each value of an 

independent variable for a specified time interval. 
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Monte Carlo conducts a Monte Carlo analysis of an independent variable for 

a specified range and probability distribution. 

Optimize 

(This feature is available only to those who have purchased the Optimizer module) 

 

Figure 1-10 – Optimize Menu 

A flexible, dynamic optimization package for evaluating important model parameters. 

Given appropriate dependent data, and a user-defined objective function, GPS-X can 

identify an optimal value for a selected model parameter.  

The Optimize sub-menu controls the set up and operation of the optimization tools.  

In Modelling mode, selecting the Optimize Mode will start a wizard that will set you 

through the process of setting up the optimization. 

In Simulation mode, selecting the Optimize Mode will inform the program that the 

simulation that is about to be performed should use the optimizer feature. 
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Optimizer Setup Wizard 

 

Figure 1-11 – Optimizer Setup Wizard 

An optimizer setup wizard is used for specifying target variables, optimize variables, and 

optimizer settings. Once these are specified, you must switch to simulation mode where 

GPS-X automatically creates a input parameter menu with the optimized parameters and 

creates an output graph of the target variables.  

Type 

Two options are available from this sub-menu: 

Time Series optimizes based on a set of one or more time series of 

dependent data 

DPE (Dynamic Parameter Estimation) – optimizes a moving time 

window of data for use in on-line model calibration. (This 

feature is available to those who have purchased the Advanced 

Tools optional module.). 

The data requirements and form of the objective function depend on the type of 

optimization being performed. 

Objective Function 

You have the flexibility of specifying the form of the objective function to use. This sub-

menu contains several objective function options including: 
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Absolute Difference creates an absolute error form of the objective 

function. 

Relative Difference creates a relative error form of the objective function. 

Sum of Squares creates and absolute sum of squares error form of the 

objective function. 

Relative Sum of Squares creates a relative sum of squares error form of the 

objective function. 

Maximum Likelihood creates a maximum likelihood from of the objective 

function. 

In the objective functions, the errors associated with a target variable are the differences 

between the predicted values and the observed values. 

Target Variables 

This menu item displays a list of the target variables selected for the optimization. You 

can use this item to verify the target variable names. 

Python Script Manager 

This menu item brings up the “Python Script Manager” Window. The Python Script 

Manager is only available when GPS-X is in Simulation mode. This window is used to 

edit or run existing Python scripts in GPS-X and create new Python scripts. 

LIBRARY MENU 

  

Figure 1-12 – Library Menu 
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The library menu is used to select/view which library the current layout used.  View the 

Technical Reference Manual for more information about libraries. 

HELP MENU 

 

Figure 1-13 – Help Menu 

Manuals 

The Manuals menu item contains links to the GPS-X companion literature. Selecting the 

User’s Guide, Tutorial Guide, Model Developer Guide, and Technical Reference will 

display the corresponding GPS-X manual in electronic format using Adobe Acrobat 

Reader. 

Quick Tips 

The Quick Tips menu item will open a GPS-X Quick Tip. These tips highlight GPS-X 

features you may be unaware to help you enhance your GPS-X user experience. 

Online Help & Support 

The Online Help & Support menu will link you to Online Help and Support page of the 

Hydromantis website.  

License Management 

The License Management menu item contains sub-options including License 

Activation…, License Transfer… and View License. 

The License Activation… menu item is used to activate a product key that you’ve 

received from Hydromantis. 

The License Transfer…  menu item opens a window with instructions on how you can 

transfer your GPS-X license between computers. 
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The View License… menu item opens the local website where you can view any current 

licenses that are installed on your computer, their expiry date, and various other settings. 

Check for Updates 

The Check for Updates menu item will verify that you are using the latest version of 

GPS-X   

About  

The About menu item will display information on this version of GPS-X. 

MAIN TOOLBAR 

The buttons are listed below. Not all of the buttons are available in both Simulation and 

Modelling Modes. For information about the actions that they perform, see the corresponding 

menu item description in the previous section. 

  
New Layout 

 Open Layout 

 Save Layout 

 Cut 

 Copy 

 
Paste 

 
Rotate 

 
Mirror 

 Zoom to Selection/Plant 

 Display Labels 

 Define 
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 Analyze 

 Optimize 

Units: SI/US Default Unit Set 

 Data Files 

 Report 

DRAWING BOARD 

The drawing board is the large area in the center of the main window. This is where you define 

your treatment plant process flow diagram.  See Creating Model Layouts in CHAPTER 2 for a 

description of how to do that. 

 
 The Site Properties button can be found in the upper left-hand corner of the drawing board. See 

Site Properties in CHAPTER 4 for a description of its use. 

 

MODELLING/SIMULATION MODE 

 

Figure 1-14 – Modelling/Simulation Mode Buttons 

The Modelling/Simulation Mode button allows the user to switch between the two modes. It 

also activates the automatic rebuilding of layouts (if applicable). 

Modelling Mode For creating and/or editing models. Users must be in 

Modelling Mode to draw and change models on the 

drawing board, and define new variables or source objects. 

Any user-defined code (see Customizing GPS-X) must be 

entered while in this mode. 

Simulation Mode For using the model, and doing analyses. Users must be in 

Simulation Mode to run the model, create and use 

scenarios, create and use input and output graphs, and use 

the analyze/optimize functions. The GPS-X layout drawing 
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board will appear with a grey background when in 

Simulation Mode. 

SIMULATION TOOLBAR 

The Simulation Toolbar is only displayed in Simulation Mode.  It is at the bottom of the main 

window. 

 

Figure 1-15 – Simulation Toolbar 

Simulation Progress Controls 

 
Start Runs the simulation from the beginning. 

 
Resume If a simulation has been paused, this will resume the simulation 

from that point.   

If a simulation has reached it’s ‘Stop Time’, then you can 

increase that value and then continue the simulation. 

 
Pause Pause a simulation. 

Steady State 

This checkbox controls whether or not to use the steady state solver. 

Convergence/Simulation Progress Bar 

This progress bar shows either the steady state convergence percentage (grey) or the 

simulation progress (blue).  

 

Figure 1-16 – Convergence/Simulation Progress Bar 

Scenario 

This menu contains scenario-related commands including the commands to select, create, 

delete and show the contents of scenarios. See Using Scenarios section in CHAPTER 8 

for more information. 
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Stop Time/Communication/Delay 

This area of the simulation toolbar allows you to edit the stop time, communication 

interval, and the delay value.  These three parameters can be changed interactively as the 

simulation proceeds.  

Click on the label to switch between the three variables. 

Stop Time is the amount of time that the simulation will run before stopping. This value 

is also used to set the maximum time on time series graphs. 

Communication interval is the period of time between communication with the model 

and the graphical interface.  This interval affects both the spacing between data points on 

a graph and updating the model with the values of the input controllers.  It can be any 

positive value greater than zero. 

Delay is an artificial delay inserted in the simulation routine, which slows the simulation. 

For some models, this may be necessary to allow enough time to change controls and 

observe responses. 

Simulation Control 

 
This menu contains various settings regarding the simulation and some different low-level 

commands that can be sent to the model.  For more information about these options, see 

the Simulation Control section in CHAPTER 8.   

Reset 

 
The Reset button can be used to clear all the previous simulation iterations and results. This 

feature keeps all the layout settings but resets the Initial Conditions. Most people do not 

need to use this feature because simply starting the simulation over again (by pressing the 

Start button) will begin the simulation in an adequate place. 
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CHAPTER 2  

Creating Model Layouts 

LAYOUTS 

GPS-X layouts contain data on the physical objects being modeled. Among other things, these 

data include the model(s) being used, physical dimensions, and connectivity between unit 

processes. The layout defines the structure of your plant model, including the kinds of plant 

behavior you can model, the degree of flexibility in setting up simulations, the model parameters 

you can change, and the response variables you can plot. 

You can create as many layouts as you wish, with as many different configurations as you would 

like to model. Layouts and their associated data can be saved for later use, and the information in 

the layout can be exported for reporting purposes. This information and the layout schematic can 

be printed or copied to other documents so that you can prepare reports and papers. The layout 

contains all the information needed to reproduce a session. 

Layouts usually correspond to and are prepared from the treatment plant process flow diagram. 

To prepare a layout of a treatment plant, you will need to know the configuration of the plant, and 

the unit processes that make up the plant. It is a good idea to refer to your plant diagram as you 

examine the procedures for building a GPS-X layout. 
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Opening an Existing Layout 

 To open a GPS-X layout file, complete the following steps: 

1. Click on the Open button.  

 

Figure 2-1 – Open File Browser 

2. Use the File Browser to navigate and select the desired GPS-X layout file. 

3. Click the Open button. The layout will be opened. 

Before opening the model layout, GPS-X checks to see if the current layout has been saved. 

If the layout has not been saved, a warning dialogue box is displayed which provides the 

opportunity to save the layout. 

If the layout that you are opening contains variables that are not defined in the applicable 

GPS-X library, a pop-up text form will be displayed that indicates the variables were mapped. 

Creating a New Layout 

A new layout is started by selecting New from the File menu, or by clicking on the New 

button on the tool bar.  

Saving a Layout 

Before getting started on the construction of a layout, it is best to save the layout with a 

new file name. As you make changes to the layout, you can select Save from the File 

menu or click on the Save button on the toolbar to update the layout file. If at any time, 

you want to save the layout to a different file name, select the Save As… item. 
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To create a new layout, complete the following steps: 

1. Open the File menu and select the Save As… item.  

2. Use the file browser to navigate to the directory where the file is to be saved. 

3. In the File Name text entry field, enter a layout name. Layout names can 

consist of any alpha-numeric character (among other exclusions, spaces and 

periods are not allowed). You do not need to append a file extension as one is 

automatically added to the layout name you enter (.lyt) 

4. Click on the Save button. The layout will be saved and the layout name will be 

displayed on the main window’s title bar.  In general, it is a good idea to save 

your work often to avoid any loss of information. 

GPS-X saves all the information needed to restore your modelling session to the state it 

was in when you last saved the file. This includes the layout objects and their 

connectivity, any controls you may have defined and the graphical output you specified. 

There are several other data files, which are sometimes used with a layout, and in most 

cases, these are associated with the layout name rather than stored within the layout file. 

These additional files include raw data files, code additions and output data files. Details 

on these other files are provided in subsequent chapters. 

SELECTING AND PLACING OBJECTS 

You are now ready to begin building a model layout. GPS-X allows you to build models 

graphically by selecting object icons from the objects in the Process Table and placing them on 

the drawing board. The resulting graphical representation of the plant is later converted to a 

dynamic model. To be able to select from the objects, you must first display the process table. 

To hide/show the process table: 

1. Select the View > Toolbars > Process Table menu item. The Process Table 

window is displayed on the left-hand side of the drawing board.  The objects are 

grouped into collections of like unit processes. Click on the group name (i.e. 

“Attached Growth Processes”) to open the group. 

A distinction is made between object, icon, and model. Object is used to refer in general 

to a unit process or control point (including the icon and model), icon is used to refer to 

the picture, and model refers to the underlying mathematical formulae. This distinction is 

important for understanding the way layout information is stored and how you can tailor 

GPS-X to include your own icons and models. A complete examination of these topics is 

given in CHAPTER 11. 

Each object has one or more models. You manipulate icons on the drawing board to build 

a schematic representation of your plant. The icons in the layout are images, which serve 
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as a visual reminder of the type of object being modeled rather than the model itself. 

Each icon is linked to one or more models, which are manipulated in the preparation of 

the full plant model. 

 

Figure 2-2 – A Distinction is made between an Object and its Attributes 

Once the process table is displayed, you can begin to place objects on the drawing board. 

To select an object and place its icon on the drawing board: 

1. In the Process Table, left-click on any object group. 

2. Press and hold the left mouse button on any object icon and drag the object to 

the drawing board. 

3. Release the mouse button. A copy of the object’s icon will be dropped onto the 

drawing board. 

You can continue to drop object icons onto the drawing board by repeating this operation. 

Notice that the drawing board is divided into equally sized cells.  The entire drawing 

board area is a 32x32 grid.  Each of the cells can contain one process icon. Select the 

Display Grid button on the toolbar to see the gridlines. 

Once an icon has been dropped onto the drawing board area, an alternative way to add a 

new object is to select the object in the drawing board area by clicking and dragging the 

mouse across the object of interest. This operation shades the selected grid cells a light 

blue color. Once an area of the drawing board is selected it can be cut, copied or deleted 

as required. If the objects were cut or copied, they can be pasted to a different area of the 

drawing board to create exact copies of the originals (including any attributes you may 

have changed in the originals).  Changing object attributes is discussed in CHAPTER 4. 

CONNECTING OBJECTS 

When building a plant layout, you first decide which object(s) to model and then place the 

appropriate icons on the drawing board as described in the previous section. Having done so, it is 

necessary to establish the flow paths between process objects. This connectivity is important as it 

is needed by GPS-X to develop the material balances from which dynamic model equations are 

prepared. 
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Icon Connection Points 

Each icon has a number of connection points. These points are easily recognized since 

they are drawn as horizontal or vertical arrows projecting from the icon.  

Numbers are assigned automatically to connection points as their labels.  Each stream 

label must be unique to the layout. You can easily change these labels as described in the 

Labels section of CHAPTER 4. 

After the icon is placed on the drawing board, the connection points become active, that 

is, if you move the mouse pointer over a connection point, the arrow pointer disappears 

and a connecting arrow is drawn at the connection point. 

As shown in Figure 2-3, when the mouse pointer is placed over a connection point, a 

small connecting arrow is displayed (right side of plug flow reactor, connection point 3).  

 

Figure 2-3 - Model Layout Showing Connection Points  

(Reactor Effluent Connection Point is Selected) 

Specifying a Flow Path 

A flow path is specified by joining the connection points of two objects. To specify a 

flow path, complete the following steps: 

1. Move the mouse pointer to the icon connection point, which you would like 

to be the flow source. The mouse pointer changes to a connection arrow when it 

is over an icon connection point. 

2. Press the left mouse button and drag a connecting pipe to the icon 

connection point which you would like to be the flow terminating point. The 

mouse pointer changes to a connection arrow when it is over an icon connection 

point. 

3. Release the mouse button. With this action, a flow path has been defined. 

To delete a flow path, complete the following steps: 

1. Move the mouse pointer over the beginning or ending connection point of 

the flow path you would like to delete. The mouse pointer changes to a 

connection arrow when it is over an icon connection point. 
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2. Press the left mouse button and drag a connecting pipe to an empty grid cell. 

3. Release the mouse button. You will be prompted to confirm the deletion of the 

flow path. 

To move a flow path, complete the following steps: 

1. Move the mouse pointer over the beginning or ending connection point of 

the flow path you would like to move. The mouse pointer changes to a 

connection arrow when it is over an icon connection point. 

2. Press the left mouse button and drag a connecting pipe to the new 

destination of the flow path. 

3. Release the mouse button 

Moving Flow Paths Around 

Once a flow path has been correctly drawn on the drawing board, the location of the line 

connecting the two objects can be moved around to make the diagram clearer and/or less 

cluttered. 

To move an existing flow path while maintaining the connections to the objects, complete 

the following steps: 

1. Place the mouse pointer over the flow path line somewhere between the 

beginning and ending connection points. The pointer will change to an up/down 

or left/right arrow, depending on the orientation of the line. 

2. Hold the left mouse button while dragging the line to another location. 

3. Release the mouse button. This action can be done as many times as required to 

create as many corners as needed. 

Normally, you will want to place the desired object icons on the drawing board and then 

specify the flow paths. GPS-X contains logic to guide you in selection of appropriate 

flow paths. For example, GPS-X does not allow flow paths which initiate at an icon input 

and terminate at an icon output. Similarly, you cannot have flow paths initiating and 

terminating on the same icon. This logic prevents the creation of incorrect layout 

diagrams and ensures that a valid model can be prepared. It is not necessary to specify 

flow paths to every connection point on every icon. For example, in some layouts, one or 

more objects have zero influent flow, and therefore, do not have any flow path connected 

to the influent connection point. 
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Flow Path Color 

The color of the flow path is used to quickly convey information about the stream. There 

are three possible colors that a stream can be: Blue, Brown and Black. 

Streams that are colored Blue represent flows of treated water. This includes any streams 

treated by a tertiary treatment object, streams coming from a clarifier overflow or a water 

influent. 

Streams that are colored Brown are used to represent the flows of wastewater. This 

includes any clarifier underflow lines, suspended growth effluents and wastewater 

influents. 

Streams that are colored Black are used to represent any streams where the treatment 

quality of the water cannot be immediately be determined from looking at the object. 

This includes flow combiners, flow splitters and black box objects.  

EDITING THE LAYOUT 

At some point in building a plant layout it may become necessary to add or remove object icons 

and flow paths, either to investigate alternative layouts or correct an existing one.  

 

Figure 2-4 –Layout of a Conventional Activated Sludge Plant 

Figure 2-4 shows the completed layout for a conventional aerobic suspended (activated sludge) 

treatment process. The layout consists of a single influent, a primary settler, a plug-flow reactor, a 

secondary clarifier and an effluent outfall structure. Wastage flows from the primary settler and 

the plug flow reactor are connected in the layout to a combiner object, which consolidates the 

flows. 

Consider the types of editing operations you might want to perform given a layout such as the one 

in Figure 2-4. All or part of the layout may be similar to another plant process train that you 

would like to model, so it would be convenient to copy this portion. If you want to compare 

layouts with different types of reactor models, you might want to replace the plug-flow reactor 

with a complete mix reactor. Not all plants waste from the aeration tank, so you may want to 

delete this flow path. Some plants don’t have a primary settler, or you might want to compare 

plant performance without one, in which case you would want to delete this unit process icon. 
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The placement of icons may not be exactly as you would like so you may want to move one or 

more of the icons. In some cases, it might be necessary to move a flow path, that is, change the 

initial and/or terminal points. For example, you might want to move the wastage flow path so that 

wastage occurs from the secondary clarifier rather than the plug flow reactor. 

In some cases, editing changes affect the model structure; whereas, in other cases, the changes are 

only cosmetic. For example, replacing a plug flow reactor with a completely mixed reactor 

significantly changes the plant model, but moving the same reactor to another location on the 

drawing board (assuming the flow paths are not also changed) does not affect the formulation of 

the model. 

A cosmetic change, which is often useful, is rotation. GPS-X provides facilities for changing the 

orientation of object icons in order to modify the placement of flow streams. GPS-X uses a 

special mapping technique to draw the flow paths between object connection points. Rotating an 

icon can result in improved placement of the flow paths for complex drawings containing many 

flow paths. 

Some editing operations can be done in blocks. This is convenient when making large changes to 

the layout. GPS-X allows block copy, cut and paste, and block delete. If you have several parallel 

trains that are identical, you can use the block option to clone a single train and create the 

remaining trains. Large parts of a layout can be removed by dragging out a region in the block-

delete, and you can easily move a large block to a different location using block-cut and paste. 

These operations are described in detail below. 

Selecting One or More Drawing Board Objects 

To select a single object: 

1. Select the object in the drawing board area by clicking the 

mouse on the object of interest. This operation shades the 

block on the drawing board containing the object light blue.  

  

To select a block of objects: 

1. Select an area of the drawing board by clicking and 

dragging the mouse across the area of interest. This 

operation will shade the selected blocks light blue. 

 

 

Once an area of the drawing board is selected, the objects within that area can be deleted, 

copied, or cut and pasted. 



33 Specifying Object Data 

GPS-X User’s Guide 

Deleting 

To delete objects from the selected area of the drawing board: 

1. Select an area of the drawing board by clicking and dragging the mouse 

across the area of interest. This operation shades the blocks containing the  

selected object(s) light blue. 

2. Select Edit > Delete from the main menu or hit the Delete key on your 

keyboard. A warning message will be displayed for you to verify the delete 

operation. Selecting Yes causes the object icon and its underlying model to be 

deleted. If you select No, the object will not be deleted. 

Copying and Cutting 

 To cut or copy a selected area of the drawing board: 

 

 

1. Select an area of the drawing board by clicking and dragging the mouse 

across the area of interest. This operation will shade the selected blocks light 

blue. 

2. Click the applicable Cut/Copy button on the toolbar. This operation stores 

the object data on the local clipboard. 

Pasting 

 To paste an object(s) stored on the clipboard: 

 1. Click on the cell of the drawing board where the object(s) is to be pasted. 

2. Click the Paste button on the toolbar. The cut or copied object(s) will be 

pasted to the selected cell. 
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Figure 2-5 – Performing a Block Copy Operation 

Rotating 

 Sometimes it may be advantageous to change the orientation of the icon. In some cases, 

this may be visually necessary to adjust the placement of flow paths. This is often the 

case with flow combiners and splitters. Connections between objects are maintained 

when the icon is rotated. 

To rotate an icon: 

1. Select the object that is to be rotated. 

2. Click the Rotate button on the toolbar. The icon’s orientation will change 90 

degrees. Continue clicking the Rotate button until the desired orientation is 

achieved. 

Mirroring 

 Yet another cosmetic change that is sometimes needed is mirroring an object icon.  

To mirror an icon: 

1. Select the object that is to be reversed. 

2. Click the Mirror button on the toolbar. The object’s icon will be flipped 

horizontally. 
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Zooming and Panning 

After placing several objects on the drawing board, you may want to adjust the level of 

zoom to reduce the amount of whitespace on the drawing board or to focus on specific 

objects in the plant. This can be done using Zoom to Selection/Plant. 

To zoom in on the plant: 

 1. Click on the Zoom to Selection/Plant icon. GPS-X will adjust the level of 

zoom on the drawing board so there is an empty block framing the plant on 

each side. 

 

 

Figure 2-6 - Zoom to Plant Scaling 

  To zoom in on objects of interest: 

1. Select an area of the drawing board by clicking and dragging the mouse across 

the area of interest. This operation will shade the selected area light blue. 

 

2. Click on the Zoom to Selection/Plant icon. This will zoom in on the selected 

area so that it fills the entire drawing board 
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Figure 2-7 - Zoom to Selection Scaling 

Alternatively, if you would like to customize the amount of whitespace being added to 

the drawing board, you can use the Locator.  

The locator window is a viewpoint of the entire drawing board. 

To display the locator: 

1. Click on the Locator menu item found under View > Zoom. The Locator 

window is displayed as shown in Figure 2-8.  
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Figure 2-8 – The Locator Window 

A smaller simplified representation of your layout is displayed in the window. 

Also, shown in the locator window is a rectangular area, which corresponds to that 

portion of the total available drawing area currently displayed in drawing board. 

To zoom in or out on a portion of the drawing board: 

1. Drag out an area on the Locator window. The drag area should correspond to 

that portion of the total area you would like to view and will be represented by a 

red rectangle as shown in Figure 2-6. When you drag out a rectangle, the 

drawing board scale factor changes. 

When the drag operation is complete, the drawing board will be updated, showing the 

selected area. If the selected area is smaller than the previous area, the effect will be to 

zoom in. Similarly, if the selected area is larger than the previous area, the effect will be 

to zoom out. If the selected area is offset to one side, the effect is to pan to that side (up, 

down, right, or left). 

Figure 2-9 shows both the locator and the drawing board at two different scales. The top 

shows the default scale and the corresponding Locator window. When you drag out a 

smaller area in the locator window as shown in the bottom half of Figure 2-9, the scale 

factor is increased and the object icons appear larger. 
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Figure 2-9 – Locator Window Scaling (2 views) 

 

Layout History Database 

The Layout History feature provides a means of storing the state of your layout through 

each stage of its development. Every time you save your layout, a copy is stored in a 

database for later retrieval. 

To use this feature, select View > Preferences from the main menu bar and then select 

“Enable layout history” as shown in Figure 2-10. 
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Figure 2-10 – Enable Layout History 

When “Enable layout history” is first selected, a database for storing layouts is created 

in the user’s login directory. The name of this database directory is .gpsxhistory. When 

you select Save or Save As…, your layout will be backed up to the database. Also, any 

existing layout opened for the first time will be stored in the database. 

To access your layout history, select File > History… as shown in Figure 2-11. 

NOTE: This menu item is only accessible in Modelling Mode. 



40 Specifying Object Data 

GPS-X User’s Guide 

 

Figure 2-11 – Accessing the History Option 

If your layout is already open in GPS-X you will see a dialog window showing its time 

stamped history as shown in Figure 2-12. 

 

Figure 2-12 – History Dialog 

Several options are presented to you in this dialog window. 

(1)  You can add a note at each time stamp to describe the layout at that point.  

(2)  You can select one or more entries to be deleted. By deleting entries that you are not 

interested in, you will save space on your hard disk and speed up database access. 

(3)  By selecting the desired time stamp entry and clicking “Extract” you will be asked if 

you want to overwrite the existing layout (which itself will have been backed up 

before being overwritten).  
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(4)  Or select “Extract To…” if you want to place the layout in a directory different from 

the current one. 

If no layout is open or you have clicked on “Back to all Layouts” in the dialog window 

as shown in Figure 2-12, you will see a different dialog window (see Figure 2-13) 

showing a list of all the layouts that have been stored in the database, including the 

directory paths to the layouts. 

 

Figure 2-13 – History Layout Selection Dialog 

After selecting one of the layouts and clicking “Select”, you will see the time stamped 

history dialog window for that layout. 

Note that the database does not store any input data files (e.g. .dat or .xls) that you might 

have. The user is required to back up these files separately.  

If you deselect “EnableLayout history” in Preferences, the database is retained and will 

be available the next time you turn on this feature. You can back up the database 

directory (<User>/.gpsxhistory) as you would any other directory on your computer. You 

should deselect “Save Layout History” in the Preferences… dialog first to be sure that 

the database is not active when doing the back up. 

The history database is available to only one instance of GPS-X at a time. When the 

layout history feature is active, the history feature will remain greyed out in any 

additional instances of GPS-X that are opened. Consequently, layouts will not be saved to 

the database from this copy of GPS-X.  
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CHAPTER 3  

Influent Advisor 

The mathematical description of the influent wastewater that is fed to the plant model is the single 

most important aspect of a simulated system. Without significant consideration of the influent 

characterization, the plant model will be limited in its ability to predict the dynamic behavior of 

the plant. Hydromantis has developed a tool called Influent Advisor to help users navigate the 

influent models and achieve the influent characterization most consistent with the available 

measured data. 

The influent model is dependent on the choice of a biological model chosen for the downstream 

processes. The reason for this is that the downstream biological models use different sets of state 

variables. GPS-X automatically determines which biological model has been chosen in the 

downstream processes and selects the appropriate influent model. This approach ensures that the 

influent data entered by the user is partitioned correctly. For instance, if a user is using ASM1 in a 

downstream biological process, then it is important that any biodegradable soluble COD be 

assigned to the ss state variable. Alternatively, if the user is using ASM2d (in which ss is not a 

state variable), then it is important that soluble substrate be assigned to sf or slf and not ss. 

The influent advisor interface is shown in Figure 3-1. 
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Figure 3-1 – Influent Advisor Example 

The User Inputs column on the left contains the variables that can be directly modified by the 

user to characterize a given influent stream for the selected influent model.  

The middle State Variables column contains a summary of the calculated states variables based 

on the concentrations and stoichiometry that have been entered in the left-hand column.  

The third column located on the right lists the Composite Variables that have been calculated 

based on the specified user inputs and state variables. As the data is entered into the User Inputs 

column, the state and composite variable values are automatically updated accordingly. 

To see how a value is calculated, click on it. The formula will be displayed in the Equation for 

box at the bottom of the screen, and the values used in the equation will be highlighted in the 

columns so that the applicable cells can be easily identified. If a negative value is calculated in 

either column, the number will turn red for easy identification. (Figure 3-2). Correcting 

problematic data is a matter of adjusting parameters in the User Inputs column to achieve non-

negative values. 
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Figure 3-2 – Influent Advisor showing Highlighted Cells (Blue) and Negative Value Errors (Red) 

The influent models used in GPS-X make certain assumptions about what data may or may not be 

available. For instance, no influent model uses both COD and BOD data, even though the data 

may be available and may provide important information about how that organic material is 

partitioned into the available state variables.  

Influent Advisor helps overcome this shortcoming.  

Take an example in which BOD and COD data is available and the codstates model is chosen for 

the influent object and the User Inputs cells can be filled in, including the available COD data. 

The user can then scroll to the right table and check the BOD values calculated based on the input 

data. If the BOD data is in agreement with the measured BOD data (assuming no negative values 

appear in any cells), then the user can be assured that the input data is consistent with the 

available data. If the BOD data is different from the measured BOD, then the unknown (or 

estimated) input data should be adjusted until acceptable agreement is achieved. 
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CHAPTER 4  

Specifying Object Data 

TYPES OF DATA 

Influents, flow control points (i.e. splitters and combiners), and unit processes are characterized 

by the data that define them. Here, the term data is used in a generic sense to refer to the values 

of all attributes that uniquely define an object. Foremost among these attributes are the models 

which describe the input-output behavior of the object. Some models are simple and require few 

parameters. For example, a two-way flow-splitter model has a single parameter – the fraction of 

the flow going to one of the two outputs (the other is calculated). Other models are complex, such 

as the biological nutrient removal models used in reactor objects. The kinds of parameters needed 

for an object depend entirely on the kind of model selected for that object. 

Attributes can be classified as either numeric or text. Numeric attributes include parameters like 

the real dimensions of the unit (width, area, etc.) and kinetic constants (maximum specific growth 

rate, decay constant, etc.). Most of the attributes in GPS-X are numeric. Text variables include the 

type of model used to describe the object, the type of controller to use in a model, etc. Text 

variables have a discrete number of ‘values’. For example, the plug flow tank reactor can have 

only one of several types of model – one of the asm1, asm2, asm3, newgeneral, mantis2, or 

mantis3 models (not all of these models are available depending on which library you are using). 

Similarly, the controller type variable for the PID controller model can be P, PI, or PID. When 

specifying a value for a text variable, GPS-X provides a list of options from which to make a 

selection. 

Every object placed on the drawing board must be fully specified before a plant model can be 

prepared. GPS-X simplifies this using default models and parameter values. In practice, it is often 

found that some model parameters do not change significantly1, or do so within a certain range. 

Incorporating default values for model parameters in GPS-X minimizes the amount of data entry 

that must be done before a working model can be built. However, you must ensure that these 

values are appropriate for the particular plant or process being modeled.

 
1 Exceptions include the physical or operational parameters such as dimensions, operational mode, etc. 
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OBJECT MENUS 

Object data are specified by opening the appropriate data entry form and either making a 

selection from a list of options or entering numeric values. Data entry forms are accessed from 

the Process Data menus, which are defined for each object. 

To display the process data menu: 

1. Right click on any object on the drawing board. The process data menu for 

that object will be displayed. 

Figure 4-1 shows the process data menu for the circular secondary clarifier object. 

 

Figure 4-1 – Process Data Menu for a Circular Secondary Clarifier 

Selecting a Model 

In GPS-X, one of the most important attributes of an object is the type of model used to 

simulate the input-output behavior of that object. Because of this, the first step in 

specifying object data is to select the model to be used for each object. This is done by 

selecting the Models item from the process data menu. 

To specify a model type: 

1. Pop up the Process Data menu by right clicking on any object on the drawing 

board. 

2. Select the Models item. This will cause a hierarchical menu to be displayed as 

shown in Figure 4-2. 

3. Click on the desired model. 
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Figure 4-2 – Selecting a Model 

GPS-X automatically selects the default model for you when you first place the object on 

the drawing board. If you wish to switch to a different model, you will lose any 

parameters entered into the data menus. 

If you wish to change the default model so that GPS-X will always choose your desired 

model, edit the defaultmodelchoice.txt file in the subdirectory bin/gpsx/resources in the 

GPS-X installation directory. 

Not all objects have more than one model. For example, splitter and combiner objects 

have a single, pre-set default model so you do not need to make a model selection to 

access the parameters for these objects. 

Summary of Object Attributes 

Once the model has been specified, you can access all of the object’s attributes. These 

attributes differ depending on the model and type of object.  

For detailed lists of object and model attributes, see the Technical Reference manual. 

An object’s attributes are divided up into several categories. 

Input 

Depending on the object type, the input variables are grouped into either: 

(1) Composition and Flow if it’s an influent object (see Influent Objects) 

(2) or Input Parameters and Initial Conditions if it is any other object (see 

Process Objects). 
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The items under this group allow you to set the model characteristics in 

Modelling mode (see the Data Entry Forms section below) or select controller 

variables in Simulation mode (see CHAPTER 6 Preparing Input Controls). 

Output 

The output group allows you access to all the variables that can be displayed on 

graphs or various other output displays in Simulation mode. 

Source Data 

Allows you to specify (or remove) links to other unit processes where common 

data can be obtained.  See the Sourcing section in this chapter for more details. 

Note 

Allows you to make any personal notes about this specific object on the drawing 

board.  These notes are purely for your own reference.  They do not affect the 

layout in any way. 

Summary of Changes 

Allows you to see a summary of all of the variables you have changed from their 

default GPS-X settings for a given object.  

Labels 

Allows you to view/edit the process and stream labels for this object (see the 

Labels section below). 

DATA ENTRY FORMS 

For a complete description of the data entry forms and parameters for each model, refer to the 

Technical Reference manual.  The following is a general description of the forms. 

Data entry forms are displayed when you select one of the menu items under an input grouping 

(ie. Composition, Flow, Input Parameters or Initial Conditions as described in the previous 

section). 

Within each form, data are grouped into logical categories. 
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Figure 4-3 – Data Entry Form Example for a Secondary Clarifier 

More… 

In some cases, some of the less commonly adjusted parameters are grouped together on a 

separate data form, which is shown by the presence of a More… button.  

Inactive Parameters 

Some parameters will appear “greyed-out” (ie. inactive). These are parameters that are 

only relevant when another parameter has been activated or selected. For example, when 

the proportional recycle is set to off, the recycle parameters will be inactive. This 

functionality is also tied to the drop down menus. 

Parameter Label 

When the mouse is held over a parameter name, a tooltip appears which shows the 

descriptive and cryptic names of the parameter.  

The purpose of this tooltip is twofold.  

(1) One is to provide the descriptive name as some of the longer descriptive names may 

be cut-off in the data entry form due to space limitations.  

(2) The second purpose is to show the cryptic name of the parameter. Knowing the 

cryptic name of a parameter is sometimes needed for setting up controller models, or 

for adding customized model code. For more information on the conventions used for 

setting cryptic parameter names, see the Technical Reference manual. 
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Entry Fields 

To the right of the descriptive label for a parameter is an entry field for entering input. 

The entry field may be a data entry field, a text entry field, a drop-down menu from 

which a selection can be made, or an ON/OFF button. If the variable is an array, an 

Array button [(…)] is displayed. To access the individual array elements, click on the 

array button, and another form will be displayed for entering values in each element of 

the array.  

When values are entered that are different than the default value, the new value will be 

shown in bolded blue text. The default value can still be viewed by holding the mouse 

cursor over the entry field to display the tooltip. 

Units 

The unit of the input variable can be changed by clicking on the unit label. 

Notes 

To the right of the units is a button that allows you to add a note 

about each parameter.  

Once notes have been made, the button’s icon will change and 

the note will appear as a tooltip pop-up when the mouse is held 

over the button.  

The notes function also supports the use of HTML tags. 

 

 

Figure 4-4 – Data Entry Form Example (with notes field in use) 
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INFLUENT OBJECTS 

The composition, concentration, and flow characteristics of the influent are major factors 

determining the dynamic behavior in unit processes that make up the plant. GPS-X allows you to 

specify the type of flow or load pattern. You can specify a constant or sinusoidal flow or load 

pattern by entering only a few parameters in the Wastewater Influent object. You can enter a 

single diurnal pattern for GPS-X to repeat or you can enter your own flow and/or composition 

data and have GPS-X use these data for the influent. These attributes are entered by making 

selections from the Composition and Flow process data menu items. 

Composition 

The majority of an influent model’s attributes are accessing through Composition item.  

These parameters have been further divided into categories depending on the specific 

type of influent (Continuous or Batch). 

Influent Characterization accesses the Influent Advisor tool to aid in the setup of your 

influent object (see CHAPTER 3). 

 

Figure 4-5 – Influent Object Composition Menus for (A) Continuous and (B) Batch 

NOTE: Not all influent models have all the menu items displayed in Figure 4-5 

Flow 

The Flow > Flow Data item is used to enter a flow type and related data. The continuous 

wastewater influent object differs from the batch influent and chemical dosage objects in 

that it contains a specialized runoff model. 

PROCESS OBJECTS 

A variety of parameters are needed to specify a unit process; however, these can be categorized as 

either input parameter or initial condition values. Input parameters include physical, kinetic, 

operational and stoichiometric data; whereas, initial condition values refer to initial conditions 

for the model state variables including the volume and component concentrations. 

Panel A Panel B 
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Input Parameters 

The majority of a model’s attributes are accessed through the Input Parameters item.  

These parameters have been further divided into categories depending on the specific 

type of object. 

 

Figure 4-6 – Input Parameters Sub-Menu Example 

Initial Conditions 

Initial conditions are defined only for non-point process objects; that is, objects which 

have a volume. Point process objects include objects such as flow splitters and 

combiners, which are modeled as zero-volume control points. Point objects do not require 

initialization because there is no accumulation or utilization of material within the object. 

Point objects serve only to distribute or collect flows coming into the object. 

In practice, initial conditions are rarely set manually unless data are available from 

previous simulations and you want to restore these conditions before re-starting the 

simulation, or if you are interested in starting the simulation with certain initial volumes 

(for example, with one or more tanks partially full). In the majority of cases, the default 

initial conditions – which are pre-defined for the model’s default data – are used. For a 

given set of initial conditions, the usual procedure is to first run the steady-state solver to 

determine a valid steady-state, and then run a simulation. Alternatively, you can run the 

simulation for a period (i.e. 1 day), save the state variables, reinitialize the state variables 

and then conduct a simulation. See Initial Conditions in CHAPTER 8 for more 

information on setting the initial conditions for a simulation run. 
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Figure 4-7 – Initial Conditions Sub-Menu Example 

SUMMARY OF CHANGES 

When constructing a model in GPS-X, the default settings for each variable provides a good 

starting point for most applications, but you will often need to modify these defaults to match 

your plant characterization and performance. For large models that are highly customized, it can 

be difficult to track all the changes that have been made to the GPS-X default settings. In 

Modelling Mode, the Summary of Changes menu item can be used to provide you with a quick 

summary of each variable in an object that the user has changed from its GPS-X default value. 

The Summary of Changes from the Default results for a wastewater influent object can be seen in 

Figure 4-8. 

 

Figure 4-8 - Summary of Changes for an Influent Object 
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The name and current value of each modified variable for the selected object appears in the 

Summary of Changes output. Beside each variable value is a Go to location button which will 

take you to that variables data entry form where you can further manipulate the variable or reset 

its value to the GPS-X default value.   

The View drop-down menu at the top of the output can be used to navigate between the objects 

on the layout. A Summary of Changes output will be available for each object that is currently 

placed on the drawing board.  

LABELS 

Among the important system-related attributes of every object in a GPS-X layout are the 

connection point labels for that object. When you drop an object icon on the drawing board,  

GPS-X assigns a numbered label to each connection point in that object. The label is used to 

generate model variable names, develop the model equations and manage the changes, which 

occur in each variable. These processes are transparent and need not interfere with the process 

analysis tasks you perform. In fact, a key advantage of GPS-X is its ability to hide lower levels of 

complexity so that you can concentrate efforts on process analysis and understanding. 

In some cases, it is necessary or convenient to determine or possibly change the labels assigned to 

connection points on an object. To do this, you can use the Labels… item in the process data 

menu. 

To change the labels on an object, complete the following steps: 

1. Right click on an object. Select the Labels… item. This will cause the label dialog box 

to be displayed. 

 

Figure 4-9 – Labels Dialog 
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2. Enter any alphanumeric string at each connection point. You can enter any string you 

like. The only constraint is that if the label consists of more than one alphanumeric 

character, the name must begin with a letter, not a number. For example, the labels a, 1, 

and a1 are acceptable, but 1a is not. GPS-X will not allow you to enter invalid strings 

(i.e. spaces are not allowed and certain characters cannot be used to start a string). The 

label can be up to 31 characters in length. 

3. Enter any alphanumeric string in the ‘label’ text box. This is the process’s label and is 

displayed above the object on the drawing board.  It can also be useful for differentiating 

between objects when the output displays are created. 

4. Click the Accept button to save these values. If you entered a label that is already in use, 

an error will be displayed and you won’t be able to ‘accept’ the changes until the 

duplications are corrected. 

Cryptic Variable Names 

The connection point labels are used as flow stream identifiers and to generate variable 

names (referred to as ‘cryptic’ names) in the dynamic process model. Cryptic names are 

created by taking a default descriptor, such as ‘muh’ for heterotrophic maximum specific 

growth rate, and appending the label to that descriptor.  

For example, the cryptic variable containing the value of soluble BOD for an object’s 

influent labeled ‘inf’ is ‘sbodinf’.  

By convention, any variables internal to non-point objects take the output connection 

point label when constructing the variable name.  

As an example, if a continuous flow stirred tank reactor has ‘140’ as the label for the 

output connection point, the heterotrophic maximum specific growth rate (descriptor 

‘muh’) in the reactor would be named ‘muh140’.  

There are two ways to view the cryptic names.  

(1) For individual parameters, position the mouse over the variable label of interest 

whereby a tooltip will appear with the descriptive label and the cryptic name 

separated by a back slash. See example in figure below. 
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Figure 4-10 – Viewing the Cryptic Name via Tooltip 

(2) Another way to view the cryptic names is by selecting the Show cryptic variable 

names option in View > Preferences > Layout tab under the Display group. 

 

Figure 4-11 – Viewing the Cryptic Names via Preferences Setting 

This will change it so that the cryptic name is shown in all data entry forms instead of 

the descriptive label.  This can be confusing, so it is recommended that the cryptic 

option be used with care. The data entry label names will be refreshed each time you 

accept the changes to the Preference menu. 

For more information on model variable names and conventions used in constructing these 

names, please see the Technical Reference. 
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Displaying Labels on the Drawing Board 

By default, labels are not displayed on the GPS-X drawing board2. If you would like to 

have them displayed, use the Label drop down menu on the Toolbar and choose either 

‘streams’, ‘objects’ or both.  

 

Figure 4-12 – Layout Before and After Displaying Process/Stream Labels 

Labeling procedures in GPS-X are important when you need to uniquely identify an object and/or 

its streams. This is the case when object data are linked together as discussed in the Sourcing 

section of this chapter. 

FIND 

When constructing you are constructing a model, there may be times where you wish to modify, 

control or visualize a variable but you are unsure of which menu it is located in. If you know part 

of the variable’s common name or have a cryptic variable name from a GPS-X output, the Find 

function can be used to locate the menu.  

To open the Find window, go to Edit > Find to open the data entry window for the find 

functionality, as seen in Figure 4-13. 

 
2 This can be changed by checking the appropriate label checkbox on the Layout tab of the Preferences form. 
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Figure 4-13 - Find Menu Entry Form 

In the Find Stream Label section of the Find Window is a drop down which contains all of the 

stream labels on the layout. Selecting a stream label from this drop-down menu will highlight the 

object in the layout that the stream originates from. This can be used to identify the object that 

unfamiliar model outputs originate from.  

The Find Input/Output Variable section of the Find menu is used to locate variables in GPS-X. If 

you are unsure of the variable you are looking for, keywords you expect to be in the variable 

name can be entered into the Find entry field with the Keyword toggle selected. For example, 

entering ‘underflow’ into the find entry and pressing the Find button will yield the results seen in 

Figure 4-14. 

Using the find function will give you a list of all of the variables that contain the keyword 

‘underflow’. The variables will be organized by both the object they are associated with on the 

GPS-X layout and if they are an input or an output variable. If you press the “Go To Location”  

next to the variable name it will take you to the menu where the variable is defined. If the variable 

is an input, you will be taken to a data entry menu, well an output variable will take you to a 

display variable menu.  

Alternatively, if the cryptic variable name is known, the Find function can be used to can be used 

to find all variables whose cryptic variable name contain the known cryptic variable name. To 

search a cryptic variable name, enter it in the data entry field in the Find Input/Output Variable 

section of the Find menu and toggle on the Cryptic option below the entry field. Press the Find 

button and GPS-X will display all instances of the cryptic variable in the layout, formatted the 

same way as the Keyword find results. 
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Figure 4-14 - Find Results for Underflow 

SOURCING 

Data entry is an important aspect of building and maintaining a dynamic process model. Once the 

model structure is in place, it is necessary to identify those parameters, which are most important 

and then determine how to adjust these to obtain the desired model behavior. With conventional 

modelling and simulation software, this task consumes a large fraction of the model development 

time, using resources that could be more profitably applied elsewhere. One time saving feature is 

specifying Source objects. 

In GPS-X, attributes are linked to specific objects. This linkage mechanism is a simple way to 

reference objects to their data and makes it possible to link multiple objects to a single data set. 

When one object (a parent), becomes a source for a second object (a child), the latter inherits data 

from the former. This is the essence of the concept sourcing in GPS-X. 

The real power of sourcing becomes evident when changes are made to object data, for example, 

due to model calibration, on-line data entry, etc. When objects are properly sourced, this change 

need only be made in one place – at the source object. If the sourcing feature was not used, these 

changes would have to be made for each appropriate object affected by the change. 
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NOTE: Not all data are inherited. Only the kinetic and stoichiometric parameters for reactor 

models and settling parameters for sedimentation models are inherited. The same model type 

must be selected for both objects before any sourcing links can be established. 

Note the following constraints when sourcing: 

• Sourcing of kinetic and stoichiometric parameters can only be established between 

objects with the same model type. 

• Sourcing specifications cannot include inheritance loops, that is, you cannot specify a 

data chain of sourcing relations in which a parent object inherits from one of its child 

objects. It is not possible to determine a unique parent object in a sourcing chain forming 

a loop. 

• Biological reaction unit processes can inherit kinetic and stoichiometric parameter values 

from any other biological reaction unit process with the same model. 

• Sedimentation unit processes can inherit settling parameters from other sedimentation 

unit processes of the same kind. Secondary sedimentation and sequencing batch reactor 

objects can inherit from other secondary sedimentation or sequencing batch reactor. 

Sedimentation unit processes which have reactive models can inherit kinetic and 

stoichiometric parameter values from any other biological reaction unit process. 

To specify a source object (parent) for another object (child) of the same type: 

1. Right-click on the child object. The process data menu for that object will appear. 

2. Highlight the Source Data option (Figure 4-16). If that option is disabled (greyed out) 

then that means that there are no potential data sources (ie. parents) currently on the 

layout. 

3. Select the parent object from the list. The child will now automatically inherit data 

from the parent. 

NOTE: A ‘chain’ icon will appear on the child object’s image on the drawing board to easily 

identify which processes have been sourced (Figure 4-17). 

 

Figure 4-15 – Example Layout before adding Source Links 
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Figure 4-16 – Example Layout showing Source Data menu 

 

 

Figure 4-17 – Example Layout showing Source Linked Processes 

To remove (or view) the current source of an object, complete the following steps: 

1. Right-click on the child object to display the process data menu. 

 

2. Highlight the Source Data option. The sub-menu will display other potential parents (if 

applicable) and below that is the option to remove the current parent. 

 

GENERAL DATA 

There are some data which are not exclusively related to influent, process or flow path objects. 

This includes operating system and simulator module set-up information, such as timing 

parameters, numerical integration options, and process environment parameters such as 

temperature. The data entry forms for this data are accessed from the Layout menu on the main 

menu bar.  It can also be accessed by right-clicking on a blank area of the drawing board. 
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Figure 4-18 – General Data Menu 

The System menu is used to gain access to the global simulation parameters, such as parameters 

related to the operation of the steady-state solver and the optimizer. 

The User menu is used to gain access to the user-defined variables. This item is provided for 

advanced users to customize the GPS-X interface. The user can define any number of additional 

parameters or initialization and display variables and then access these here. For more 

information on customizing GPS-X see CHAPTER 11. 

The User Files menu is used to define custom code and user-defined variables. This item is used 

to access the GPS-X user-customizable files, which give users the ability to define, use and 

display customized user code. For more information on customizing GPS-X see CHAPTER 11. 

SITE PROPERTIES 

The Site Properties item is merely a subset of the most commonly used data in the General Data 

category described above.   

It allows users to customize the physical input parameters of the plant (Plant Site Properties tab) 

and the simulation date (Simulation Setup tab). Additional plant information notes can also be 

saved under the Plant Information tab.  

  



63 Optimization Tools 

GPS-X User’s Guide 

CHAPTER 5  

Defining Data 

INTRODUCTION 

You can create secondary variables that are calculated from existing model variables. Model 

variables are referred to as primary variables3. 

The Define feature is provided to make it easy for you to specify common secondary variables. 

You can add other calculated variables by modifying the model code directly. For more 

information on this topic, see CHAPTER 11. 

You can specify daily and/or moving averages and mass flows for any variable in the model. This 

includes secondary variables that you may have defined previously, either in the code 

(CHAPTER 11) or with the define feature.  

For example, with the define feature you can specify a secondary variable which contains the 

value of the moving average of the plant food-to-microorganism ratio. 

Food-to-microorganism and solids retention time variables are special because normally they are 

calculated from primary variables at different locations in the plant. 

For example, solids retention times can be calculated for a single treatment train, two or more 

treatment trains or the entire plant4. You can include the effluent suspended solids in calculation 

of the solids retention time or choose to ignore the effect of effluent solids on the calculated 

value. Similarly, you can evaluate the F/M ratio for a single reactor or multiple reactors and 

specify which unit process mass values should be used in the calculation. With the Define 

feature, you can specify how these variables are calculated for your plant. 

The Define feature can be accessed through the Tools menu on the main menu bar or the Define 

button on the main toolbar. 

 
3 Another type of variable is a composite variable. Composite variables are calculated from the model state 

variables. 
4 In GPS-X, SRT is calculated on a total suspended solids (TSS) basis.  The F/M ratio is calculated on a 

CBOD5/VSS basis. 
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Figure 5-1 – Define Menu Options 

The types of variables that can be defined with this feature include: 

For any model variable: 

• Daily average 

• Moving average 

• Totalizer 

• Mass flow 

Or any layout: 

• Food/Microorganisms ratio 

• Solids retention time 

Use the define feature during set-up of the layout, and before building the simulation model. You 

must always re-build the model after defining new variables. 

MOVING AVERAGES, MASS FLOWS AND TOTALIZER 

Moving averages, mass flows and totalizers are often calculated for one or more variables in a 

treatment plant. The procedure for specifying these secondary variables is the same for all of 

them. 

Moving Averages 

Moving averages are data filters that smooth-out high frequency (rapid) changes in 

dynamic data so that it is easier to see overall trends.  

Mass Flows 

Mass flows are used in loading and material balance calculations.  
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Totalizer 

This function will integrate the selected variable starting from time zero. The most typical 

application is integrating flow that is calculating the total liquid volume passed through 

the selected pipe during the duration of the simulation. 

Concentrations totaled this way represent mass flow in a unit flow (1 m3/d) over the 

duration of the simulation. If the total mass flow (g/d) is required, it is best to use the 

Mass Flow function in the Define menu. 

Follow this procedure to specify these secondary variables: 

1. Click on the Define button and select either Daily Average, Moving Average, Mass 

Flows or Totalizer from the list (Figure 5-1). A dialog window will appear as shown 

in Figure 5-2. 

 

Figure 5-2 – Define Dialog for Daily Average 

2. Use the Variable Type drop-down box to change the display to the desired type of 

variable. 

3. Select all of the locations (left side) and variables (right side) to include in the 

calculation. Note that a checkbox with a grey background means that some, but not 

all of the items in that grouping have been selected. 

4.  Click Accept to create the variable and close the dialog window 

The secondary variables are now specified and are valid model variables like any other in the 

model. This means that you can display the defined variable, query the simulator for its value and 

include it in the definition of other secondary variables. For example, you might want to calculate 
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the mass flow of solids into a reactor or clarifier and, from this, a moving average of the mass 

flow.  

Specifying Moving Average’s Time Frame 

After a moving average variable has been defined, the number of days to be used in the 

calculation can be specified in two different ways: 

Through the Define dialog 

(1) Open the Define dialog like you did in order to create the variable in the first 

place.   

(2) Select “Define Variables” from the Variable Type drop-down box.  A list of 

defined variables will be displayed. 

(3) Find the variable of interest.  Beside the variable will be an entry field where 

you can enter the number of days (Figure 5-3). 

(4) Click “Accept” 

 

Figure 5-3 – Specifying Moving Average Time Frame (Method 1) 

  

# of days 
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Through the Process Data menu 

(1) Right-click on the process that contains the defined variable.  The process 

data menu will appear. 

(2) Select Output Variables > Defined Variables > Moving Average. See 

Figure 5-4.  A dialog window with the defined variables will be displayed. 

 

Figure 5-4 – Viewing Defined Variables 

 

(3) Enter the desired value into the entry field (Figure 5-5)  

(4) Hit “Accept”. 

 

Figure 5-5 – Specifiying Moving Average Time Frame (Method 2) 

The number of days that you set together with the communication interval specified for the 

simulation determines the number of points for calculation of the moving average. See 

CHAPTER 8 for information on simulation set-up including specification of the communication 

interval.  
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Remember that the communication interval defines the update frequency and the number of days 

value defines the overall time window used in calculating the moving average. 

For the daily (moving) average the time window is 24 hours and is calculated exactly regardless 

of the simulation communication interval. To calculate the daily average, GPS-X uses data 

obtained at each integration time step rather than the output communication interval. 

Any defined variable becomes a normal, calculated model variable. You can display the variable 

and use the variable in other calculations; however, as it is a secondary variable you cannot set its 

value before or during a simulation run. Remember that you must re-build the model after 

defining new variables to display the calculated values. 

FOOD/MICROORGANISM (F/M) RATIO 

The definition of food/microorganism ratio is often layout-dependent and, therefore, it is 

convenient to be able to define it differently for each layout you prepare. The procedure used to 

define the variable is interactive. Because it is based only on mass and flow measurements, the 

GPS-X define procedure has been designed to allow you to specify the form of the equation by 

simply clicking on the object or connection point containing the mass or flow value of interest. 

 

Figure 5-6 – Food/Microorganism Ratio Manager 

To define a Food/Microorganism Ratio secondary variable, complete the following steps: 
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 1. Click on the Define button and select the Food/Microorganism Ratio item. The 

F/M Ratio Manager dialog window will appear (Figure 5-6). 

 2. Click on the “+” button to create a variable name for the new defined variable. 

The text area on the right side of the dialog displays the mass and mass flow terms 

used in the equation to calculate the selected variable on the left.  You interactively 

specify the full form of the equation by clicking on objects and object connection 

points. 

 

3. Click on a unit process on the drawing board (not a connection point) to add 

that unit’s mass to the calculation of the mass term in the defining equation. 

When you move the cursor over an applicable unit processes it will change the 

cursor to a hand. Clicking will add the object’s identifier label5 as an argument in the 

Mass() term. If you click the same object a second time, the object’s identifier label 

is removed from the mass term. 

 4. Click on connection points (not the object itself) corresponding to flow streams 

containing mass flow values of interest to add that connection point’s mass flow to 

the calculation of the mass flow term in the defining equation. When you move the 

cursor over an applicable connection point it will change the cursor to an arrow. 

Clicking will add the connection point’s flow stream label as an argument in the 

Mass Flow() term. If you click the same point a second time, the connection point’s 

stream label is removed from the mass flow term. 

 5. After you have specified all appropriate mass and mass flow terms, click Close. 

SOLIDS RETENTION TIME (SRT) 

The SRT Manager allows users to define multiple SRTs for a model layout. The SRT manger 

also allows the user to control sludge wastage via a SRT setpoint.   

The SRT Manager can be used to define calculations for multiple SRTs if required. For example, 

it is possible to define aerobic SRT, anoxic SRT or anaerobic SRT by using the biomass in 

aerobic, anoxic, or anaerobic compartments respectively. 

To define an SRT secondary variable, complete the following steps: 

 1. Click on the Define button and select the Solids Retention Time item. The SRT 

Manager dialog window will appear. 

 
5 By convention, this is the object’s effluent flow stream level. 
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 2. Click on the “+” button to create a variable name for the new defined variable. 

The text area on the right side of the dialog displays the mass and mass flow terms 

used in the equation to calculate the selected variable on the left. You interactively 

specify the full form of the equation by clicking on objects and object connection 

points. 

 

3. Click on a unit process on the drawing board (not a connection point) to add 

that unit’s mass to the calculation of the mass term in the defining equation. 

When you move the cursor over an applicable unit processes it will change the 

cursor to a hand. Clicking will add the object’s identifier label6 as an argument in the 

Mass() term. If you click the same object a second time, the object’s identifier label 

is removed from the mass term. 

 4. Click on connection points (not the object itself) corresponding to flow streams 

containing mass flow values of interest to add that connection point’s mass flow to 

the calculation of the mass flow term in the defining equation.  When you move the 

cursor over an applicable connection point it will change the cursor to an arrow.  

Clicking will add the connection point’s flow stream label as an argument in the 

Mass Flow() term.  If you click the same point a second time, the connection point’s 

stream label is removed from the mass flow term. 

 5. The “Estimate WAS using selected SRT” checkbox allows the user to estimate 

the waste flow rate for the selected SRT.  Additional inputs like the SRT set point 

and min/max values for the calculated SRT controller pump flow are required. 

 6. After you have specified all appropriate mass and mass flow terms, click Close. 

In the simulation mode, the values of the SRT can be visualized by dragging and dropping the 

SRT variables in the output window. The drag and drop action places both the instantaneous and 

dynamic SRT for visualization. Depending on the need, one or the other SRT can be removed 

from the outputs. In simulation mode, the SRT manager can also be used to turn off the WAS 

flow rate calculation based on SRT set point. The user can also change the set-point value in 

simulation mode. 

 

 
6 By convention, this is the object’s effluent flow stream level. 
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Figure 5-7 – Selecting Processes/Streams for Defined Variables 

DYNAMIC SRT 

Under dynamic conditions the solids retention time (SRT) is based on an age balance performed 

on the sludge in a manner similar to a typical mass balance. At steady-state the dynamic SRT is 

equivalent to the SRT. In dynamically changing conditions the dynamic SRT gives a better 

approximation of the true age of the biosolids in the system and can replace empirical smoothing 

methods (seven day moving average, etc.) routinely used to filter the sudden fluctuations in the 

instantaneous SRT calculation. 
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CHAPTER 6  

Preparing Input Controls 

WHAT IS AN INPUT CONTROL? 

An input control is a user-defined graphical object that controls or modifies the value (continuous 

or discrete) of a model variable. This should not be confused with an automatic process 

controller which is used for maintaining a control variable at its set-point. The variable, which is 

linked to the control, can be any model independent variable. The effects of changes in the 

independent variable are observed by displaying selected dependent variables.  

Any influent object flow or composition variable and any process object parameter or 

initialization variable, both continuous and discrete, can be linked to a control. These are the 

independent variables, which can potentially alter the dynamic behavior of dependent variables in 

the model. Dependent variables include the state variables, their derivatives, process rates, etc., 

any composite variables that are calculated from the states or their derivatives and any secondary 

variables that you may have defined. Dependent variables cannot be changed because they are the 

response variables calculated by the simulator's integration and calculation routines. 

For example, for design purposes you may want to control the volume or surface area of a unit 

process (independent variable) and observe the effects on effluent water quality (dependent 

variable).  

If you are interested in observing plant performance - measured by variation in effluent 

suspended solids, BOD5 or ammonia nitrogen - at different solids retention times, you might want 

to investigate changes to the sludge wastage rate. Sensitivity analysis, which is a more structured 

investigation of relationships between variables in the model, requires that one or more dependent 

variables be observed with changes to the value of an independent variable within a certain range 

and at selected intervals. 

Input controls are set up and used in the Simulation Mode. 

There are three steps in creating and setting up an input control: 

1. Create one or more blank input control tabs. 

2. Locate the independent variable to be controlled, and drag it to the blank tab.  

3. Access the properties to adjust the controller type and settings.  
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In Simulation Mode, the main window is divided up into three different regions; Controls, 

Outputs, and the Drawing Board (Figure 6-1). 

 

Figure 6-1 – Three Regions of Simulation Mode (Controls, Outputs, Drawing Board) 

Input controls are displayed on one or more tabs. You can create as many tabs as you like and 

organize the controllers in whatever way is convenient. For example, you can place all the file 

input controls in a single tab and controls for the optimizer independent variables in another. 

CONTROLS TOOLBAR 

At the top of the Controls section of the main window is the Controls toolbar.  This gives you 

access to many features pertaining exclusively to the input controllers 

 

Figure 6-2 – Controls Toolbar 

Here is a general overview of the buttons and their uses: 

Controls 

Drawing 

Board 

Outputs 
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 New Tab – Controllers can be grouped together into tabs.  This button will 

create a new tab. 

 Delete Tab – This will delete the current tab and its contents. 

 
Reset All Controls – This will reset all controllers on all tabs to their initial 

values. 

 
Input Control Properties – See the Input Controls Properties section below. 

 Transfer Values to Layout – See the Transfer Controller Values section 

below. 

 Transfer Controls to Scenario – See the Transfer Controller Values section 

below. 

 Tab Listing – This displays a drop-down list of all the control tabs so that you 

can easily select the desired one.  This can be useful when you have many tabs. 

TYPES OF INPUT CONTROLS 

There are two main types of input controllers: 

• Direct (user interactive) controls 

• Indirect (program-mediated) controls 

Each of these control types is discussed in the next section. 

Direct Controls 

Direct controls are those that you can set up and change interactively as the simulation 

proceeds.  

There are three types of direct controls that you can set up in GPS-X (Figure 6-3): 

1. Slider Control: The slider control sets the value of the independent variable and 

gives a visual indication of the setting and a text display of the current value. You 

must specify a minimum and maximum for the slider control. 

2. Increment Control: This control consists of two buttons, which add or subtract a 

specified amount to the current value of the independent variable. You must specify 

the increment, minimum and maximum for this control. Three system-defined 
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controls that set the simulation stopping time, communication interval and delay 

make use of increment controls. 

3. Discrete Control: One type of discrete control is an on/off (2-state) button, which 

allows you to activate or de-activate an independent variable. For multi-valued text 

variables, this control is displayed as a pull-down menu of mutually exclusive 

buttons. Pressing one of these buttons causes the others to pop-up 

 

Figure 6-3 – Example of Different Types of Input Controls 

With the slider or increment type controls, you can type in the value on the line to the left 

of the slider or buttons. When you press the Enter key after typing in the value, the new 

entry will take effect. In the case of the slider control you will see the slider pointer move 

to the new position. If you enter a value outside the bounds of the min/max, the number 

will change to red to alert you, but the value is still used as is. 

 
The slider, up/down, ON/OFF and pull-down menu controls have a “reset” 

button located at the far right of the control.  Pressing this button will reset the 

controller to the default value (taken from either the layout or the current 

scenario). 

Indirect Controllers 

The idea of a control extends beyond that of user-interactive control of an independent 

variable to include control of variable(s) by routines within GPS-X itself. These routines 

include: 

• File Input Control: This function reads data from files. These data might be 

generated by other simulations, produced with spreadsheet or word processing 

programs, or collected from an actual plant. The data can be continuous, for 
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example values of the influent flow rate, or they can be discrete, for example, 

‘on’ or ‘off’ and ‘option 1’, ‘option 2’, etc. See the Using File Input Controllers 

section of this chapter for more information about setting up and using this 

feature. 

• Analyze Control: These routines automatically vary the value of an independent 

variable. You specify the minimum, maximum and an increment and GPS-X runs 

the appropriate number of simulations to generate the sensitivity analysis results. 

There are additional input data requirements for sensitivity analysis. More 

information on setting up and performing sensitivity analysis is given in 

CHAPTER 9. 

• Optimize Control: These routines calculate the optimal value of variables using 

specialized procedures to obtain targeted results. More information on setting up 

and performing an optimization is given in CHAPTER 10. 

For each of these control types, you provide certain initial set-up information. GPS-X 

then controls, or sets, the value of the independent variable accordingly. The graphical 

objects displayed for each of these control types is a non-interactive gauge, which 

indicates the current value.  

 

Figure 6-4 – Indirect Control Types – File Input (yellow), Analyze (red) and Optimize (green) 

CREATING A CONTROL FROM AN INDEPENDENT VARIABLE 

Specification of the independent variables for which you would like to prepare a control is done 

by dragging the desired parameter to an input control tab from a data entry menu (Figure 6-5).  
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Figure 6-5 – Dragging Variable to Control Tab 

 

To access the data entry menu, right-click on an object to display the process data menu for the 

object of interest and select the appropriate independent variable menu item as demonstrated in 

Figure 6-6.  Data entry menus are accessed by selecting either the Flow or Composition menu 

items for influent objects or the Input Parameters or Initial Conditions menu items for other 

process objects. 

 

Figure 6-6 – Example of Process Data Menu 
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Some parameters in the data entry forms are unable to be dragged to an input control window 

because these variables cannot be changed as the simulation proceeds. These include variables 

that would require a recompilation of the model, such as the number of reactors in series in a plug 

flow reactor. 

It is important to differentiate between setting up input controls and setting up output display 

graphs as described in the next chapter. The procedure for both is similar; however, the selection 

of display variables is made only from the Output Variables menu item for a process object.  

Quick Tip:  You can quickly create new input control tab by dragging a parameter (from 

a menu or another input control window) to the blank area to the right of existing tabs.  

By doing so, a new tab will be created and the parameter assigned to it.  This eliminates 

the need for clicking on the “New Tab” button first. 

INPUT CONTROLS PROPERTIES 

Once you have created one or more control tabs and filled them with parameters to be used as 

interactive controls, you can then specify the properties of the controls themselves. 

Clicking the Input Controls Properties… button (Figure 6-7) will bring up the Control 

Properties dialog.   

 

Figure 6-7 – Accessing Input Control Properties 

In this dialog window, you can specify the units, ranges, and types of controllers for each input 

control parameter, as shown in Figure 6-8.  

There are several different options for the type of controller, including: 

1. Slider 

2. Up/Down (increment) 

3. On/Off (discrete variables only) 

4. Analyze (Step & Monte Carlo) 

5. Optimize 

6. File Input 

7. Database 

Note: Some options may not be available depending on the specific variable 
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Figure 6-8 – Input Control Properties showing Control Type Options 

The interpretation of minimum (Min), maximum (Max) and increment (Delta) values is different 

for each type of control as described below. 

• Slider Control: The minimum and maximum values define the total range of the slider. 

The resolution of the slider is 1/100th of the range calculated as maximum value - 

minimum value. The value of delta is ignored.  

• Up/Down (increment) Control: The minimum and maximum values define the range 

over which the variable can be incremented. The value of delta is taken as the increment 

value.  

• On/Off (discrete) Control: For this control, there are discrete choices (two or more). 

Values for minimum, maximum, and delta are ignored. 

• Analyze Control: The minimum and maximum values define the limits of the analysis. 

For more information about analyze control, see CHAPTER 9. 

o In a step sensitivity analysis, the independent variable varies from the minimum 

value to the maximum value in increments of delta.  

o In a Monte Carlo analysis, the independent variable varies randomly within the 

range following the defined probability function 

• Optimize Control: The minimum and maximum values are used as constraints in the 

optimization procedure. The optimizer will not set the independent variable to a value 

less than the minimum nor greater than the maximum. The delta value is ignored. For 

more information about optimize control, see CHAPTER 10. 

• File Input Control: The minimum and maximum values are used to filter the input data. 

When a datum is read, it is compared with these values. If the input datum is less than the 

minimum, then it is set equal to the minimum value. If the input datum is greater than the 

maximum, then it is set equal to the maximum value. The delta value is ignored. For 
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more information about file input controls, see the Using File Input Controllers section 

of this chapter. 

• Database Control: Similar to the file input control, this control reads a time series of 

data from a database (such as MySQL).  The minimum and maximum values are used to 

filter the input data. When a datum is read, it is compared with these values. If the input 

datum is less than the minimum, then it is set equal to the minimum value. If the input 

datum is greater than the maximum, then it is set equal to the maximum value. The delta 

value is ignored. Use of the database input control is limited to users with the Advanced 

Online Features option activated in their license.  For further information, please contact 

Hydromantis. 

RENAMING AN INPUT CONTROL TAB 

The name of an input control tab can be changed by simply double-clicking on the tab 

name, changing the text, and pressing ‘Enter.’ 

 

Figure 6-9 – Renaming a Control Tab (Method 1) 

Alternatively, right-clicking anywhere on the tab (other than parameter names) and 

selecting “Rename Tab” will bring up the window shown below: 

 

Figure 6-10 – Renaming a Control Tab (Method 2) 

REMOVING A CONTROL 

To remove a variable from an Input Control tab, right click on the parameter name, and select 

“Remove Input Control”, as shown in Figure 6-11. 
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Figure 6-11 – Removing an Input Control (Method 1) 

 

You can also remove the controller by accessing the “Input Control Properties…” dialog window 

and clicking on the red ‘x’ beside the variable (Figure 6-12). 

 

Figure 6-12 – Removing an Input Control (Method 2) 

TRANSFER CONTROLLER VALUES 

There are times when you may have used the controllers to fine-tune a calibration of your model 

and once you are satisfied with the results, you’d like to use those values as the default values for 

either your layout or a scenario (for information on scenarios, see the section Using Scenarios in 

CHAPTER 8). 

To accomplish this, we have added two buttons to the Controls toolbar to simplify this task. 

Transfer Values to Layout 

This feature will give you the option of selecting (from the current tab) which control 

values you would like to transfer and use as the default values of your layout.  

Transferring values to the layout will cause the layout to be saved and the model to be 

rebuilt with the new values. 
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Figure 6-13 – Transfer to Layout 

Transfer Controls to Scenario 

This feature is only enabled if a scenario has been selected (see Using Scenarios).  It will 

give you the option of selecting (from the current tab) which control values you would 

like to transfer and use in the scenario.  As opposed to transferring the values to the 

layout, this action does not require for the model to be rebuilt.   

USING FILE INPUT CONTROLLERS 

In many cases, it is desirable to use data generated outside of GPS-X as input to the simulation 

model.  

For example, it might be convenient to use actual plant influent flow and composition data as 

input to the model to observe the difference in response between the plant effluent data and model 

predictions. Operational reports, such as those recording a step-feed strategy, might be used to set 

up a file containing instructions on how to change the model to mimic the operation in the real 

plant.  

The File Input control type reads data directly from a properly formatted ASCII or Excel file.  

There are two methods for preparing data for a File Input controller: manually preparing data 

files, and using the GPS-X data file editor. 

Manually Preparing Data Files 

Any number of data files (in standard ASCII text or Excel spreadsheets) can be read and 

used as model inputs (input excitations or driving functions) or for display in GPS-X.  

While the files can reside anywhere on your computer, it is suggested that you place them 

in the same directory as the layout files or a subdirectory of that location. 
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ASCII Text Files 

For ASCII text files, you’ll need to know the cryptic variable name and the time-stamped 

data values.   The file must be saved with the extension .dat or .txt. 

The format for this file is as follows: 

t<delim>cryptic-name-1<delim>cryptic-name-2<delim>...  

unit<delim>unit<delim>unit...  

time<delim>data-1<delim>data-2...  

.  

.  

.  

 

The first line in the file is a tab or space delimited header containing the identifier ‘t’ (for 

time) followed by the cryptic names for the independent variables. 

The second line specifies the units that the data is expressed in (columns are separated by 

delimiters). 

Subsequent lines must contain the time stamp, in decimal form and the data values 

(columns are separated by delimiters).   

An example of a data file for the variables bodcon and tkncon for the stream with a label 

of raw is shown below. 

 

Figure 6-14 – Example of ASCII Data File 

Excel Data Files 

Data files can also be prepared using Excel.  The format is similar to the ASCII text files, 

except that cells are used instead of delimiters to separate the data. 

The first row in Excel is the header line that contains the cryptic names for the variables. 

Time (‘t’) is the first column. 

The second row specifies the units that the data is expressed in. 

Subsequent rows must contain the time stamp, in decimal form and the data values. 
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An example of a data file for the variables bodcon and tkncon for the stream with 

a label of raw is shown below. 

 

Figure 6-15 – Example of an Excel Data File 

New Data File Creation Tool 

A tool has been included in GPS-X to simplify manual data entry in Excel by creating an 

Excel template file where the first two rows of data are populated by GPS-X.  

To access the New Data File Creation tool: 

 
(1) Open the Data File Menu. On the main toolbar press the Data File button 

to open the Data Files window. 

 (2) Create a new Data File. Pressing the New button on the Data Files 

window will open the New Data File Creation window. This will allow 

you to create a new Excel template file to be applied to the current scenario 

(see Using Scenarios) The New Data File Creation Window can be seen in 

Figure 6-16.  

 (3) Choose the Type of Data File. There are two types of data file variable 

types available: 

• If the Input Variable option is selected, the variables available to 

add to the data file will be limited to the variables that currently 

have an input controller. The data entered in this file will change 

the value of the input controllers during the simulation. 

• If the Output Variable option is selected, the variables available to 

add to the data file will be limited to the variables that are currently 

on an output display. The data entered in this file will be displayed 
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on the output graph to compare the simulation results to observed 

results (see CHAPTER 8). 

       Press Next. 

 (4) Select the Variables. All of the currently available variables will be 

grouped by the tab they are currently placed on in the options pane. 

Expand the tab name lists to select variables. When a variable is selected it 

will appear in the Current Selection pane. 

When all variable selections are made, press Next. 

 (5) Save the File. By default, GPS-X will save the Excel file with the same 

name as the layout in the same directory. These defaults can be changed by 

pressing the Browse button. 

Press the Finish button to save the file. You will be prompted to open the 

template file after it has been saved. 

 

Figure 6-16 – Using the New Data File Creation Tool 

Special Characters 

?  Fields in a data file that contain a question mark are interpreted as missing 

data.  In this case, the last valid data input for that variable is used. 



86 Optimization Tools 

GPS-X User’s Guide 

std If you enter a timestamp with the value ‘std’ that is interpreted as the 

value(s) to use at the start of a steady state simulation run.  As opposed to 

the value ‘0.0’ which is used at time zero (ie. the end of a steady state run 

– see Figure 7-23 for an example) 

Using the Data File Editor 

GPS-X contains a simple tool for writing and editing .dat files (ie. ASCII text files with 

an extension of .dat).  This tool can only create/edit a file that will be used for a single 

variable, so it’s use is only suggested in simple cases or for beginners to GPS-X.  More 

advanced users typically prefer to edit their files externally to GPS-X so that they can 

include many variables into one file.  

The editor can be accessed in several different ways: 

(1) Through the Input Control Properties dialog.  When you change the desired 

controller to a file input type, a button will appear beside the Type box that will give 

you access to the editor. 

 

Figure 6-17 – Accessing the Editor through the Control Properties dialog 

 

(2) Right-clicking on the controller label.  This will pop up a menu where “Data 

File…” is one of the options. 
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Figure 6-18 – Accessing the Editor through the Pop Up Menu 

 

(3) Right-clicking on the label in the data entry form. This will pop up a menu where 

“Data File…” is one of the option. 

ADDING INPUT FILES TO A LAYOUT 

Once the data files have been set up properly you have to let GPS-X know that it should use these 

files during the simulation.   

If you created the file using the GPS-X Data File Editor or the New Data File Creation tool, it is 

automatically added to the layout. 

However, if you manually created the files external to GPS-X, you need to explicitly let GPS-X 

know that they exist.  To do that: 

(1) Access the “Scenario > Configuration” dialog window from the Simulation Toolbar (see 

Scenario Configuration in CHAPTER 8). 

 

Figure 6-19 – Add Files through Scenario Configuration 

(2) From the list of scenarios (see Using Scenarios), choose the appropriate one and click the 

“Data Files” button.  This will display a dialog window with a listing of all the files that are 

currently being used by this scenario. 

 

(3) From this dialog, you can choose to Add, Remove, or Edit a data file. 
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Figure 6-20 – Add, Remove or Edit Data Files 

 

DYNAMIC DATA VALIDATION 

When manually creating a dynamic influent characterization data set, it can be time consuming to 

verify each set of influent conditions results in a valid influent characterization. To simplify this, 

GPS-X is equipped with a tool to automatically verify that each set of influent conditions creates 

a valid influent characterization. 

To use the Dynamic Data Validation tool: 

 (1) Open the influent advisor by right clicking on the Wastewater Influent object and 

navigating to Composition > Influent Characterization. 

 
(2) Open the Dynamic Data Validation tool by pressing the Dynamic Data Validation button in 

the bottom left corner of the influent advisor. 

 (3) If you have manually prepared an influent data file, provide it to GPS-X by pressing the 

Browse button next to the Input File entry field. If you have not yet created an influent data 

file, press the Create Template button to have GPS-X provide you with a list of all the 

variables in the influent advisor. Select the variables that you have data for, and press 

accept. Save the file and populate it with data. 

 (4) Create an Output File. Pressing the Browse button next to the Output File data entry field 

will prompt you to save a new file that GPS-X has created. This file is where GPS-X will 

write the results of the Dynamic Data Validation. 
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The Dynamic Data Validation tool will apply the influent conditions described in your input file 

to the influent advisor at each time step. The values calculated by the influent advisor at each time 

step will be written to the output file. You will be prompted to open the output file once GPS-X 

has completed the Dynamic Data Validation. 

In the output file any conditions that result in a influent advisor variable taking a negative value 

will result in those conditions being highlighted yellow. GPS-X will also highlight the negative 

values in that row red.  
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CHAPTER 7  

Preparing Output 

WHAT IS AN OUTPUT DISPLAY? 

Output refers to the graphical or textual information generated by GPS-X. This can exist as a 

display or as a data file. Displays can be static or they can be linked to the simulator such that the 

display is continuously updated as the simulation progresses.  

Output can also be saved to data files so that you can obtain prepare reports, store data in 

archives, etc. The sections below describe the types of output available and procedures for setting 

up and generating the output. 

In Simulation Mode, the main window is divided up into three different regions; Controls, 

Outputs, and the Drawing Board (Figure 7-1). 
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Figure 7-1 – Three Regions of Simulation Mode (Controls, Outputs, Drawing Board) 

Output displays are set up and used in the Simulation Mode.  They are organized into tabs. You 

can create as many tabs as you like and organize them in whatever way is convenient. 

OUTPUTS TOOLBAR 

At the top of the Outputs section of the main window is the Outputs toolbar.  This gives you 

access to many features pertaining exclusively to the output displays. 

 

Figure 7-2 – Outputs Toolbar 

 New Table Tab –This will start a wizard to help you set up a table with your 

desired output variables.  It will place the new table onto its own tab. See Table 

Displays for more information. 

 New Graph Tab –This will create a new tab for User-Defined Displays. 

 Delete Tab – This will delete the current tab and its contents. 

 
Auto Arrange – This will automatically size and arrange the user-defined output 

displays so that they are all visible on their tab and cover the available space. 

 
Output Properties… – See the Output Properties section below. 

 
Export – This displays a drop-down list of the options available to export data 

from GPS-X for use in a report or spreadsheet. 

 
Additional Output Displays – This displays a drop-down list of all available 

process schematic outputs. See Process Schematic Output Summary. 

  Tab Listing – This displays a drop-down list of all of the output tabs so that you 

can easily select the desired one.  This can be useful when you have many tabs. 

TYPE SUMMARY 

There are several different types of output displays.  Each output tab will contain one type of 

output and the label on the tabs have a different appearance depending on the type of output that 

it contains. 
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Quick Display 

These panels provide a quick summary of the most important information for each unit 

process object in the model. See the Quick Display section for more information. 

Table Displays 

The tables are user-defined summaries of model outputs across the entire length of the 

plant (which can also be displayed in graphical form).  See the Table Displays section 

for more information. 

Bar Charts from Table Display 

A visual representation of a row in the Table Displays can be created.  See the Bar 

Charts from Table Display section for more information. 

User-Defined Displays 

The tabs that contain user-defined output displays can contain one or more graphs 

constructed from any output variable in the model.  See the User-Defined Displays 

section for more information. 

The following eight types of output displays are available to plot any output variable 

from any unit process: 

1. X-Y time series plot – with time on the X-axis and the dependent variable on the Y-

axis. 

2. X-Y Scrolling time series plot – with the same axis labels as an X-Y time series plot 

and scrolling to the right with each time increment. 

3. Bar Chart (primarily for array variables) – with each vertical bar representing a 

single array element’s value. 

4. Bar Chart (Horizontal) – similar to Bar Chart, but with the bars running 

horizontally, instead of vertically. Primarily for display of clarifier data. 

5. Digital – displays only the current value of a variable. 

6. 3-D Bar Chart – displaying 2-D arrays where the z-axis is the array element’s value. 

7. Grayscale – where an element’s value is associated with a shade of gray. 

8. Probabilistic (Monte Carlo) – histogram representing percent probability of each bin. 
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In Analyze Mode, GPS-X substitutes the specified independent variable for time on all 

the time series displays to create a special X-Y plot. Refer to the Creating User-Defined  

section below, and CHAPTER 9 for more information on this type of graphic.  

State Point Analysis 

The secondary clarifier objects (circular and rectangular) provide options to plot State 

Point Analysis Graphs. 

Send Data Directly to File 

This option sends the simulation data directly to a plain text file.  You may wish to do 

this to store simulation data for processing externally to GPS-X.  See the Saving Data to 

Text File section for more information. 

PROCESS SCHEMATIC OUTPUT SUMMARY 

In addition to the output displays that are set up in the Output section of the main window, there 

are four types of Process Schematic Outputs that are shown in their own display windows since 

they require more space to visualize.  The four types are: 

Sankey Diagram 

Five commonly used variables (Flow, TSS, COD, TN, and TP) can be displayed on a 

Sankey diagram. Sankey diagrams are flow diagrams that display variable quantities in 

terms of arrow width. This allows users to look at the plant's performance visually. See 

the Sankey Diagram section for more information. 

Energy Usage Summary 

This feature generates an energy usage summary based on the operational conditions and 

costs specified by the user.  The values are displayed as a varying intensity of color 

around the unit process on the drawing board. 

Operating Cost Summary 

This feature generates an operating cost summary based on the operational conditions and 

costs specified by the user.  The values are displayed as a varying intensity of color 

around the unit process on the drawing board 

Mass Balance Diagram 

Five commonly used variables (Flow, TSS, COD, TN, and TP) can be displayed on a 

Mass Balance diagram. Mass Balance diagrams are flow diagrams that display variable 

quantities in a tabular form. This allows users to look at the plant's performance 

numerically. See the Mass Balance Diagram section for more information. 
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QUICK DISPLAY 

The Quick Display panels available in Simulation Mode are designed to present the important 

information to the user in the easiest manner possible. When you first build a layout, a Quick 

Display panel for every process on the drawing board is automatically created for you as a good 

starting point for setting up your outputs.   

You can remove any of the Quick Displays that you aren’t interested in by using the “Delete Tab” 

button on the Outputs Toolbar. 

Double-clicking on any object in the drawing board will either create a Quick Display tab for that 

object (if it doesn’t already exist) or select the existing Quick Display tab. 

 

Figure 7-3 – Example of Quick Display 

 

Select variable to display 

at each connection point. 

Unit process image with 

values at each connection 

point. 

Table of the most 

important simulation 

results for this object. 

Additional operational 

variables specific to this 

object. 

Mass flows in and out of 

this object. 

Tabs to switch 

between physical 

and operational 

parameters 
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Exporting Data from Quick Displays 

 
The entire Quick Display can be exported to an Excel spreadsheet by clicking on the 

“Export Data to an Excel File” menu item found in the Export button drop down list on 

the Outputs Toolbar.  This will open a file browser where you can choose the name and 

location of the file.  

 

Figure 7-4 – Quick Display Exported to Excel 

 
Additionally, the entire Quick Display can be exported to a Word document by clicking 

on the “Export Tab to Word” menu item found in the Export button drop down list on 

the Outputs Toolbar.  This will open a file browser where you can choose the name and 

location of the file. 
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Alternatively, you can copy the data (text only) to the system clipboard by clicking the 

“Copy Data to Clipboard” menu item from the Export drop down list Outputs Toolbar.  

The data can then be pasted into a report or spreadsheet. 

If you only wish to export a specific selection of the data, simply highlight the rows in the 

Quick Display table and then right-click on it.  A popup menu with the options of either 

copying the selection or the complete table is presented. 

 

Figure 7-5 – Quick Display Copy to Clipboard 

TABLE DISPLAYS 

Reporting simulation data in a Tabular format is very convenient for preparing outputs for 

selected stream and process variables. The stream variable tables are very useful for viewing the 

mass balance of the most important plant variables across the whole plant. 

There are two types of Table Displays: 
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Stream Variables 

These tables display variables that are associated with the streams like flow rates, state 

variables and composite variables. An option is provided to tabulate the concentration 

values and/or the mass flows for the streams. 

Process Variables 

These tables display variables that are associated with the process itself like volume, 

HRT, organic loading, energy consumption, etc. 

 

Setup Wizard 

 To create a Table Display, click on the “New Table Tab” button on the Outputs 

Toolbar.  This will start the Table Properties Setup wizard (Figure 7-6).  

(1) The first option to select under Table Type is whether you would like this table to 

display stream variables or process variables (see above for distinction). 

(2) If this is going to be a stream variable table, you must decide whether to include the 

concentration values and/or the mass flows. 

(3) You then simply select the location of the variables (left pane) and the specific 

variables themselves (right pane). 

(4) When you are satisfied with your selection, click ‘Accept’ to create the Table Display 

tab (Figure 7-7). 
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Figure 7-6 – Table Display Setup Wizard 

 

Figure 7-7 – Example of a Table Display 

Exporting Data from Table Displays 

 
The entire Table Display can be exported to an Excel spreadsheet by clicking on the 

“Export Data to an Excel File” menu item from the Export drop down list on the 

Outputs Toolbar.  This will open a file browser where you can choose the name and 

location of the file. 
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Additionally, the entire Table Display can be exported to a Word document by clicking 

on the “Export Tab to Word” menu item found in the Export button drop down list on 

the Outputs Toolbar.  This will open a file browser where you can choose the name and 

location of the file. 

 
Alternatively, you can copy the data (text only) to the system clipboard by clicking the 

“Copy Data to Clipboard” menu item from the Export drop down list Outputs 

Toolbar.  The data can then be pasted into a report or spreadsheet. 

 If you only wish to export a specific selection of the data, simply highlight the rows in 

the table and then right-click on it.  A popup menu with the options of either copying the 

selection or the complete table is presented. 

 

Figure 7-8 – Table Display Copy to Clipboard 

Settings 

 
Clicking on the “Output Properties” button on the Outputs Toolbar, will bring up the 

Setup Wizard where the current selections can be changed. 

Column Order 

Right-clicking on the Table Display will pop up a menu where one of the options is 

“Column Order…” (Figure 7-8).  This will display a dialog window where you can 

change the default order of the column in the table. 
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BAR CHARTS FROM TABLE DISPLAY 

 You will notice that each row in the Table Display will have a small “Graph” button (Figure 

7-7).  This button creates a bar chart of that row’s data.  A new tab will be created that shows all 

data in the selected row. (see Figure 7-9) 

 

Figure 7-9 – Bar Chart created from Table Display 

Settings 

 
Clicking on the “Output Properties” button on the Outputs Toolbar, will display a 

dialog window where you can change various settings for the Bar Chart 
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Figure 7-10 – Bar Chart Properties 

The options include settings for the y-axis (autoscale or setting the maximum value, and 

units), as well as the order of the bars.  You can also remove a variable from the chart by 

selecting it from the list and clicking “Delete”. 

USER-DEFINED DISPLAYS 

You can create any number of user-defined graphs on multiple tabs. This allows users to plot 

additional information in formats that are the most useful for the simulation task at hand. 

These displays must be created before running a simulation. This means that in setting up a 

simulation, you should consider the types of graphics desired, the variables to be plotted, and 

their minimum and maximum values. Think about the model behavior you would like to observe 

and ways to group output variables to maximize the information content.  

Here are some guidelines for presenting data in output displays: 

• Group Variables to be compared within a Single Graph. For example, the state variable 

related to phosphorus removal in a single reactor can be compared easily if they are on 

the same display. Grouping encourages a visual comparison for the results. 

• Display 6 or fewer Graphs on a Single Tab. If you require a large amount of data to be 

plotted, create several tabs to allow fewer graphs per tab. 

• Use Digital Displays when only the Instantaneous Value is Important. For example, in 

some simulations, only the current solids retention time is important. Digital displays 
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don’t provide information on rates of change but are convenient for displaying single 

values. Up to 20 variables can be displayed on a single digital display. 

• Use X-Y or Scrolling X-Y Graphic Displays when the Past History, Level and Rate are 

Important. These displays provide information on the past history (depending on the 

x-axis scale) of the variable, its instantaneous level and its rate of change. 

• Use Bar Chart or Bar Chart (Horizontal) for Comparison of Levels and Rates of 

Change in Array Variables. Many array variables are defined in GPS-X and most are so 

defined because of some spatial relationship between their elements, for example, the 

solids concentrations in each layer of a settler. Dynamic bar charts show the relative 

levels and rates of change for the variables in the array, but do not provide information on 

past history. 

• Use Grayscale or 3D Bar Chart to Display DO profiles, concentrations in a trickling 

filter, biofilm, etc. 

• Use Problematic (Monte Carlo) graphs when displaying data from Monte Carlo 

simulations. 

 

Figure 7-11 – Example of Different Types of Output Displays 
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It may take a few iterations to settle on an adequate display. You can stop the simulation at any 

time, right-click on output graphs to make changes, and then return to the simulation to view the 

new output. The specific procedures for these steps are examined in detail below. 

Analyze/Optimize Graphs 

The way an output graph is displayed depends on the simulation mode.  

For example, in Analyze Mode, the graphics can be modified to accommodate data in a 

sensitivity analysis. In this case, the independent variable is not time, rather it is the 

variable defined by the user as the focus of the analysis. See CHAPTER 9 Analysis 

Tools for more information. 

The display graphs also change in Optimize Mode. See CHAPTER 10 Optimization 

Tools for more information. 

Creating User-Defined Output Displays 

Once you have decided on the variables and kinds of graphics you would like to have 

displayed during a simulation, the next step is to instruct GPS-X to setup the output 

graphs. This step should be completed before running a simulation but you can iterate 

between the simulation and outputs setup to get the displays you like best.  The outputs 

setup procedure is similar to that used for setting up input controls. 

There are three major steps in setting up an output graph: 

1. Create one or more blank output display tabs by clicking on the “New Tab” 

button on the Outputs Toolbar. 

2.  Locate the variables to be displayed on graphs, and drag them to the blank 

output tab. 

3. Adjust the display properties. 

Creating a New Output Display Tab 

 The “Add Tab” button on the Outputs Toolbar creates a new, blank tab. This 

blank tab can be filled with graphs containing variables from Output Variables 

menus from any unit process object in the layout.  
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Specify Output Variables to Display 

Output variables include state variables and their derivatives, composite 

variables7, inputs, special calculated variables, user-defined variables, and model 

constants.  

Any of these variables, including system-related variables, can be displayed.  

If the variable you need is not available, but can be calculated from existing 

variables, you can define it and make it available for plotting. For more 

information on defining your own variables, refer to CHAPTER 11 Customizing 

GPS-X.  

 

Figure 7-12 – Output Variables in Process Menu 

To select a variable for display: 

1. In Simulation Mode, bring up the Process Data menu by right-clicking 

on an object icon or one of its connection points. Different variables are 

available at the different spots.  Note that the mouse cursor will change 

to an arrow when you are over top of a connection point. 

 
7 Composite variables are variables calculated from a combination of state variables and other constants. 
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Figure 7-13 – Different Spots to Access Different Variables 

2. Select the Output Variables menu as shown in Figure 7-12. 

3. Select the variable or variable group menu item of interest. A dialog 

window will be displayed with a list of the available options.  

If the output variable is an array, as shown in Figure 7-15, click on the 

array button ((…)) to access a second dialog window for selecting the 

individual elements of the array. 

4. Find the display variable and drag it to either 

i. an available blank area of the output tab (Figure 7-14) to create 

a new display.  It produces an X-Y graph by default, but this can 

be changed at a later date (see Output Properties section). 

ii. or drop it on an existing display to add it to that one. 

5. Close the dialog by clicking the ‘Accept’ button. 

Connection Points 

Connection Points 

Object Icon 
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Figure 7-14 – Dragging Variable to Output Display 

 

Figure 7-15 – Accessing Variable Array Dialog 

Quick Tip:  You can quickly create new output graphs by dragging a variable (from a 

menu or another input control window) to the area to the right of the output tabs. By doing 
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so, a new tab will be created and the output variable assigned to it. This eliminates the 

need for clicking the “New Tab” button first. 

Selecting Variables for Bar Charts 

Elements of an array variable can be displayed most conveniently in a bar chart. 

To select an array variable for display, use the same procedure as above, but 

select drag the entire array (ie. the label beside the (…) button) to the output area 

instead of dragging the individual array elements. 

Scalar variables can also be displayed in bar charts. In this case, the bar chart 

consists of a single bar; however, this is useful for displaying changes in sludge 

blanket heights, variable tank volumes, etc. 

Exporting Data from User-Defined Output Displays 

 

 

 

 

The entire Output Display can be exported to an Excel spreadsheet by clicking on the 

“Export Data to an Excel File”  menu item found in the Export button drop down list 

on the Outputs Toolbar.  This will open a file browser where you can choose the name 

and location of the file.  

Additionally, the entire Table Display can be exported to a Word document by clicking 

on the “Export Tab to Word” menu item found in the Export button drop down list on 

the Outputs Toolbar.  This will open a file browser where you can choose the name and 

location of the file.  

 

Alternatively, you can copy the data (text only) to the system clipboard by clicking the 

“Copy Data to Clipboard” menu item found in the Export button drop down list on the 

Outputs Toolbar.  The data can then be pasted into a report or spreadsheet. 

Output Variables vs Input Parameters 

The dialog windows that contain the output variables have a similar look to the data entry 

windows used to specify input values for a simulation. The output variable window 

differs in that simulation values are displayed, rather than showing an editable field for 

data entry. Keep this distinction in mind as you access the different window types to 

avoid confusing output variables with input parameters. 

Display Variable Locations 

Note the following conventions when selecting display variables: 

• The pumped flow stream, effluent flow stream and last reactor in a plug-flow tank 

have the same composite, state and stoichiometric display variable values. 
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• Not all connection points have the same list of display variables, and the display 

menu inside the object itself is different from that of the connection points. 

The display menus can be grouped into three broad categories: 

1. Inside the object; 

2. At the effluent or overflow connection point; and,  

3. At all other connection points 

These display menus are explained further in the next three sections. 

Internal Display Menus 

There are two types of internal display variable menus depending on the physical 

configuration of the object, as follows: 

1. Completely mixed or zero-volume objects; and,  

2. Objects with internal structure. 

In the first type, there is no spatial variation in the objects. 

The mathematical models are described by algebraic relations (for zero-volume 

objects) or ordinary differential equations (for completely mixed objects). In either 

case, no arrays are defined. The internal output variable menu is a copy of the menu 

at the effluent connection point. 

Objects of the second type include plug-flow tanks, layered settlers, sequencing batch 

reactors, and others. Concentrations may have a gradient in these objects. In 

mathematical terms, partial differential equations are used and arrays are defined. In 

these objects, the internal output variable menu is used to access the one-dimensional 

arrays. 

Effluent Display Menus 

There are two types of effluent, or overflow, output variable menus depending on the 

physical configuration of the object, as follows: 

1. Fixed-model objects (splitters, combiners, etc.); and, 

2. All other objects 

The display menus for effluent connection point of objects of the first type have the 

basic set of display variables, namely Model Information, Flow, Composite 

Variables, State Variables and Model Stoichiometry. 

The overflow location is a special connection point for the majority of the objects. It 

has three sets of output variables: 
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1. The basic display variables as for fixed-model objects; 

2. Those internal model variables that are scalars, i.e., volume, sludge blanket, 

etc.; and,  

3. Model parameters (just as in the Parameters menu, but only for display) 

Other Display Menus 

Display menus at these connection points have the basic set of display variables, 

namely Model Information, Flow, Composite Variables, State Variables, and 

Model Stoichiometry. 

Output Properties 

 Once you have selected variables for display and placed them on one or more output 

displays, you can customize the properties and appearance of each graph.  

 
This can be done by either clicking on the “Output Properties…” button on the 

Outputs Toolbar or right-clicking on an output graph to access the pop up menu and 

select the option from there.  

 

Figure 7-16 – Output Graph Properties Dialog 

As shown in Figure 7-16, this dialog window has 2 sections.  

Display Properties 

This section contains settings for the whole graph, such as title, graph type and the 

autoscale option.  

For a brief description of the different display types, see the User-Defined Displays 

overview section. 
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Autoscaling allows the program to determine the maximum value of the y-axis for you 

depending on the values of the variables during the simulation.  This feature applies 

collectively to all of the y-axis in the graph and they are all given the same maximum 

value. The maximum value adjusts appropriately during the simulation run. 

Variable Properties 

 The Variable Properties section contains individual settings for each of the variables in 

this display.  

 Note that some of the settings may be visible or not depending on the selections in the 

Display Properties section. 

 
To remove the variable from the graph, click the small ‘x’ beside the variable you wish 

to remove. 

 

 

If autoscale is not selected in the Display Properties section above, then you can 

explicitly state the minimum and maximum value that you’d like for the y-axis.  Beside 

the min/max lable is a lock icon.  If the column is ‘locked’ then that means that if you 

change one value, it will change it for the whole column.  ‘Unlocking’ the column 

allows you to specify a different min/max for each variable. 

 The Color column allows you to specify the color of the lines or bars.  Clicking on the 

small, colored box opens a color selector window that allows you to choose a different 

color. 

 The Save column allows you to automatically write data to a file located in the layout 

directory while the simulation is running for processing outside of GPS-X, such as 

preparing statistical summaries, presentation graphics or text documents.  See the Saving 

Data to Text File section for more details. 

 
The Data Points option allows you to display values from a file or database on the graph 

as points (as opposed to the simulation data which is displayed as lines).  Selecting 

“File” will display a “Data File” button that can be used to create or view the data.  The 

structure of the data file is the same as the files for File Input Controllers. See the 

Manually Preparing Data Files section for more information. 

Quick Tip:  The numerical value results from any graph can be instantaneously displayed 

by clicking on the graph itself. 
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Figure 7-17 – Graph Showing Instantaneous Values 

STATE POINT ANALYSIS GRAPHS 

State point analysis is incorporated in the secondary settlers to analyze the maximum solid 

loading rates for design purposes. State point analysis may be conducted by using the simulated 

MLSS concentration or a user-defined design MLSS concentration.  

To create a state point analysis graph, right click on the circular or rectangular clarifier objects, 

and select the Output Variables > State Point Analysis option, as shown below. 

 

Figure 7-18 – Creating a State Point Analysis Graph 

The state point analysis graph is dynamically updated for any fluctuation in the flow rates to the 

clarifier. A typical output of the state-point analysis is shown in Figure 7-19. 
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Figure 7-19 – Example of State Point Analysis Graph 

As long as the operation point (red dot) is within the red curve, and the green line is not crossing 

the red curve, the operational condition of the clarifier is considered to be safe. 

SANKEY DIAGRAM 

After a simulation has been run, you can choose to view a Sankey diagram with the choice of five 

common variables (Flow, TSS, COD, TN, and TP).  

Sankey diagrams are flow diagrams that display variable quantities in terms of arrow width. This 

allows users to look at the plant's performance visually and compare variable quantities.   

Viewing a Sankey Diagram 

 To view a Sankey diagram, run the simulation and click on the Sankey Diagram menu 

item found in the Additional Output Displays button drop down list on the Outputs 

Toolbar.  
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Figure 7-20 - Sankey Diagram Displaying Flow 

 

Options for the Sankey Diagram 

You can customize the look of the Sankey diagram in various ways and export the image 

to various formats.  The options are grouped into five categories. 

Size 

In the size category, you can manipulate the size of the output diagram by defining 

the number of pixels you would like diagram width height to be. By selecting 

Maintain Aspect Ratio, GPS-X will automatically scale the unchanged dimension to 

maintain a constant ratio between the diagram width and height. 

Display 

In the display category, you can choose to hide/show the Sankey lines themselves 

and/or the numerical values that are displayed on the diagram. 

If you are displaying the Sankey lines, you are also given the option to hide/show the 

mixed liquor streams.  You may choose to hide these streams because the values of 
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these streams are typically much larger than the other values and therefore 

overwhelm the visual difference in the other streams. 

NOTE: You can also hide/show individual streams by moving the mouse cursor over 

the stream (the cursor will change to a hand) and right-click.  If the stream is 

currently showing, you will be given the option to hide it and vice versa.  Right-

clicking on a blank area of the drawing board will give you to option to “Show All” 

currently hidden streams. 

Variable 

In the variable category, you can choose which variable to display and the unit that 

the value will be displayed in. 

You can also choose to hide/show the title on the diagram where the variable name 

and unit are displayed. 

Sankey 

This category gives you various options on the appearance of the Sankey lines. 

You can change the color by clicking on the little square that shows the current color. 

You can vary the maximum width of the Sankey lines by adjusting the slider. 

There are three effects that you can choose from for the Sankey lines. 

 1. No effect. This will just display the lines in the normal fashion. 

 2. Fade.  A width limit can be set such that any value greater than that 

width will cause the line to fade from a solid color to a more transparent 

value. 

 3. Darken. A width limit can be set such that any value greater than that 

width will not increase the width of the line but will instead darken the 

color of the line proportional to the value. 

 
NOTE: The width limit for the fade/darken effect is set by clicking the 

settings button beside the effect option.  This will pop up a dialog with a 

slider where you can adjust the limit and see the immediate effect on the 

diagram.  

Export 

This category gives you several options for exporting the image. 
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1. Save Image to File. Opens a file browser where you can choose the 

name and location of the image file to save the diagram to. 

 
2. Copy to Clipboard.  Copies the image to the system clipboard so that 

you can paste it into a report or spreadsheet. 

MASS BALANCE DIAGRAM 

After a simulation has been run, you can choose to view a Mass Balance diagram with the choice 

of five common variables (Flow, TSS, COD, TN, and TP).  

Mass Balance diagrams are flow diagrams that display variable quantities in a tabular form. This 

allows users to look at the plant's performance numerically and compare variable quantities.   

Viewing a Mass Balance Diagram 

 
To view a Mass Balance diagram, run the simulation and click on the Mass Balance 

Diagram menu item found in the Additional Output Displays button drop down list on 

the Outputs Toolbar. This will start the Mass Balance Diagram wizard (Figure 7-21). 

 

Figure 7-21 - Mass Balance Wizard Setup Menu 

(1) The first option to select under Table Contents is what columns you would like 

to be displayed in each individual table (variable label, concentration and mass 

flow rate). You can then specify which variables you would like to be included 

in the tables (Flow, TSS, COD, TN, and TP) in the rows section. 
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(2) You then select the streams that interest you. When you are satisfied click Finish 

to create a Mass Balance Diagram. 

(3) You will be asked if you would like to auto arrange the table locations, which 

will organizes the tables around the perimeter of the diagram close to the stream 

that they represent. 

 

Figure 7-22 – Mass Balance Diagram 

 

Options for the Mass Balance Diagram 

Once the Mass Balance diagram has been generated, you can drag the tales anywhere you 

would like within the diagram. 

You can further customize the look of the Mass Balance diagram in various ways and 

export the image to various formats.  The options are grouped into five categories. 
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Size 

In the size category, you can manipulate the size of the output diagram by defining 

the number of pixels you would like diagram width height to be. By selecting 

Maintain Aspect Ratio, GPS-X will automatically scale the unchanged dimension to 

maintain a constant ratio between the diagram width and height. 

Display 

In the Display category, you can choose to snap to tables which will attempt to align 

the tables with other tables or object in the diagram when you move them. 

You can also choose to reopen the Setup Wizard in this category which will allow 

you to add or remove tables from the Mass Balance Diagram. 

NOTE: You can also hide individual tables by moving the mouse cursor over the 

table and right-click.  You will be given the option to hide the table. 

Location Lines 

In the Location Lines category, you can choose if you would like there to be lines 

connecting the tables to the stream they are representing. 

You can also choose where you would like the location lines to connect (midpoint or 

start of the stream) if location lines are shown. 

Content 

This category gives you various options for the content in the tables. 

You can add the stream name as a header in each table by selecting the Showstream 

label option. 

You can modify which column and row values selected in the setup wizard are 

shown in the tables. 

You can also adjust the adjust the number the number of significant digits you would 

like present in the tables. Export 

This category gives you several options for exporting the image. 

 
3. Save Image to File. Opens a file browser where you can choose the 

name and location of the image file to save the diagram to. 

 
4. Copy to Clipboard.  Copies the image to the system clipboard so that 

you can paste it into a report or spreadsheet. 
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ENERGY USAGE AND OPERATING COST SUMMARY 

After a simulation has been run, you can choose to view a plant schematic output summary of 

either the Energy Usage or Operating Costs.  These two summaries are discussed together here 

since their appearance and settings are similar and the only difference is the type of data that is 

displayed. 

Energy Usage Summary   

The model tracks power consumption for aeration, pumping, mixing, heating, and other.  

To view an energy usage summary, run the simulation and click on the “Energy Usage 

Summary” menu item found in the Additional Output Displays button drop down list 

on the Outputs Toolbar.  

Operating Cost Summary   

The model tracks operating costs for aeration, pumping, chemical dosage, sludge 

disposal, and miscellaneous. 

To view an operating cost summary, run the simulation and click on the “Operating Cost 

Summary” menu item found in the Additional Output Displays button drop down list 

on the Outputs Toolbar.  

Summary Views 

The dialog window that is shown when choosing one of the options above, has two 

different views of the data. 

Layout View 

In layout view, an image of the layout is shown with ‘hot spots’ around the unit processes 

that represent the value of the variable that is being displayed.  The intensity of the color 

of the ‘hot spot’ increases as the value gets larger.  

An example is shown in Figure 7-23 where the total power of each unit process is being 

displayed. 
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Figure 7-23 – Summary Dialog (Layout View) 

Table/Pie View 

In Table/Pie view, the window is divided in two with a table of the different values on the 

left and a pie chart representation of either the select row or column of data.  

An example is shown in Figure 7-24 where the row with the total power of each unit 

process is selected. 

 

Figure 7-24 – Summary Dialog (Table/Pie View) 
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Options for the Layout View 

You can customize the look of the plant schematic diagram in various ways and export 

the image to various formats.  The options are grouped into four categories. 

Size 

In the size category, you can manipulate the size of the output diagram by defining 

the number of pixels you would like diagram width height to be. By selecting 

Maintain Aspect Ratio, GPS-X will automatically scale the unchanged dimension to 

maintain a constant ratio between the diagram width and height. 

Display 

In the display category, you can choose to hide/show the color indicator (ie. ‘hot 

spot’) and/or the numerical values that are displayed on the diagram. 

Variable 

In the variable category, you can choose which variable to display and the unit 

that the value will be displayed in. 

You can also choose to hide/show the title on the diagram where the variable 

name and unit are displayed. 

An option to change the color of the ‘hot spot’ also exists.  Clicking on the 

colored square box beside the variable option will display a color selection 

dialog. 

Export 

This category gives you several options for exporting the image. 

 
1. Save Image to File. Opens a file browser where you can choose the 

name and location of the image file to save the diagram to. 

 
2. Copy to Clipboard.  Copies the image to the system clipboard so 

that you can paste it into a report or spreadsheet. 

Options for the Table/Pie View 

Export 

 Similar to above, you can export the data/image in various forms. 
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View 

 The only View option is the ability to change the highlighted selection between 

rows and columns.  You can either use the button on the toolbar or you can 

click on the row or column header to switch it. 

SAVING DATA TO TEXT FILE 

In addition to the Microsoft Excel reports that can be generated for any graph, the simulation 

results can be saved directly to a plain text file (tab delimited) while a simulation is running. 

In the Output Properties dialog window (Figure 7-16), there is an option to ‘Save’ the variable. 

If this check box is selected, the data from the simulation will automatically be saved to a file. 

All variables that are to be saved will be written to the same file that is located in the same 

directory as the layout file.  The name of the file will have the following format: 

layoutname_scenarioname_yyyy_mm_dd.out  

Where layoutname is the name of the current layout,scenarioname is the name of the 

current scenario and yyyy_mm_dd is the date specified in the Site Properties window under the 

“Simulation Setup” tab. 

Contents 

The columns in the file are delimited by tabs. 

The first line contains a list of the selected variables, starting with the identifier ‘t’ to 

indicate the time column. 

The second line lists the units of each variable.  

If a steady-state evaluation was performed before the run begins, the third line begins 

with the identifier ‘std’ followed by the results of the steady-state evaluation for each 

variable.  

The remaining rows contain the time stamp and value(s) for each variable. 
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Figure 7-25 – Example of Plain Text Output File 

The .out file remains open until you return to Modelling mode or close the layout.  

If Start is selected more than once, any existing file will be overwritten; therefore, the .out file 

will always contain the results of a single simulation run from the starting time to the stopping 

time at the interval indicated by the value of the Communication interval.  

If desired, you can rename the output data file or move it to a different directory so that 

subsequent simulations do not overwrite the file. 

Using Output Data as Input Data 

As GPS-X output data files have the same format as input data files, you can use the 

input/output capabilities to emulate a record/run macro. 

To record a simulation session: 

1. Set-up the variables you want to record for file output. In this case, these 

would be variables that you set up as interactive controls (eg. sliders). 

2. Run a simulation, changing the values of the controllers as you like.  

3. Rename the output data file to conform to the input data file convention. To 

do this, simply change the extension of the file from ‘out’ to ‘dat’. 

4. For each variable specified in Step 1, change the input controller from the 

interactive control to a File Input control and run the simulation. 

When you run the simulation in step 4, the variable values will be read from the input 

data file, essentially reproducing the simulation you performed in step 2.  

This technique is useful for generating artificial scenarios.  

For example, if you want to generate data which approximate a storm event, you can use 

this method to save data as you manually change the influent flow. Later you can use this 

data for testing the effects of the storm flow. 
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GENERATING A REPORT 

Reports can be exported to a Microsoft Excel spreadsheet file or a Microsoft Word document.  

These reports can contain images, data, parameter values, model results, and any other 

combination of text and images. 

The report can be generated either before or after simulation.   

Reports generated in Modelling Mode will contain only the information about the model and 

parameter defaults.   

Reports generated in Simulation Mode can also contain information about the current state of the 

model, and time series data from the most recent simulation. 

There are three types of reports: 

1. Standard Word Report 

2. Standard Spreadsheet Report 

3. Custom Spreadsheet Report 

 
You can access the report dialog by either selecting Report from the File Menu or clicking on 

the Report button on the Main Toolbar.  

 

Figure 7-26 – Report Dialog 
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Standard Word Report 

Standard Word reports use a fixed format and style to display all model input, output and 

simulation results.   

By default, all information will be included in the report.  If you wish to exclude certain 

types of information, select the “Options…” button.   

The Options Dialog (Figure 7-27) allows users to specify which types of information are 

to be included in the standard Word report. The information is organized under multiple 

headings within the report. 

 

Figure 7-27 – Options Dialog (Standard Word Report) 

Quick Tip:  In cases where a user has entered information into the 

“Notes” field for a parameter that information is inserted included in 

the General/Parameter Notes section of the report, where each object 

with a Note will be given a table. 

 

Standard Spreadsheet Report 

Standard spreadsheet reports use a fixed format and style to display all model input, 

output and simulation results.   

By default, all information will be included in the report.  If you wish to exclude certain 

types of information, select the “Options…” button.   
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The Options Dialog (Figure 7-28) allows users to specify which types of information are 

to be included in the standard spreadsheet report. The information is organized into 

multiple worksheets within an Excel file. 

 

Figure 7-28 – Options Dialog (Report to Standard Spreadsheet) 

Quick Tip:  In cases where a user has entered information into the 

“Notes” field for a parameter that information is inserted into the 

report as an Excel comment attached to the cell that contains the label 

of that parameter 

If you would like a company logo automatically inserted on the front page of the report, 

place the image (in .bmp, .gif, .jpg, .png,  or .tiff format) in the following sub-directory of 

the GPS-X installation directory: 

\bin\gpsx\resources\images\report 

Custom Spreadsheet Report 

The custom report option uses an XML-type template to specify which data are inserted 

into the report, with its location and formatting.  A good understanding of the XML 

format is assumed if you are going to use this custom report option. 

The template file (with the extension “.gpr”) contains a series of tags that describe how 

the report is to be laid out. 

To generate a custom report, select the Custom Report option from the Report Dialog 

(Figure 7-26).  You will be prompted to either browse to an existing template or to create 

a new template with the Template Editor. 
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Template Editor 

Clicking the Template Editor button on the Report Dialog starts the template editor. 

 

Figure 7-29 – Template Editor 

In most cases, you’ll want to start with the standard report template and then proceed to 

organize and add/remove items to customize it to your preferences. 

To create a new template, select “New” from the File menu and choose “Standard Report 

Template” to populate the editor window with the XML specification of the currently 

selected report options.   

Quick Tip:  You can access the standard options through the Edit > 

Standard Template Options menu item to include/exclude certain 

items before creating a new template to begin from a closer starting 

point to your desired results. 
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Figure 7-30 – Example of a Template File 

The GPS-X report template will contain various XML tags.  

The report template must: 

• Start with a <xml version=“1.0” encoding=“UTF-8”?> header tag 

• Include exactly one <report> </report> tag pair that encloses the entire 

customized XML report specification. 

Each <report> contains one or more <sheet> </sheet> tag pairs. 

 A sheet tag corresponds to one Excel sheet. Each <sheet> tag can contain one or more 

of the following tags: 

• <image> 

• <datestamp> 

• <layout> 

• <object> 

• <output> 

• <data> 

• <value> 

• <text> 
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The following sections describe the use of the above tags: 

 

XML Tag Description 

 

<sheet  name=””> 

</sheet> 
name Label of sheet tab 

 

<image   

imagepath=””  

imagewidth=””  

imageheight=””  

cell=”” /> 

 

imagepath 
Path to location of image file (bmp, gif, jpg, png, tiff) 

i.e. C:\images\image.jpg 

imagewidth Number of columns the image will span 

imageheight 

Number of rows the image will span (if imagewidth 

and imageheight are not specified, the image will be 

inserted at the original aspect ratio) 

cell 
Place top left corner of image in cell(col,row), i.e. 

cell=“A4” 

 

<datestamp cell=””/> cell 
Insert date/time in cell(col,row) 

i.e. cell=“A4” 

 

<layout  

    name=””  

    cell=””  

    image=”true|false” > 

layoutname  </layout> 

layoutname GPS-X layoutname 

name Layout title. Defaults to “layoutname” 

image 
Show content of GPS-X drawing board. Defaults 

“true” 

cell Cell(row,col) i.e. cell=“A4” 

 

<object  

   image=”true|false”  

   inputs=”true|false” 

   inits=”true|false”    

   outputs=”true|false” 

> 

objectid </object> 

objectid Is a process object ID (see Table 1 for valid IDs) 

image 
Show process table image for process. Defaults 

“true” 

inputs Show process input parameters. Defaults “true” 

Inits Show process initial conditions. Defaults “true” 

Outputs 
Show display variables.  

Defaults “true” 
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XML Tag Description 

 

<output  

   image=”true|false” 

   imagecell=”” 

   imagewidth=”” 

   imageheight=”” 

   data=”true|false”  

   cell=””  

   stats=”true|false” > 

graphname 

</output> 

 

 

image Show image of graph. Defaults “true” 

imagecell 
Top left corner of graph image 

i.e. cell=“B10” 

imagewidth Number of columns image will span 

imageheight Number of rows image will span 

data 
Display data from graph.  

Defaults “true” 

cell 
Top left corner of data column(col,row) 

i.e. cell=“A4” 

stats 
Display statistics (min, max, mean, std dev). Defaults 

“true” 

graphname Title of graph 

 

<data  

    cell=””  

    xdata=”true|false”  

    stats=”true|false”  

    npoints = “”>  

variables </data> 

 

cell 
Location of data to be inserted 

i.e. cell=“A4” 

xdata Inserts X-axis (e.g. t) data. Defaults “true” 

stats 
Show statistics (min, max, mean, std dev). Defaults 

“true” 

npoints 

Show only the last npoints number of data points in 

the time series. Default is to show the entire time 

series. To be inserted into the report, all variables 

must be on visible graphs 

variables Space delimited list of cryptic variable names 

 

<value  

    name=””  

    cell=””  

    stream=””>  

variables</value> 

name Descriptive label 

cell 
Insert current value, starting at (col, row) 

i.e. cell=“A4” 

stream Stream label associated with variables 

variables Space delimited list of cryptic variable names. 

 

  



130 Optimization Tools 

GPS-X User’s Guide 

XML Tag Description 

 

<text  

    value=””  

    cell=””  

    bold=”true|false”  

    italics=”true|false” 

    color=”” 

    bgcolor=”” 

    align=”” 

    size=”” /> 

 

value Text string to be inserted 

cell 
Location to insert text 

i.e. cell=“A4” 

bold Bold text formatting 

italics Italic text formatting 

color Text color (default is black) 

bgcolor Background cell color 

align 
Alignment of text within the cell options are Left, 

Right, Centre Fill, General, Justify 

size Size of font 

 

Available color names are: 

black bright green sky blue 

white sea green pale blue 

red dark green rose 

dark red olive green lavender 

yellow teal tan 

dark yellow dark teal aqua 

light blue grey 25% lime 

pink grey 40% gold 

turquoise grey 50% orange 

light turquoise grey 80% light orange 

green blue grey brown 

light green dark blue indigo 

blue violet plum 
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STATISTICAL ANALYSIS 

If you have set it up so that measured data is being plotted on a graph (see Data Points in the 

Variable Properties section) then you can perform a number of statistical analyses of the 

difference between the simulation and the measured data.   

These evaluations provide you with an estimate of the quality of the simulation (compared to 

measured data) during the process of model calibration. 

Setting Up a Statistical Analysis 

For any X-Y (time series) graph that contains data read from a file, a statistical analysis 

can be set up by right-clicking on the graph, and selecting the Statistics menu.  

 

Figure 7-31 – Accessing Statistics Menu 

This will bring up a menu of the available parameters on this X-Y graph as shown above.  

Select the desired variable to access the Statistics dialog for that particular variable. 

From the Statistics dialog, you can create a table of goodness-of-fit statistics, a plot of 

simulated vs. measured data points, and/or a histogram of standardized residuals.  Each 

graph will be created in a new window on the current tab, and can be auto arranged, 

resized and/or dragged to another tab as needed. 
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Figure 7-32 – Statistics Dialog 

In addition, you can create graphs of the various types of residual analyses by selecting 

the desired graph from each of the two columns (plot against measured values, plot 

against time) in the “Residual Analysis” section of the dialog. 

You can specify the nature of the measured samples being used in the statistical analyses 

(e.g. residuals) by selecting the appropriate sample type from the drop-down box in the 

“Measured Data Type” section. 

Once plots/tables have been created, you can access this dialog again by right-clicking on 

any of the produced graphs, and selecting the Statistics menu option.   

Full details on the calculation of all statistical analyses can be found in the Technical 

Reference manual. 

Exporting Data from Statistical Analyses 

 
The entire graph can be exported to an Excel spreadsheet by clicking on the “Export 

Data to an Excel File menu item found in the Export button drop down list on the 

Outputs Toolbar.  This will open a file browser where you can choose the name and 

location of the file. 
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Additionally, the entire graph can be exported to a Word document by clicking on the 

“Export Tab to Word” menu item found in the Export button drop down list on the 

Outputs Toolbar.  This will open a file browser where you can choose the name and 

location of the file. 

 
Alternatively, you can copy the data (text only) to the system clipboard by clicking the 

“Copy Data to Clipboard” menu item found in the Export button drop down list on 

the Outputs Toolbar.  The data can then be pasted into a report or spreadsheet. 
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CHAPTER 8  

Building and Running a Model 

DYNAMIC MODELLING & SIMULATION 

Dynamic modelling in wastewater treatment starts with a formal description of the relationships 

between variables in unit processes; that is, development of models. This task of synthesis has 

been one of the primary bottlenecks in the application of models to wastewater treatment. Over 

the years, an extensive effort has gone into formalizing models of different unit processes in 

wastewater treatment. These models have matured to the point where they are valuable tools for 

the practitioner.  

Models 

Models are computer representations of real systems. The real systems of interest here are 

the unit processes in a wastewater treatment plant, such as the aeration basin or the 

sedimentation tank in an activated sludge treatment system. Models in GPS-X can be 

classified as either mechanistic or empirical. The difference between empirical and 

mechanistic models is more a continuum than a rigid classification as mechanistic models 

often have some empirical component. 

Mechanistic models (Figure 8-1) are based on first principles, that is, laws of physics, 

chemistry, and biology. Actual data are used to modify parameters in these models. For 

example, the law of conservation of mass is the essential building block on which 

dynamic equations are based in GPS-X. Data collected in the real system are used to 

adjust physical dimensions, rate constants and other parameters in the equations. This is a 

"bottom-up" approach to modelling in which the model is provided a firm foundation by 

natural laws. These laws help us to understand more thoroughly the behavior observed in 

the real system and the model. Many of the models in GPS-X are mechanistic. 

Empirical models rely solely on data. In this approach, the model structure is determined 

by selecting from a set of general mathematical expressions such as those shown in the 

center of Figure 8-2. There is no guarantee that the selected model will be ‘correct’. 

Essentially, the data "speak for themselves" and ultimately dictate the form of equations - 

selected among a set of candidate equations on the basis of goodness-of-fit - to be used in 

the model. 

This "top-down" approach to modelling is weaker than the mechanistic approach as the 

model structure is simpler and the meaning less clear. A different set of data can often 

result in a different model structure and we are not always certain how to interpret the 
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meaning of parameters in the model. Nevertheless, empirical models are useful as long as 

their use is limited to the data ranges over which they were fitted, and in many cases, are 

the only choice when we have limited knowledge about the real system being modeled. 

For example, empirical models often give good predictions and can ultimately lead to the 

discovery of more general mechanistic expressions. GPS-X includes several kinds of 

empirical models. In these models, actual data determine which model to select and the 

values of parameters in the selected model.  

 

Figure 8-1 – Mechanistic Models are Based on First Principles 

 

Figure 8-2 – Empirical Models Fit the Data to a Certain Model Form 

State and Composite Variables 

The system of differential equations, which GPS-X automatically generates in the model 

building process, constitutes a precise, mathematical representation that describes the 

relationship between model variables. Some of these variables, referred to as State 

Variables, are important because they define the “state” of the system8. In the absence 

of any external excitation, the state variables determine how the system behaviour 

evolves over time. Secondary or composite variables are calculated from state variables 

and other constants so they always depend on how the state variables change. The 

difference between these two variable types is demonstrated in Figure 8-3. 

 
8 Here, “System” refers to the model, that is, the system of equations. 
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Figure 8-3 – Nitrogen State (Boxed Variables) and Composite (Bolded Text) Variables 

The essential behaviour of a model is closely linked to the response of the model’s state 

variables. This is a key to conducting effective sensitivity analyses. You can examine the 

behaviour of composite variables, and this is convenient as composites are often the kind 

of variable typically measured in a plant, for example, mixed-liquor suspended solids is a 

variable composed of several particulate state variables. As shown in Figure 8-3, Total 

Kjeldahl Nitrogen (TKN) is a composite variable calculated as the sum of soluble and 

particulate nitrogen state variables plus the nitrogen fractions of some organic state 

variables. State variables are the basis on which models are organized in the GPS-X 

libraries. 

State Variables and GPS-X Model Libraries 

Models are approximations of a real system. State variables are the essence of a model, 

but it was not described how these are selected. Given assumptions about the proper state 

variables, another problem is identifying the reactions that these variables undergo. This 

includes specific expressions for the reaction rate (kinetics) of each variable and the mass 

ratios (stoichiometry) between variables. 

In many cases there are obvious choices for state variables, such as substrate and biomass 

concentrations in the activated sludge process, but in general this requires care in 

selection. Simplifying assumptions must be made and these are reflected in the specific 

choice of state variables. Modelers always try to find a balance between model 

complexity and prediction capability as shown in Figure 8-4. Increasing the complexity 

of a model by adding new reaction terms, etc., may increase its ability to make more 

accurate predictions but it carries extra overhead including more difficulty in 

comprehending the model structure, additional data requirements and reduced calculation 

speed. Removing or simplifying reaction terms minimizes these problems but may result 

in less accurate predictions. No single model can explain all real system behavior 

under all circumstances so it is important to have flexibility in selecting the model to 

be used for a particular purpose. 
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GPS-X gives you the necessary flexibility in model selection by providing a number of 

libraries containing many state-of-the-art models. The model libraries available with 

GPS-X are shown in Table 8-1. 

 

Figure 8-4 – Balancing Multiple Objects is Important in Developing a Good Model 

 

Table 8-1 - Model Libraries Available in GPS-X 

Library Name Number of State 

Variables 

Comprehensive (Mantis2) 52 

Selenium and Sulphur (Mantis2S) 72 

Greenhouse Gas/Carbon Footprint (Mantis3) 56 

Process Water (Procwater) 68 

Petrochemical (Mantisiw) 52 

Carbon – Nitrogen (CN) 16 

CN Industrial Pollutant (CNIP) 46 

Carbon – Nitrogen – Phosphorus (CNP) 27 

CNP Industrial Pollutant (CNPIP) 57 

You have a choice with regard to the basic state variables you can model. You can get 

more information on each of these libraries in the Technical Reference. 

A Common Basis for Models 

Now that you are familiar with the general nature of unit process models available in 

GPS-X, you may question how the GPS-X system manages the integration of different 
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kinds of models. In GPS-X, state variables are the elements common to every model in a 

library. As these are the essential variables, they provide a convenient basis for 

combining different unit process models. All models in a library include expressions for 

each of the state variables. The values for these variables at entrance and exit points are 

particularly important because these are the points at which flows to and from other 

processes originate or terminate. To build a multi-unit-process model, it is necessary to 

track these values between unit processes. 

The key task of tracking state variables between unit processes is handled transparently 

by GPS-X.  GPS-X manages this in a rigorous way.  You can display the values of these 

and other composite variables at every point in your plant layout, but you can ignore the 

procedures for mapping the state variables among the models. This is another example of 

how GPS-X insulates you from unnecessary detail, increasing the power of the models 

you are able to build and allowing you to concentrate on understanding your model and 

your system rather than code implementation. 

Material Balance Expression 

One of the key tools of practitioners in engineering is the material balance. Construction 

of dynamic models is a straightforward application of this fundamental principle. When 

GPS-X builds a model of a layout, it does so by first establishing the material balance for 

each state variable in the unit process. As discussed above, this involves tracking the state 

variables in each unit process in the layout. This is the essential task of the GPS-X 

translator, which converts the graphical layout into code as described in the Overview of 

The Model Building Process section and shown in Figure 8-10. 

The material balance expression for a constant volume can be stated as: 

The net rate of change in a component within a control volume (an object in 

GPS-X) is equal to the rate at which the component enters the volume, minus the 

rate at which it leaves the volume plus or minus the rate at which the component 

is generated or used within the volume.  

This is shown graphically in Figure 8-5. For each object in GPS-X a material balance 

dictates the changes which occur in the key components, that is, the state variables.9 All 

other dynamic characteristics of the system depend on how these state variables change. 

There may be several hundred equations constructed by GPS-X if the layout is large. 

Both steady state and dynamic (time varying) situations can be analyzed using the same 

fundamental relation and the equations produced by GPS-X. 

 
9 The black box object (and some models in the toolbox object) in GPS-X does not use the material balance to 

establish input-output relationships; however, it is defined to properly map model state variables from input to 

output points. 
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Figure 8-5 – Material Balance Expression for Two Components (State Variables) and X  

  

Steady-State and Dynamic Simulation 

From the material presented in the previous sections, you should now have a general 

understanding of the nature of the models in GPS-X and the way they are constructed. In 

the last section, it was stated that the equations can be used for analysis of both steady-

state and dynamic or time-varying situations. The important differences between these 

types of analyses are examined this section. 

Steady-State Analysis 

Steady-state analysis assumes that none of the state variables change over time. 

To get a qualitative feel for the meaning of steady-state, assume a situation where 

a plant has been operating under the same external excitations for an extended 

period of time. The plant has been receiving the same influent, with the same 

composition and has been operated in the same mode for several months. The 

situation is shown in Figure 8-6. In this scenario, the influent flow and 

operational mode are potential sources of external excitations, but assume for the 

moment that they do not change over time. As none of these changes, after some 

time, the plant settles into a steady-state. Because no external excitation is 

disturbing the plant, variables measured in the plant, such as DO and MLSS, do 

not change during the period, that is, the variables are not dependent on time. 

Whenever you interpret the results of a steady-state analysis, remember that the 

results are valid only for a plant operating at steady-state as described here. 
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Figure 8-6 – A Treatment Plant Operating at Steady-State 

Finding state variable values at steady-state involves an iterative procedure for 

solving a system of simultaneous equations. Normally, this procedure converges 

(finds the solutions) but sometimes it does not. In the latter case, the state 

variable values contain a (possibly high) degree of error. Ensuring that these 

errors are kept to a minimum is an important consideration because, if a solution 

cannot be found there may be a problem with the structure of the model or the 

parameter values being used. Whenever you conduct a steady-state analysis, 

make sure that the solution procedure converges to a reasonable state. The 

steady-state solver included with GPS-X is a robust procedure that was 

specifically designed for the types of models used in wastewater treatment 

facilities. See the Steady State Simulation section in this chapter for more 

information. 

Conducting a steady-state analysis of a model is a convenient way to get a feeling 

for model variable relationships. Values calculated by the steady-state solution 

procedure depend on the values of all model inputs and parameters. For example, 

the steady-state value for effluent ammonia depends on the value for the wastage 

rate because this affects the growth of ammonia-removing bacteria. One quick 

way to see the relationship between wastage rate and effluent ammonia 

concentration is to conduct a steady-state sensitivity analysis. To do this, simply 

change the value of the wastage rate, run the GPS-X steady-state solver and 

observe the calculated value for effluent ammonia. Do this for several different 

wastage rates to see the effect over a range of wastage rates. This can be done 

manually or automatically if you have purchased the Analyzer option in GPS-X. 

Dynamic Analysis 

The assumption of steady-state is convenient, but most plants do not operate in 

steady-state. For most realistic situations, it is important to conduct dynamic 

sensitivity analyses to observe the time-dependence of variables. This situation is 

shown in Figure 8-7. In contrast to Figure 8-6, this plant is in a continuous state 

of change. The influent composition varies and operational changes, process 

upsets and equipment failures disturb the steady operation of the plant. 
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Figure 8-7 – A Treatment Plant Operating under Dynamic Conditions 

Dynamic analysis gives a more complete picture and can serve to validate or 

reinforce the results of steady-state analysis. Most plants do not have a constant, 

unchanging influent, and are subject to frequent disturbances (excitations) that 

result in wide fluctuation in the values of measured variables. For wastewater 

treatment facilities, dynamic operation is the norm and steady-state operation the 

exception. This does not mean that results from steady-state analysis are invalid 

because often a dynamic analysis shows that the model variable values lie within 

a range, which includes the steady-state value; however, it is always a good idea 

to supplement a steady-state analysis with a dynamic one in cases where you 

suspect that the plant is significantly influenced by dynamic disturbances. 

Integration Error and Instability 

The benefits of dynamic simulation are significant; however, the solution of the 

dynamic equations is more complex and, if done correctly, can introduce errors 

in the results. The two major considerations in the solution of dynamic model 

equations are numerical instability, and the error between calculated and actual 

values (referred to as convergence). GPS-X is designed to minimize these types 

of problems. For the great majority of simulations you perform, the default 

conditions imposed by GPS-X will ensure adequate accuracy of the solution to 

the model equations. GPS-X includes robust procedures for this purpose and 

makes it easy for you to apply them in conducting simulations. 

Dynamic analysis requires numerical integration of the model equations, that is, 

the estimation of derivatives by finite difference approximations for each of the 

model’s state variables. When using these procedures, there is always a small 

error, referred to as the integration error, between the calculated value and the 

real value, which would be obtained from an exact solution of the equations. You 

can control this error by setting integration method parameters or by selecting a 

different integration method. There are several methods available in GPS-X and 

you can easily change from one method to another. In most cases, it is possible to 

keep this error below a reasonable, arbitrarily selected limit. 
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The second consideration that sometimes arises in numerical simulation is 

instability. Under some circumstances it is possible for integration procedures to 

become unstable. The effects of this may be minor, such as small, rapid changes 

in the value of a variable, or they can be dramatic, resulting in the invalidation of 

a simulation run. These problems typically occur when using one of the less 

robust integration routines, especially if the integration step size is made too 

large. This may be done for convenience or to save time as the large step size 

requires fewer calculations and therefore, results in faster execution times. 

A simple way to determine if errors or instability are a problem is to run the same 

simulation with more than one of the available integration methods. If you find 

significant differences in the results of these runs, then one of the methods is 

producing incorrect results. Try making adjustments to the integration parameters 

and re-run the simulations until you get agreement between the results calculated 

by different integration procedures. Consult the GPS-X Technical Reference for 

more information on this topic. 

Initial Conditions 

Finding solutions to the dynamic equations, which comprise the models you 

prepare with GPS-X, is referred to as an initial value problem. In general, the 

behaviour of a dynamic model depends on: 

1. The model equations, 

2. The values of parameters and inputs to the model equations, 

3. Inputs to the model (forcing functions), and 

4. The initial values of the model state variables. 

Without assigning initial values to the variables, it is not possible to find a unique 

solution to the set of differential equations that comprise the model. In previous 

material we have described how GPS-X constructs the model equations and the 

ways for you to enter model parameter values. The remaining task is to select the 

initial conditions. As the behavior you observe is dependent on these values, it is 

useful to take time to consider how initial values can be determined and how the 

results you obtain should be interpreted. 

In all of the simulations you perform with GPS-X, it will be necessary to specify 

the initial conditions. There are two ways to do this: 

1. Enter the values directly, and 

2. Calculate the steady-state values at time=0 and use these as the initial 

values. 
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The procedures for setting the values directly have already been covered in the 

Process Data Menu sections. As initial values are a kind of model attribute, their 

values can be set from the object process data menu. The hierarchical menu 

obtained by selecting this item is shown in Figure 8-8. 

 

Figure 8-8 – Initial Conditions Menu Item 

Remember that the initial values determine the unique solution obtained for the 

set of defining (differential) equations. If these values are set directly, then you 

must take care in making a proper interpretation of the meaning of the simulation 

results obtained. A safe way to set the initial values, one with a simple 

interpretation, is to use the steady-state solver to calculate the steady-state values 

and then use these as the initial values. 

As shown in Figure 8-9 there are actually two cases to consider. In case 1, 

shown on the left-hand side of Figure 8-9, the process has been at a steady-state 

prior to the start of the simulation (t=0). After starting, the changes made to 

model inputs or parameters cause some dynamic behavior to occur. This is the 

case mentioned above, where the steady-state solver has been used first to 

calculate the steady-state. After doing so, the state variables are given these 

steady-state values at the starting time (t=0). The state variables at any time after 

the start are influenced by changes to model inputs or parameters resulting in the 

dynamic behavior you observe. 

In the second case shown on the right-hand side of Figure 8-9, the behavior of 

the state variables is dynamic before and after the point where time=0. Consider 

two additional scenarios of Case 2 that may be simulated; one in which there is 

no knowledge of the dynamics before time=0, and one in which there is 

knowledge of the dynamics before time=0.  
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Figure 8-9 – Two Possible Simulation Cases and their Relationship to Initial Values 

If there is no knowledge of the dynamic behavior before time=0 and the initial 

values are entered directly, perhaps from actual measurements or based on 

engineering judgment, then it is not always clear whether the behavior after 

time=0 accurately reflects the dynamics in the system being modeled. Relatively 

small errors in a single state variable initial condition can cause significant errors 

in the simulation results.  

It is also possible to specify a set of initial conditions that violate model validity 

constraints, for example, entering a negative value for concentration or an 

unreasonably large or small value for a state variable. Under these circumstances 

the integration of model equations may still be stable with a low integration error 

but the results are not valid. In general, you should exercise care in the selection 

of initial conditions for this case. 

Given good estimates of the initial conditions, the system of equations will 

eventually "settle in" to a repeatable pattern. This period can be estimated as it is 

dependent upon the time constants for the processes being modelled. In 

wastewater treatment processes, important time constants are the hydraulic 

detention times of the unit process and the sludge age or solids retention time 

(interpreted as the mean age of the solid matter) of a system of unit processes, for 

example, the activated sludge process. Generally, a value of 2 to 3 times the 

hydraulic or solids retention time should be used as a minimum period. 

If there is knowledge of the dynamics before time=0 then it is possible to 

determine exactly the derivatives and, therefore, the behavior of the system. This 

would be the case if you restored the initial conditions from a previous run or 

when there is a repeating pattern of model inputs or parameter changes, such as a 

repeating diurnal variation in influent flow rate and composition. For the latter 

case, you may at first only have estimates of the initial conditions but you can 

determine the exact initial conditions by re-running the simulation with the same 

inputs until you get identical results for consecutive runs. GPS-X includes this 

capability and will perform the necessary re-runs automatically. 



145 Optimization Tools 

GPS-X User’s Guide 

You have many options in setting-up and running simulations. In some cases, it 

is not necessary to run dynamic simulations because you can get the information 

needed by completing a steady-state analysis. In other cases, extensive dynamic 

analyses are necessary. For example, a simple treatment plant design might 

require only steady-state values, whereas an on-line application may necessitate 

closer attention to process dynamics.  Take some time to think about the results 

obtained to ensure that the simulation results are understood correctly. GPS-X 

helps you to get the simulations right - interpreting correctly is up to you. 

OVERVIEW OF THE MODEL BUILDING PROCESS 

The build procedure is shown in Figure 8-10. In GPS-X descriptive models are supplied in 

libraries. When you place objects on the drawing board and specify their Model types, GPS-X 

knows which models to retrieve from the library. When you specify the connections between 

objects, GPS-X then knows how to couple these models to generate a dynamic model of the 

entire layout. As default data are defined for all critical model parameters, it is possible to 

translate the layout into a high-level computer language and generate an executable program. 

In GPS-X, the model build process is transparent; once you have prepared the layout on the 

drawing board, creating an executable model is done when switching over to Simulation Mode. 

GPS-X achieves this using a specialized translator, which converts the graphic images you place 

on the drawing board into dynamic model equations. Once the executable code is generated, you 

can conduct simulations of the model. 

 

Figure 8-10 – The Model "Build" Process in GPS-X 

As shown in Figure 8-10, GPS-X simplifies the construction of models by automating many 

tasks with special routines. The first step involves the GPS-X translator, which is a special pre-

processor program that converts the layout you prepare to a high-level description of a dynamic 

model. The GPS-X translator writes the material balance equations for each unit process based on 
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the models and connectivity you specified. Many levels of detail, which concern the mechanics of 

constructing the code rather than process understanding, are hidden through the use of an 

extensive macro language. This allows you to concentrate your efforts on understanding the 

model itself rather than the modelling and simulation tools. 

The remaining steps in the build process do not require user interaction. The GPS-X translator 

writes a high-level description of the model in the Advanced Continuous Simulation Language 

(ACSLTM). ACSL is a third-party program that is used as the simulator module in GPS-X. ACSL 

handles the details of numerical simulation, including the ordering of equations, integration and 

many other details. In the next step, ACSL code is converted directly to a FORTRAN program, 

then to object code and finally to an executable module. The entire build process can take less 

than a minute to complete, even for moderate-sized models. When you run a model in GPS-X, 

you are running the executable module shown in Figure 8-10.  

BUILDING A MODEL 

When switching from Modelling Mode to Simulation Mode (see Modelling/Simulation Mode 

section in CHAPTER 1), if necessary, the numerical model will be built. 

If the model for this layout has previously been built, but the layout has been modified, you will 

be prompted to rebuild the layout or simulate with the older version of the model (in most cases, 

you will want to rebuild the model). 

 

Figure 8-11 – Rebuild Model Option 

When the model is being built, you will see the “Building Model” window, as shown in Figure 

8-12.  The status of the building process will be updated as it moves through the different steps 

and any errors that occur will be displayed in this window. 

Building the numerical model may take from 5 seconds up to a couple of minutes, depending on 

the speed of your computer and the complexity of your model. When the model building is 

complete, the “Building Model” window will automatically close, and the model will be ready for 

simulation. 
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Figure 8-12 – Building Model Dialog 

BUILDING OPTIONS 

NOTE: This section is for advanced users. Unless you are interested in the details of the model 

building process, you can skip forward to the section on Starting Simulations. 

The build process, while fully automated, can also be carried out manually from the Tools > 

Build menu while in Modelling Mode for those situations where you may want to test whether a 

model will build without an error but you are not ready to move on to running simulations yet. 

The process of building involves two major steps: 

1. Translating the drawing board layout to ASCL source code. 

2. Compiling and linking the source code to produce a FORTRAN executable program. 

All messages related to the build process will be displayed in the Building Model window 

(Figure 8-12).  This includes the GPS-X and ACSL translator messages, compiler messages and 

linker messages.  

If the build process is successful the window is automatically closed.  Otherwise, it will remain so 

that you can view what the problem is. Some of these errors can be solved by adjusting the 

Translation Options. 

Translation Options 

If you wish to control how the translation step is performed, you can specify building 

details in the Build tab of the View > Preference menu, as shown below. 
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Figure 8-13 – Preferences Dialog (Build Tab) 

The Code item has several options for the code generation step.  The Quick option 

creates code optimized for speed whereas the Big and Big+ options are used for large 

treatment process models. These options are described in greater detail below.  If you 

make changes to the code generation options, you must subsequently select the Tools > 

Build menu item to prepare the executable program. 

QUICK Option 

Many GPS-X models contain recycle streams between processes. To find an 

accurate solution to the model equations in these cases, the numerical solution 

routines must iterate at every time step to resolve the effects of changes occurring 

in upstream units or downstream units, which in turn, may affect upstream units 

via recycle streams. 

At any point receiving a recycle, the (numerically integrated) components of the 

recycle stream cannot be known accurately until effects are propagated through 

the plant to the source of the recycle. At some point, a balance is struck, but 

finding this balance requires an iterative solution. The Quick option ignores 

these effects and the computational overhead associated with them. Using the 

Quick option effectively reduces the execution times. 

The difference in model predictions made using the Quick option and the exact 

solution are usually not significant. This is because integration time steps are 

much smaller than the time constants of processes in a typical wastewater 

treatment plant and the changes, which occur between time steps, are small. For 

most purposes, the Quick option is the best choice. The Quick option is assumed 

if you select the Build menu option. 
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BIG Option 

When building a large plant model containing many unit processes (for example 

more than 10 settlers) it is possible to exceed the limits which the simulator 

module places on the number of discretely executed code sections.  

When this occurs, the translation to source code will fail and an error message 

(‘too many discretes, build BIG’) will be displayed in the Building Model 

window.  In most circumstances, GPS-X will auto-detect when a build fails with 

a “too many discretes error”, and automatically rebuilds the layout with the BIG 

option. 

When the BIG option is used, all controllers in the layout use the same discrete 

sampling interval, rather than individual sampling intervals specified in each 

object.  This controller sampling time is specified in the Layout > General 

Data > System > Inputs Parameters > Dynamic Solver Settings menu. 

BIG+ Option 

This option is similar to the BIG option. Instead of defining a single sampling 

interval for all controllers, scalar PID controllers (only) are disabled. 

STARTING SIMULATIONS 

GPS-X allows you to conduct simulations interactively rather than (or in addition to) batch model 

simulations. Interactive simulation is simple – you Start the model and then change the pre-

defined controls to observe the response of model variables set up in output displays. There are 

some useful set-up commands, which you may want to issue before beginning and you can 

interrupt the simulation at any time, query the simulator for specific variable values, modify the 

displays or controls and then continue with the simulation. GPS-X is designed to make this 

interaction easy in order to get the maximum amount of information from a simulation run. 

Steady State Simulation 

To start a steady-state simulation: 

 1. Make sure you are in Simulation Mode 

 2. Select Steady State on the Simulation Toolbar. 

 3. Enter a value of 0.0 for the Stop Time. 

 

4. Click on the Start button. 
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The simulator will then run the steady state solver and pause when it has reached 

convergence. The percentage convergence is shown dynamically on the progress bar on 

the Simulation Toolbar. 

If you have the Command Window displayed, the status of the steady state calculations 

is displayed dynamically.  This information consists of the following: the iteration 

number, the number of loops without improvement, the current value of the sum of 

derivatives and the lowest value of the sum of derivatives are shown. Messages indicating 

whether convergence was or was not achieved are also displayed in this window.  

In some cases, the steady state solver does not converge; however, simply re-running the 

solver may result in convergence. This is done automatically in GPS-X if the number of 

retries is set to a value greater than zero (0). 

To set the number of steady state solver retries: 

1. Switch to Modelling Mode 

2. Select the Layout > General Data > System > Input Parameters > Steady-State 

Solver Settings menu item. The steady-state solver parameters dialog is 

displayed as shown in Figure 8-14. 

3. Change the value of Number of Retries on Iteration. A value of 5 or less is 

best. 

4. ‘Accept’ to close the dialog. 

5. Switch to Simulation Mode. You will be prompted about rebuilding – select 

“Rebuild Model”. This will create a new model with 5 (or fewer if convergence 

is achieved) steady-state retries as default. 
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Figure 8-14 – Steady-State Solver Settings Dialog 

An alternative procedure would be to set the number of retries in a scenario rather than 

changing the layout. This method does not require re-compilation (see Using Scenarios 

section of this chapter for more details). 

GPS-X will re-initialize the steady-state solver and attempt to find a solution to the 

equations. The number of retries should be kept small as it is unlikely that the system will 

converge if the procedure has failed after 5 retries. Under these circumstances, it still may 

be possible to achieve convergence by modifying other solver parameters shown in 

Figure 8-14. As a last resort, it may be necessary to modify either the model structure or 

model parameters to achieve convergence.  

Refer to the Technical Reference for more information on the steady-state solver and 

strategies for modifying steady-state solver parameters. 

If the stop time is set to 0.0, the steady-state solver stops after calculating the steady-state 

values. If the stop time is set to a value greater than zero (0), the simulator sets the initial 

conditions equal to the steady-state values and starts a dynamic simulation. 

Dynamic Simulation 

When performing a dynamic simulation, the simulator will always stop when it gets to 

the indicated Stop Time value; therefore, before starting a simulation, make sure the 

current value of Stop Time is greater than zero (0). 

To start a dynamic simulation: 

 1. Make sure you are in Simulation Mode 

 2. Select Steady State on the Simulation Toolbar (optional). 

 3. Enter a value greater than zero for the Stop Time. 

 

4. Click on the Start button. 

As discussed in the Initial Conditions section in CHAPTER 4, the initial conditions can 

be set either by entering the values directly or by calculating the steady-state values and 

using these as the initial conditions.  

When steady-state is selected, the steady-state solver starts and the state variables, values 

calculated by the solver, are used as the initial conditions.  
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If steady-state is not selected, the simulator takes the pre-set initial conditions10 and 

immediately begins a dynamic simulation run.  

In the former case, there will be a delay before the results begin appearing on output 

displays as the steady-state solver runs.  

The simulator will continue until it reaches the stopping time. 

In the Initial Conditions section, problems associated with using estimates for the initial 

conditions were addressed. The best situation is one in which a repeating pattern of 

model inputs can be assumed. In these cases, it may be necessary to run the same 

simulation several times before the system reaches a dynamic, or periodic, steady-state. 

These additional simulations are performed automatically in GPS-X if the number of re-

runs is set to a value greater than zero (0). 

To set the number of dynamic simulation re-runs: 

1. Switch to Modelling Mode 

2. Select the Layout > General Data > System > Input Parameters > Simulation 

Run Settings menu item. The dialog window is displayed as shown in Figure 

8-15. 

3. Change the value of Number of Reruns. 

4. ‘Accept’ to close the dialog 

5. Switch to Simulation Mode.  You will be prompted about rebuilding. 

 

Figure 8-15 – Simulation Run Settings Dialog (Repeat Runs) 

In most cases, Steps 2-6 are made in a scenario rather than the layout (see Using 

Scenarios section of this chapter). The number of re-runs you select will depend on 

estimates of the time needed for the system to come to a periodic steady-state. This 

 
10 Initial conditions are process object attributes and can be accessed from the object’s process data menu 
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estimate can be based on important time constants in your system, for example, the 

detention times of unit processes or solids retention times in combinations of unit 

processes such as the activated sludge process. 

PAUSING/RESUMING THE SIMULATION 

 

Whenever the simulator is running, you can pause the simulation by pressing the Pause button 

on the Simulation Toolbar.  

Once the simulator paused, you can adjust the interactive input controls, issue commands, alter 

the integration attributes, etc. After making any changes, you can continue the simulation. 

 

To resume a simulation when the simulator has been paused, press the Resume button. The 

simulation will continue from the point at which it was previously interrupted. 

You can pause and resume as many times as you want during a simulation session.  

OUTPUT VARIABLE FORM 

Normally the variables of interest are displayed in graphs which are defined by the user (e.g. bar 

graphs, XY graphs, etc.); however, at times it is convenient to view the values of variables that 

were not included in these displays. 

One useful feature for quickly checking the values of certain variables is the ability to browse the 

output variable forms of the various unit processes in your layout. 

1. Make sure you are in Simulation Mode 

2. Right-click on the object of interest on the drawing board. The object’s process data 

pop-up menu will be displayed. 

3. Select the ‘Output Variables’ item and browse the submenu system to find the category 

of interest.  Select the item and the Output Variable Form will be displayed.  The current 

value of the variables are displayed on the form. 
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Figure 8-16 – Accessing Output Variable Forms 

SIMULATION CONTROL 

 
On the Simulation Toolbar there is a button to access various settings regarding the simulation 

and some different low-level commands that can be sent to the model. 

Integration Control 

This item allows you access to the window that contains relevant information for the internal 

numerical solver.  Note that these values can only be altered in a scenario (see Using 

Scenarios) or in Modelling Mode by accessing the same parameters through Layout > 

General Data > System > Input Parameters > Dynamic Solver Settings. 

Properties 

This item allows you access to the settings (ie. min/max/delta) for the Stop, 

Communication and Delay data entry fields. 

Commands (Advanced Users) 

When in Simulation Mode, and whenever the simulator is in the idle state, it is possible to 

query the simulator directly by issuing ACSL runtime commands. These commands can 

be used to exercise the model, that is, to run a simulation, look at the results, and change 

model constants. 

Most of the essential commands and coordination with the simulator are handled by the 

GPS-X interface; however, you have the ability to issue ACSL commands directly.  

A full description of the ACSL commands is given in the ACSL Reference Manual 

(contact Hydromantis for details). 

mailto:support@hydromantis.com


155 Optimization Tools 

GPS-X User’s Guide 

NOTE: Commands issued to the simulator are executed in the order given and data 

values that are set remain the same until they are changed by a subsequent command or 

the model is unloaded. These commands can conflict with GPS-X instructions to the 

simulator. For example, if you set the value of a model parameter in a GPS-X process 

data entry form and then later use the runtime command “set” to set the value of the 

same variable, the latter action will override the former and the value displayed in the 

GPS-X data entry form will be incorrect. 

Eight commonly used commands or procedures11 are pre-defined and provided in the 

Simulation Control > Commands drop down menu on the Simulation Toolbar, as 

shown in Figure 8-17. 

 

Figure 8-17 – Simulation Control (Commands Submenu) 

Five of these procedures are accessed from the Information sub-menu. They concern 

information messages that are sent to the Command Window.  

These procedures are: 

1. Noinfo – suppresses the display of GPS-X system and simulator module 

messages. 

2. Fullinfo – displays all messages. 

3. Warninfo – suppresses the simulator module messages, but displays GPS-X 

system messages. 

4. Optinfo – sets up the Command Window for display of optimization 

information in optimize mode (see CHAPTER 10). 

5. DPEinfo – sets up the Command Window for display of dynamic parameter 

estimation information (see CHAPTER 10). 

 
11 Procedures are a series of ACSL commands 
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Information on the messages that are displayed can be found in the Technical Reference. 

The remaining pre-defined commands in the Simulation Control > Commands menu are 

provided for saving and restoring or reinitializing the model state variables.  

1. Reinitialize procedure writes the current values of the state variables into their 

corresponding initial conditions. This is useful for establishing a starting point for 

a subsequent simulation run. This procedure stores these initial conditions in 

memory only. It does not overwrite the values that a user sees in the initialization 

forms, so if the model is unloaded and reloaded, the form values will be used as 

the initial conditions. The reinitialized values will be lost when the model is 

unloaded. 

2. Save States procedure saves all model data, including state variable initial 

conditions to a data file.  This file has a pre-determined name (ie. ACSLSV.gps) 

and is located in the same directory as the layout file, so only one set of model 

data can be saved at a time using this feature. 

3. Read Saved States procedure restores the file output created using the Save 

States command. This is another useful way to save the data at a point in the 

simulation so that you can later start a simulation at the same point 

Any messages or other output from the simulator module will be displayed in the 

Command Window. 

Command Window 

The Command Window is an auxiliary output area used to report details of the system 

and model status. These include messages that might be generated during run-time.  

In addition, the Command Window is the primary text-based output interface to the 

simulator module.  

You can issue commands to the simulator (as described in the section above) or any other 

valid ACSL command (see Technical Reference for more details), and see the responses 

in the Command Window.  

To display the Command Window: 

1. Switch to Simulation Mode (if not already there). 

2. Click on the Simulation Control button on the Simulation Toolbar, and select 

Command Window. The command window will be displayed as a tab in the 

Output section of the main window. 
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Figure 8-18 – Command Window Tab 

The ACSL commands can be typed in the field at the bottom of the window (see Figure 

8-18) and sent by either pressing ‘Enter’ or clicking the ‘Command’ button. 

USING SCENARIOS 

When organizing simulation runs it is useful to start with a base set of data, and then create one or 

more separate cases, which are modifications to the base data set. These cases are referred to as 

scenarios in GPS-X.  

You can create any number of scenarios and in each scenario, you can specify the changes to the 

model parameter(s) which define that scenario.  Those changes are saved so that they can be 

restored at any point in the future. 

 

Base Model 

(ie. base data set) 

Scenario 1 Scenario 2 Scenario 3 
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Figure 8-19 Scenarios Derived from a Base Data Set 

A couple of rules that apply to scenarios: 

• Scenarios can only be selected at the start of a simulation. This means that if you pause a 

simulation and then change the scenario, the simulation will no longer be able to be resumed.  

It will have to start from the beginning again. 

• Changes to model parameters which would require rebuilding the model, cannot be placed in 

a scenario. For example, it is not possible within a scenario to change the number of reactors 

in a plug-flow tank, the number of layers in a sedimentation tank or delete unit process 

objects. You can, however, set the volume of a tank to zero to make it appear that the tank is 

not present. 

The Scenario menu can be accessed through the Scenario item on the Simulation Toolbar. 

 

Figure 8-20 – Scenario Menu 

Creating a New Scenario 

To create a scenario: 

1. Make sure you are in Simulation Mode 

2. Click on the Scenario item on the Simulation Toolbar. 

3. Select New. A dialog window will be displayed that allows you to select either 

the default scenario or another existing scenario to derive the new scenario from.  

If you select the default scenario, then you are starting from the base case. If you 

select another scenario, then all of the variable changes in that scenario will be 

copied to the new scenario as a starting point for the new scenario. 
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4. Type in a scenario name. Any contiguous alphanumeric name can be used. 

5. Click the Accept button to create the scenario.  This will also make it the active 

scenario. 

Now you can go to the drawing board and access any of the object’s process data menus 

to make the desired changes to the parameters. The title bar of the data entry form 

contains the message – SIMULATION IS LOADED – to indicate that you are in a 

simulation mode, and that any changes made will be added to the scenario.  

 

Figure 8-21 – Scenario Data Entry Form (changes shown in green) 

Note that all parameter values that are changed as part of a scenario are shown in bold 

green text in data entry forms, for easy identification.  

Selecting the Active Scenario 

The currently active scenario can be selected by accessing the scenario menu on the 

Simulation Toolbar and choosing the desired scenario from the “Select Scenario” 

submenu. 

The active scenario is displayed on the status bar below the Simulation Toolbar. 



160 Optimization Tools 

GPS-X User’s Guide 

 

Figure 8-22 – Display of Active Scenario 

Scenario Configuration 

From this dialog window, you can control various aspects of the scenarios.  There are 

four main features: 

1. Add/remove/view data files.  See the Adding Input Files to a Layout section in 

CHAPTER 6 for more information. 

2. Comparing two or more scenarios to see the differences in tabular format. 

3. Deleting scenarios. 

4. Reordering the list of scenarios. 

Viewing Scenario Variables 

On the Simulation Toolbar, you can use the Scenario > Show dialog window to view 

the list of variables that have been changed (from the base scenario settings) in the 

currently active scenario. The base scenario variable settings appear in a grayed-out box 

well the modified values appear in green text and can be directly manipulated from this 

window.  

From this dialog, you can also select one or more of the variables and either: 

 
1. Delete them from the scenario, or 

 2. Transfer Values to layout (ie. base data set).  This means that the selected 

values from the scenario will be set as the base value and removed from this 

scenario.  This requires the layout to be automatically rebuilt. 
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Figure 8-23 – Example of Scenario Show Dialog 

AUTOMATING SIMULATIONS (AUTORUN) 

The Autorun feature automates a number of common button click events used for running 

simulations. This automation is done through a text file, <layoutname>.xec that can be 

created with a text editor and saved with the other layout files. The file contains a sequence of 

commands which are executed in the order in which they appear in the file.  

Following is a list of available commands: 

Table 8-2 - .xec Commands 

.xec file commands: 

log DISPLAY LOG WINDOW 

scenario <scenario name> SET SCENARIO NAME 

optimize <optimize 

type>!<objective function> 

SET OPTIMIZE TYPE/OBJECTIVE FUNCTION 

 

Optimize type is one of: time 

series, probability or dpe 

 

Objective function is one of: 

absolute difference, relative 

difference, sum of squares, relative 

sum of squares or maximum likelihood 

Analyzer <analyze type> SET ANALYZE MODE 
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Analyze type is one of: steady-

state, phase dynamic or time dynamic 

steady SET STEADY STATE ON 

iconize START GPS-X IN CLOSED STATE 

tstop <tstop> [d/h/m/s] SET STOP 

cint <cint> [d/h/m/s] SET COMMUNICATION INTERVAL 

delay <delay> [s] SET COMMUNICATION DELAY 

command <command> ENTER ACSL COMMAND 

start START SIMULATION 

report GENERATE REPORT AT END OF RUN 

exit STOPS ACSL RUN, QUITS GPS-X 

help DISPLAY INFO FILE 

The .xec file is executed by default if it exists and GPS-X is started with the –L <layout 

name> option. This feature can, however, be turned off by using the –x 0 option when 

starting GPS-X.  
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CHAPTER 9  

Analysis Tools 

INTRODUCTION 

The Analyze module is used to conduct sensitivity analyses on your layouts.  This module is an 

optional feature.  If you have not purchased this module, contact us for pricing information. 

The objective of a sensitivity analysis, in the context of simulation, is to determine the sensitivity 

of the simulation model's output variables (dependent variables) to changes in its parameters 

(independent variables). This provides insight into the model's behaviour and helps identify the 

parameters that have the greatest impact on the model. The results of a sensitivity analysis are 

very useful when setting up a parameter estimation run because they allow you to determine 

which parameters should be adjusted by the optimizer. 

You can perform sensitivity analyses using any operational, stoichiometric, kinetic, or physical 

model parameter as the independent variable. In addition, you can conduct both steady-state and 

dynamic sensitivity analyses. 

The material presented in CHAPTER 8 provides a basis for some of the discussions in this 

chapter. In particular, the material in the Steady-State and Dynamic Simulation sections will be 

needed to understand how to set up sensitivity analyses properly. 

WHAT IS STEADY-STATE ANALYSIS? 

Steady-State analysis is useful when it is unnecessary to introduce the extra complexity of 

dynamic changes. For example, graphs such as those in Figure 9-1, which show the steady-state 

responses of model outputs to selected values of an input, might be sufficient for design purposes.  

In operations, it is useful to know the ultimate or steady-state response of the plant, such as the 

effects of moving to a different operating point. A preliminary steady-state analysis may be 

sufficient to make useful predictions about the behaviour of the plant. It is important to keep in 

mind the proper interpretation of a steady-state analysis as described in the Steady-State 

Analysis section of CHAPTER 8. You can always enhance the analysis later by including a study 

of model dynamics. 
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Figure 9-1 – Example of Steady-State Sensitivity Analysis Graph 

WHAT IS DYNAMIC ANALYSIS? 

When doing a dynamic sensitivity analysis there are two important cases to consider. In the first 

case the initial conditions are such that the process is initially at steady state. In the second case 

the initial conditions are dynamic. In CHAPTER 8, these two cases were examined with regard to 

the interpretation of the dynamic behavior that results. In general, you should assign initial 

conditions carefully. The same cautions apply when performing dynamic sensitivity analyses 

because here too you must specify appropriate initial conditions before running simulations with 

different values of the independent variable. 

Examples of the two types of dynamic sensitivity analysis that you can perform are shown in 

Figure 9-2.   

In both cases, a dynamic simulation is run from time=0 until the Stop Time.   

Panel A of Figure 9-2 shows the change in dissolved oxygen (DO) concentration of the mixed 

liquor over time for several values of the wastage flow rate. Notice that the simulations all start at 

the same value, the preset initial value.  

Now compare this to a similar sensitivity analysis setup shown in panel B. In panel B the 

simulations start at different values of DO since, in this type of analysis, the user has specified 

that the steady-state solver should be run before conducting the dynamic simulation. 
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Figure 9-2 – Dynamic Sensitivity Analysis (Steady-State Off vs On) 

There are important differences in the interpretation to be given to these two cases. In the set-up 

resulting in the graph in Panel A of Figure 9-2, the results demonstrate how the model responds 

to different values of the wastage rate starting from specific values of the model state variables, 

including the DO. In this case, it may be necessary to either extend the simulation or to perform a 

number of re-runs to observe the ultimate, periodic steady-state for the system. This type of 

analysis would be useful to answer questions such as the following: 

• What is the dynamic response of the mixed liquor suspended solids concentration if the 

wastage rate is suddenly changed? 

•  How would the current DO concentration change over time if the air flow rate was 

suddenly turned up (or down)? 

• What happens to the solids distribution over time if we quickly change to step feed 

operation in the plant? 

In each case, there is an implied common starting point (current MLSS concentration, DO 

concentration or solids distribution) and a specified change in a model independent variable 

(wastage rate, air flow rate or step feed). The immediate, short-term response of the model is of 

greatest interest. 

In Panel B of Figure 9-2, the situation is considerably different. In this case the simulation starts 

at a different DO value for each run. Here the steady-state solver is used to determine steady-state 

values for each value of the independent variable, set the initial conditions equal to these values 

and then started a dynamic simulation. The model is assumed to have been operating in a steady-

state. At time=0 the value of the independent variable changes to that specified in the sensitivity 

analysis and a dynamic simulation is conducted until the specified stop time. This type of analysis 

is useful for answering questions such as the following: 

Panel A Panel B 
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• What variation in mixed liquor suspended solids can be expected over time for plant 

operation at different wastage rates? 

• In the long run, how will the DO concentration vary over time for different values of the 

air flow rate? 

• What is the solids inventory like if I use step feed all the time? 

The common characteristic of these questions is the implied interest in long-term changes rather 

than the short-term effects of a sudden change. The initial value is not of concern; instead it is 

preferred to avoid the situation where the model is making a transition from one periodic 

steady-state to another and to examine the relative differences between these periodic 

steady-states. 

Time Dynamic and Phase Dynamic Analyses 

The results of a dynamic sensitivity analysis can be displayed in one of two ways. Figure 

9-2 shows one way, that is, selected dependent variables plotted versus time. This is 

referred to as a time dynamic sensitivity analysis. 

In some cases, it is desirable to view only the end-point of the dynamic simulation for 

each value of the independent variable. For example, you might want to ask: 

• What is the value of the mixed liquor suspended solids one and a half (1 ½) days 

after a sudden change in the influent flow? 

• What will be the value of the DO concentration at the end of each week when the 

plant is subject to a different, repeating diurnal flow pattern? 

The questions suggest that the simulation result of interest is the value of the dependent 

variable at a specific point in time. This is referred to as a phase dynamic sensitivity 

analysis. Finding answers to these questions requires the ability to plot the values of 

dependent variables at the end of a simulation against the value of the independent 

variable. This type of plot, referred to as a phase diagram, is shown in Figure 9-3. 

There is one additional step to perform before initiating the analysis. A decision needs to 

be made whether the initial conditions are steady state or dynamic. 

By selecting Steady-State (by checking it on the Simulation Toolbar) you direct GPS-X 

to calculate the steady-state values and use these as the initial conditions. If Steady-State 

is not selected, the manually entered initial conditions are used. These two types of 

analysis are referred to, respectively, as long and short-term analysis. 

This difference is demonstrated in Figure 9-3 which shows the same phase dynamic 

sensitivity analysis without steady-state initialization (Panel A) and with the initial 

conditions set using the steady-state solver (Panel B).  
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Figure 9-3 - Phase Dynamic Sensitivity Analysis Graphs.  

(Panel A) Starting from Non-Steady State. 

(Panel B) Starting from Steady State 

STEPS IN SENSITIVITY ANALYSIS 

NOTE:  Sensitivity analyses are set up after the model has been built. The procedures in the 

remaining sections of this chapter assume that the outputs you want to display have already been 

set up and that the model which is the subject of the sensitivity analyses has been built. 

After creating your layout, there are a few steps to set up a sensitivity analysis (steady-state or 

dynamic) as described below: 

1. Switch to Simulation Mode. 

2. Specify the model parameter to serve as the independent variable (see Creating A 

Control From An Independent Variable in CHAPTER 6). 

3. Enter the minimum, maximum and increment value for the independent variable and set 

it as the appropriate analyze controller type (see Input Controls Properties in 

CHAPTER 6). 

 

Figure 9-4 – Set Input Control to Analyze Type 

Panel A Panel B 
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4. Select the desired type of analysis (steady-state, phase dynamic, time dynamic, monte 

carlo) from the drop-down list accessed through the Analyze button on the Main Toolbar 

or the Analyze menu item in the Tools Menu. 

 

Figure 9-5 – Accessing Analyze Features 

5. Turn on Analyze Mode by clicking the Analyze button on the Main Toolbar (to toggle 

the mode) or accessing the Analyze menu item and selecting Analyze Mode.  The status 

bar at the bottom of the main window will indicate that you are in Analyze Mode. 

 

Figure 9-6 – Status Bar showing Analyze Mode 

6. Select the desired Stop Time (if applicable) and start the simulation. 

Important Tips 

1. There can be only one independent variable so don't specify more than one variable as an 

analyze type control. You can set up controls of other types and they will be displayed 

when you open the controls window.  To avoid the effects of confounding variables, the 

other controls should not be changed when a sensitivity analysis is being performed. 

2. Once the independent variable has been specified, the control is set to a non-interactive 

gauge; however, the program does not change to the analyze mode until the mode is 

changed manually to analyze. 

3. As the independent variable is incremented, the analyze controller displays its current 

value in a non-interactive gauge as shown in Figure 9-7. You can estimate the extent of 

completion by observing this gauge. 
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Figure 9-7 – Analyze Controller 

4. The outputs that are displayed when doing a dynamic analysis will depend on whether 

Time Dynamic or Phase Dynamic was selected from the Analyze menu. For Time 

Dynamic analyses, time is plotted on the X-axis, whereas for Phase Dynamic analyses, 

the specified independent variable is plotted on the X-axis. 

WHAT IS MONTE CARLO ANALYSIS? 

Monte Carlo analysis may be conducted as either a steady-state or dynamic analysis. The process 

for setting up a steady state or dynamic Monte Carlo analysis is similar to the set-up of the 

dynamic and steady state analyses outlined earlier in the chapter but there are a few differences 

which will be covered below. 

Monte Carlo analysis functions in a similar way to the step analysis method discussed earlier in 

this chapter; however, unlike step analysis, where the parameter is incremented by some delta 

value over the range, Monte Carlo analysis samples the parameter’s range following a probability 

distribution. The results of a Monte Carlo analysis are the probabilities of particular outcomes 

occurring, given the parameter range and probability distribution.  

Setting up Output Displays 

Output from the Monte Carlo analysis can only be displayed using the Probabilistic 

(Monte Carlo) graph type. 

 

Figure 9-8 – Output Properties showing Probabilistic Option 
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Setting up the Input Controller and Distribution Properties 

1. Specify the model parameter to serve as the independent variable (see Creating A 

Control From An Independent Variable in CHAPTER 6). 

2. Enter the minimum and maximum value for the independent variable and set it as the 

Analyze – Monte Carlo controller type (see Input Controls Properties in CHAPTER 

6). 

 

Figure 9-9 – Set Input Control to Monte Carlo Type 

When Analyze – Monte Carlo is selected from the drop-down menu, a button will 

appear beside the Type column. Clicking on this button opens the Distribution Properties 

dialog for the Monte Carlo analysis. 

 

Figure 9-10 – Accessing Distribution Properties 

The probability distribution may be defined as uniform, normal, or log normal. The 

particular normal or log normal distribution required is specified using its mean and 

standard deviation. 

3. Select the Monte Carlo analysis from the drop-down list accessed through the Analyze 

button on the Main Toolbar (see Figure 9-5) or the Analyze menu item in the Tools 

Menu. 

The status bar at the bottom of the main window will indicate that you are in Analyze 

Mode. 

4. Select the desired Stop Time (if applicable) and start the simulation. 
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During each run, by default GPS-X selects a new set of random variables from the designated 

distributions.  If a repeatable set of random variables is required, change the “Monte Carlo 

seed” value in the View > Preferences > Input/Output menu to a positive value.  Setting the 

seed value to -1 will force GPS-X to select a new set every run. 
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CHAPTER 10  

Optimization Tools 

INTRODUCTION 

The Optimize module is used to optimize the values of parameters from your layout.  This 

module is an optional feature.  If you have not purchased this module, contact us for pricing 

information. 

The Analysis Tools chapter explained how to use the analyze module to study the behaviour of 

your models and to identify the important parameters. Once you have identified the important 

parameters, you can use the optimizer module to optimize the values of these parameters. 

Optimization involves adjusting certain model parameters to achieve a desired objective function. 

The optimizer can be used to fit a model to measured data or to optimize process performance. 

The procedure of fitting a model to measured data is called “parameter estimation” and involves 

adjusting selected model parameters to achieve the best possible fit between the model responses 

and the measured data. Parameter estimation is an important step in preparation of a simulation 

model because process parameters can vary significantly from plant to plant. A model that has 

been fitted to actual plant data will be more useful for predicting actual plant behaviour. 

Process optimization involves adjusting certain model parameters to maximize or minimize the 

value of a model variable or a user-defined variable. For example, you may wish to adjust certain 

model parameters to minimize a plant's operating cost. 

The optimizer module was developed specifically to solve parameter estimation and process 

optimization problems involving dynamic wastewater treatment models. It can be used for both 

steady-state and dynamic optimization. As will be seen in this chapter, the optimizer is a valuable 

tool for preparing effective models of wastewater treatment facilities. 
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USES OF OPTIMIZATION 

There are several areas where optimization can be beneficial. In wastewater treatment, the main 

areas of application are in model calibration (i.e. parameter estimation), process design, and 

process optimization. 

Parameter estimation is important because once a model has been built it often becomes 

necessary to fit the model to real data. In fitting simulation results to real data, it is usually found 

that many stoichiometric parameters can be assumed constant but that physical, operational, and 

kinetic properties vary significantly from plant to plant. You can use the GPS-X parameter 

default values as a starting point, but when it is necessary to use the model for purposes of 

predictive simulation then calibration should be performed. This can be a simple manual or 

qualitative simulation in which you conduct interactive simulations or a rigorous mathematical 

one using formal optimization techniques. 

Simulator optimization can be used for process design and plant optimization. Consider the 

problem of finding a plant design that meets certain effluent requirements. Another example is 

finding the best operating mode to reduce the loss of suspended solids during a plant upset. In 

both cases, there is a desired output, namely the design that meets the effluent limits and the best 

operating mode. If you have a model of the system, these objectives are achieved by varying plant 

design or operational parameters and observing the response of the model outputs. 

In GPS-X, you choose the target parameters and the optimized variables of interest, and select an 

objective function to achieve a desired optimization. There is no limit on the number of response 

variables. The optimizer adjusts the selected parameters until the objective function is minimized.  

ALGORITHM USED 

GPS-X uses the Nelder-Mead simplex method (Press et al., 1986) in the optimizer module. The 

simplex method is a robust multi-dimensional algorithm that does not rely on gradient 

information. The algorithm searches through a multidimensional "surface" or space (defined by 

the objective function) in an organized way to find a path to a minimum value for the objective 

function. The procedure is sensitive to the choice of the optimization parameters. For more 

information on the simplex algorithm refer to the Optimizer chapter in the Technical Reference. 

TYPES OF OPTIMIZATION 

The optimizer module is equipped to handle three different types of process measurements:  

1. Time series measurements,  

2. Long term operational data that are averages of the original process measurements, and  

3. On-line measurements.  

Each type of measurement set leads to a different type of optimization problem. The optimization 

problem types available in GPS-X are Time Series and DPE. 
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Time Series 

This optimization type is the one normally used for both parameter estimation and 

process optimization. It is designed to handle both time series and steady-state 

measurements. 

For parameter estimation involving a dynamic model, the data entered into the text file 

will be the values for each of the response variables that you would like to fit at a series 

of time values. The response variables are referred to as target variables. In GPS-X, the 

target variable can also be maximized or minimized. 

Steady-State optimization is a time series-type optimization with only one data point for 

each target variable. The steady-state solver is used and the simulation has a stop time of 

0.0. This type of optimization is useful for calibrating the model to data reported as daily, 

weekly or monthly averages. Data of this type are typically obtained from composite 

samples and do not accurately reflect the time dynamics of the real process. In a steady-

state optimization, the average data are used as the targets and selected model parameters 

are adjusted to fit these targets. 

GPS-X will fit your model to the measured data using the objective function that you 

select. On the output graphs used to display the predicted values of the model, the 

measured values provided in the data file will be displayed on the graphs with red 

diamond markers. 

GPS-X will draw a new curve for the predicted values at each optimization iteration, so 

that you can track the progress of the optimizer. At the end of the optimization run, final 

predicted responses are displayed so that you can visually assess the fit. An example of 

this type of graph is shown in Figure 10-1.  

You can use any of the available objective function types when doing a time series 

optimization. These are listed below: 

1. Absolute Difference 

2. Relative Difference 

3. Sum of Squares 

4. Relative Sum of Squares 

5. Maximum Likelihood 

When doing parameter estimation, the maximum likelihood or sum of squares objective 

functions should be used. For process design or optimization, the absolute difference 

objective function is the most suitable. For more detail on the different objective 

functions see Objective Function Options in the Optimizer chapter of the Technical 

Reference.  The optimization results you obtain can depend strongly on the chosen 

objective function. 
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Dynamic Parameter Estimation (DPE) 

GPS-X has a sophisticated dynamic parameter estimation feature (DPE) designed for the 

estimation of time-varying parameters. It can be used with on-line data or off-line time 

series data. For details on using on-line data, contact Hydromantis. 

The motivation behind DPE is that parameters in process models are often not constant, 

but vary with time. For example, the oxygen mass transfer coefficient in an aerated tank 

is often slowly time-varying. 

Dynamic parameter estimation is useful for estimating parameters in poorly understood 

processes. In these cases the model structure is likely to be incorrect. As a result, the 

model may only be able to represent the data well over short time intervals. In this case, 

using DPE will help compensate for the model error and allow acceptable fitting of the 

measured data. 

Another situation in which dynamic parameter estimation is useful is when you are 

interested in detecting process changes and upsets. If for example a model parameter is 

found to be relatively constant during normal process operation but is sensitive to process 

changes, you can track this parameter using the DPE feature and on-line data to help 

provide an early warning of process changes or upsets. 

In GPS-X dynamic parameter estimation is done by applying the time series optimization 

approach mentioned earlier to a moving time window. Instead of estimating parameters 

from an entire set of data, GPS-X calculates a set of parameter estimates for each time 

window using the parameter estimates from the previous time window as a starting guess. 

This approach can be used on a data file that is continually updated with new blocks of 

data (online data) or on a static file of time series data.  You can use any of the objective 

functions that are available for time series optimization when doing dynamic parameter 

estimation.  

The length of the time window controls how often the parameters are updated. The 

shorter the time window, the more often the parameters are updated. When using short 

time windows it may be necessary to filter the data to eliminate noise so GPS-X does not 

fit the noise. 

To ensure proper termination of the optimization routine when using the DPE feature, it 

is suggested that the time window and the communication interval be chosen such that 

the time window is an integer multiple of the communication interval. 

DYNAMIC SIMULATION INITIAL CONDITIONS 

When performing an optimization involving a dynamic simulation you can set the initial 

conditions using the steady-state solver or provide your own initial estimates of the initial 
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conditions. This choice is dictated by the target data and knowledge about the dynamics of the 

system and its behavior at the start of the simulation. 

If the dynamic target data include initial steady-state estimates, perhaps from time-averages, you 

can use the steady-state solver to establish the initial conditions for the simulation. If you know 

that the system is not at steady-state at the start of the simulation, you can use the initial data 

points in the real data set as the initial conditions. Figure 10-1 shows an optimization of a batch 

process in which the initial condition represents the initial concentration of soluble substrate in a 

tank. The target data are shown as discrete points and simulation results for six values of the 

independent variable are shown as continuous curves. Steady-State initial conditions are not 

appropriate for this case. Since soluble substrate (a state variable) is utilized in the batch reactor, 

the steady-state solver would find a solution at zero substrate concentration. If the simulation 

started at zero initial substrate, the optimizer would not be able to fit the simulation to the target 

data. 

 

Figure 10-1 – Example of Dynamic Simulation using Initial Conditions 

SELECTION OF THE OPTIMIZATION VARIABLES 

Before using the optimizer to adjust parameter values it is usually best to experiment with manual 

adjustment of the parameters. It is a good idea to familiarize yourself with the models you prepare 

to understand the important relationships. By conducting interactive simulations you can observe 

the effects of the many model parameters on the response variables of interest. With this 
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information, you will be able to make better judgments on appropriate independent and target 

variables to use in an optimization. 

One common optimization problem is selection of improper optimization parameters. In setting 

up a manual or automatic optimization, be sure to select those parameters that have a significant 

effect on the specified target variables. For example, effluent ammonia concentrations are highly 

dependent on, and responsive to, the value of the nitrifier growth rate or reactor aeration 

parameters, but not so dependent on the value of the carbon-removing organism growth rate. 

Similarly, recycle sludge concentration is not influenced greatly by the settler model flocculation 

parameter whereas effluent suspended solids from the settler is influenced by this parameter. As 

demonstrated by these examples, selection of appropriate optimization variables requires an 

understanding of the structure of the model. 

Including too many parameters in an optimization will result in a difficult optimization problem 

with a high degree of correlation between the parameters. As a result, the parameter values at the 

solution will have a high degree of uncertainty associated with them. 

When you are satisfied that you know the important relationships and have identified appropriate 

target (response) variables and optimization variables, it is best to perform some manual 

optimizations. Set up several interactive simulations with slider controls on the optimization 

variables and try adjusting these as the simulation proceeds. You can plot actual data along with 

the target variables (see the Variable Properties section in CHAPTER 7) so that you can 

compare simulation and actual data. This type of qualitative optimization is helpful in a number 

of ways. For example, it helps to identify initial guesses and establish practical bounds on the 

optimization variables. 

STEPS IN AN OPTIMIZATION 

 Optimization setup must be performed in Modelling Mode. 

To run the optimization, you must first fully setup the target variables, optimized parameters, and 

objective function using the Optimizer Setup Wizard. Once the wizard is completed, the model 

will automatically re-build to display necessary input and output parameters. The re-build is 

necessary to embed optimization instructions in the simulation model. 

NOTE:  When doing probability optimization using input data, the data must consist of 

daily averages. These daily averages will be compared with the simulated daily 

averages calculated for the target variables. GPS-X automatically creates the 

daily average variable for you, based on your selected target variable. For 

example, if you have selected effluent TSS as a target variable, when you rebuild 

your layout, GPS-X will automatically generate a daily average effluent TSS 

variable which will be used as the target variable for the optimizer. 
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Optimizer Setup Wizard 

 
The first step in setting up an optimization is to run the Optimizer Setup Wizard in 

Modelling Mode.  Press the Optimize button on the Main Toolbar 

1. The first stage is selecting the desired target variables.  Navigate through the 

variable tree to find and select the desired variable. 

The target variables are the variables that you would like to minimize, maximize, or 

fit to the measured data. The target variables are often the same variables as those 

you would plot in a normal-mode simulation. 

For time series and DPE optimizations you can select other target variables in this 

way but keep in mind that data requirements and calculation times required for multi-

target optimizations can become prohibitive.  

 

Figure 10-2 – Optimizer Setup Wizard (Specify Target Variables) 

Click “Next” to move on to the next stage. 

2. Select the desired optimized variables by ticking the appropriate boxes. The 

optimization variables will be adjusted by the optimizer as it attempts to minimize the 

objective function. 
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Figure 10-3 – Optimizer Setup Wizard (Specify Optimize Variables) 

Click “Next” to move on to the next stage. 

3. Specify the desired target comparison, objective function and optimization type. 

The target variables can be minimized, maximized, or fit to an input data. The input 

data can be imported into GPS-X by selecting Fit to Data under Target Comparison 

and clicking on the Add Data File button. 

 

Figure 10-4 – Optimizer Setup Wizard (Specify Optimizer Settings) 

 

4. Press ‘Finish’. Once you press finish, the model will automatically switch to 

simulation mode and re-build. Notice that the layout is now in Mode Optimizer- 

Time Series. A new input tab labeled Optimization Parameters and a new output 

graph tab labeled Optimization Results will be automatically generated. The 

Optimization Parameters input tab contains the optimized variables and the 
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Optimization Results output tab contains the graphs of target variables the user 

specified. 

If you load a layout where the Optimizer Setup Wizard has already been run, the 

simulation will be in ‘normal’ mode.  To turn on the optimizer, press the Optimize button 

on the Main Toolbar.   

The optimization type and objective function can also be changed in Simulation Mode 

instead of re-running the wizard.  For details on how to do that, see the description of the  

Optimize menu in CHAPTER 1. 

Running the Optimizer 

To conduct an optimization, you must be in Simulation Mode, and you must turn on the 

optimizer (if it isn’t automatically turned on after going through the Optimizer Setup 

Wizard described above).  

To run an optimization, complete the following steps: 

 1. Be sure you are in Simulation Mode. 

 
2. Click on the Optimize button to switch to Optimize Mode. Alternatively, 

you can right-click on the inverted triangle beside the optimize icon, and 

then select Optimize Mode. If you have not selected the Type and the 

Objective Function, do this now. A message indicating you are in 

Optimize Mode will be displayed in the status bar.  

 3. Set the Stop Time and the Communication Interval to the desired values. 

 

4. Click on the Start button on the Simulation Toolbar.  

As the optimization proceeds, on the output graph several different simulation curves will be 

overlaid and these curves should begin to converge to the real target data.  

The number of curves shown on the graph can be set by going to View > Preferences and on the 

“Input/Output” tab setting the Number of runs displayed (analyze/optimize) parameter.  
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Figure 10-5 – Preferences (Number of runs displayed) 

You can watch the input controllers to get a feel for the way the optimizer makes changes to the 

parameters as it attempts to match the simulation results to the target data. 

 

Figure 10-6 – Optimization Parameters as Input Controllers 

Additional optimization results are displayed in the Command Window. These include the 

iteration report, the final solution, and a number of statistics that allow you to assess how well the 

model fits the data (see the Command Window section in CHAPTER 8 for information on how 

to view and use this feature). See Appendix B: The Optimizer Solution Report in the Optimizer 

chapter of the Technical Reference for a description of the information that is printed to the 

Command Window. 

The optimization routine can take anywhere from a few seconds to a few hours to complete 

depending on the number of independent variables, model complexity, termination criteria, etc. It 

is best to start with a single parameter optimization and a small amount of data until you are 
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accustomed to the speed and resource requirements for your model and machine and the 

appropriate optimization parameters to use. 

ADVANCED OPTIMIZER SETTINGS 

In most cases, the default optimizer settings will be sufficient but more advanced users by need to 

change some of the values.  These settings can be located in the Layout > General Data menus 

and details about those settings can be found in the Optimizer chapter of the Technical 

Reference. 

TROUBLESHOOTING 

Here are some guidelines for correcting common problems that occur: 

• Make sure that you have changed to the appropriate optimize mode. You can verify by 

checking the main window status bar (lower right corner). 

 

Figure 10-7 – Status Bar showing Optimize Mode 

• Check to make sure the target data file has been set-up correctly. If the data file has been 

read by GPS-X, then the file name will be displayed in the Command Window. File input 

methods (via text files or Excel spreadsheets) are described in the Using File Input 

Controllers section of CHAPTER 6 . 

• Use the variables that have a strong effect on the target or dependent variables. If the 

optimization fails to minimize the objective function (there is a poor fit between target 

data and simulation results), it may be due to improper selection of the optimization 

variables. 

• The simplex method settings can have a strong effect on the optimization. Read the 

Optimizer Description in the Optimizer chapter of the Technical Reference for a 

description of these settings. 

• Check that the optimizer converges to a reasonable solution. There may be many local 

minima, and possible more than one global minimum. It may be necessary to conduct 

several runs from different starting guesses to find the lowest minimum.
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CHAPTER 11  

Customizing GPS-X 

INTRODUCTION 

The models in GPS-X are varied and the most comprehensive available in a wastewater treatment 

process simulator. In developing a model of your plant, you may require special modifications or 

additions to GPS-X. For example, you may want to add your own calculated variables or enter 

new equations. GPS-X is designed to be flexible and provides several ways to handle these 

special situations. In most cases you will find that the existing models provide a good foundation 

for customization and that with minor changes you can easily tailor the model to suit your needs. 

When making major changes to the process models or developing new models, it is 

recommended that you use the Model Developer tool that is available with GPS-X (contact 

Hydromantis for details). 

This chapter covers the methods used to make modifications to the forms used in GPS-X and to 

add new variables and equations. The material includes an explanation of the general structure of 

the GPS-X software system and then outlines the various ways in which you can customize the 

software to suit your needs.   

In general, this chapter assumes a more advanced level of understanding, both of the GPS-X 

system itself and other aspects of dynamic modelling and simulation. The material presented in 

this chapter is supported by examples rather than lists of specific procedures as in earlier chapters. 

The examples will help to reinforce the material and give you a more solid foundation for making 

your own modifications. 

To complete the examples, it is helpful if you have an understanding of the following: 

• Advanced Continuous Simulation Language (ACSL™) 

• FORTRAN programming language 

• Dynamic modelling of the unit processes in a wastewater treatment facility 
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ACSL is the simulation sub-system used by GPS-X. Some model modifications require an 

understanding of the ways in which ACSL is used to implement the model. A complete 

examination of the features and capabilities of ACSL is provided in the ACSL Reference Manual 

(Contact Hydromantis for details). 

Because the general programming language used by GPS-X and ACSL is FORTRAN, knowledge 

of the programming constructs in this computer language and tools for debugging FORTRAN 

programs may be required. Finally, since you may be making additions to the unit process 

models, knowledge of the fundamentals of dynamic modelling and simulation of wastewater 

treatment processes is important. 

If you are unfamiliar with one or more of these areas, you may still be able to make the necessary 

modifications by following closely the examples in this chapter.  

TYPES OF CUSTOMIZATION 

There are two approaches to customization in GPS-X. The first approach involves making 

modifications to a specific GPS-X layout. In this case, the changes only apply to the layout itself 

and do not affect newly created layouts. The second approach is to create a custom library 

containing the changes. In this case, all layouts created using this library will make use of the 

modifications. 

The first approach is useful if you want to add new variables or equations to a specific layout and 

you do not need to re-use the modifications in other layouts. For example, you may wish to create 

a new composite variable that is a variation on one of the existing composite variables. Methods 

for making the changes associated with the first approach are presented in the Customizing 

Layouts section of this chapter. If you inadvertently delete of corrupt these files, GPS-X can 

always be re-installed. If you inadvertently delete or corrupt these files, GPS-X can always be 

re-installed.  

Customizing Layouts 

The second approach is useful if you would like to change the variable names used in the GPS-X 

forms or change the default values used in the forms and then re-use these modifications in a 

number of layouts. The second approach involves modifications to model libraries, and is a 

procedure that requires some understanding of the structure of the GPS-X software system. 

Procedures for making these kinds of changes are discussed in Customizing Libraries section in 

this chapter.  
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GPS-X SOFTWARE SYSTEM 

File System 

The GPS-X software consists of three types of files that are stored in appropriate 

directories on your machine: 

1. Program executable files 

2. Model library and auxiliary files 

3. Layout files 

Program Executable Files 

The program executable files are binary files that cannot be altered. They include 

the GPS-X executable, the ACSL executable and other secondary binary files 

used by GPS-X while it is running. The GPS-X executable files are stored in the 

\bin sub-directory in the GPS-X installation directory. The ACSL executable 

files are stored in the \acsl11 sub-directory in the GPS-X installation 

directory. 

The layouts that you create are executable files; however, they are stored in the 

directories in which you create them. 

Model Library and Auxiliary Files 

The GPS-X model libraries are stored in sub-directories in the GPS-X installation 

directory (eg. the cnlib directory). Each of these libraries contains a binary file, 

gpsxm.bin that contains the lower level ACSL macros that are used to 

construct the process object models. This file also contains extensions to the 

ACSL operator set developed specifically for GPS-X. This file cannot be 

modified. 

The GPS-X libraries contain templates for the layout files (discussed in the next 

section), and model auxiliary files that are specific to the unit process models 

built into the GPS-X software. The auxiliary files have the following general 

form: 

• modelnme.cfg (model file) 

• modelcfg.con 

• modelcfg.ini 

• modelcfg.dis 

Where: cfg = asp, pft, pfm, pmp
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Here, modelname (eight alphanumeric characters maximum), and model are 

identifiers for each model type. The suffixes asp, pft etc., refer to the object 

type. The name for the .con, .ini, and .dis files are constructed by 

taking the first five characters of modelname and appending the 3-letter object 

type specification. (asp, pft, etc.). A complete list of these names is given in 

the Technical Reference. 

The files listed above are library-dependent, so the format of the files depends on 

which GPS-X model library you are using (i.e. CN, CNP, Mantislib, etc.) 

The modelname.cfg files contain the defining ACSL macros for the process 

models in GPS-X. These macros call the lower level macros found in 

gpsxm.bin. 

The modelcfg.con, modelcfg.ini and modelcfg.dis files are used 

to define the set-up of the forms accessed through each process object’s process 

data menu. The .con files are used to define the forms containing the 

parameters and constants. The .ini files are used to define the initialization 

forms while the .dis files are used to define the display variable forms. 

Model auxiliary files are text (ASCII) files, and can be edited with any text 

editor. By making changes to these files, you can modify initialization 

parameters and model constants and change the look of the menus that are 

displayed, and the text in those forms. You can also modify the model code, if 

necessary (contact Hydromantis for details). These types of changes involve 

changing the model library and will apply to all layouts created using this library 

(see the Customizing Libraries section in this chapter for details) 

Layout Files 

Layout files are specific to the layouts you prepare on the GPS-X drawing board. 

These include: 

• layoutname.usr 

• layoutname.var 

• layoutname.con 

• layoutname.ini 

• layoutname.cmd 

Where: layoutname is the file name you specify when you Save a GPS-X 

layout.
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Layout files are used to make changes to a specific layout. You can create new 

variables and equations, and define your own custom data entry and display 

variable forms. The .usr (user) file is used to enter modelling equations. The 

.con, .ini, and .var files are used to define custom forms for the new 

variables. 

Data Entry and Display Variable Forms 

In GPS-X, data entry and display variable forms, such as those shown in Figure 11-1 are 

created dynamically when you make a selection from the process data pop-up menu. 

 

Figure 11-1 – Data Entry (left) and Display Variable (right) Forms 

The numerical constants and text strings used in these forms are read from the model 

.con, .ini, and .var files. This makes it easy to customize GPS-X to display 

alternative labels in the data entry and display variable forms or to add entries in these 

forms.  

Table 11-1 shows which file to edit for the different GPS-X forms. When you make 

changes to these files in a GPS-X library, the changes apply to all newly created layouts 

that use that library. Therefore, it is a good idea to make a copy of the library you are 

modifying and make changes to this new library so that the original library is left 

unchanged. 
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Table 11-1 - Files to Edit for the Diffrent Forms 

To modify entries for: Edit the file with extension: 

model parameters or constants .con 

initial conditions .ini 

display variables .var 

Model Constants and Initialization Menus and Forms 

Changes to the values of model constants and initial conditions displayed in the entry 

forms can be made by editing the associated .con and .ini files. The first few lines 

of the CN library model constants file mantipft.con, which can be found in the 

\cnlib sub-directory, are shown in Figure 11-2. 

 

Figure 11-2 – Example of mantipft.con File 

When you display the data entry form for the physical parameters of the plug-flow tank, 

the text displayed for the tank volume is shown in this file as maximum volume. 

Similarly, the units are displayed as m3. 

Some parameters are “greyed-out” (made inactive) depending on the settings of other 

parameters in the menu. To make a parameter become inactive, include a semi-colon at 

the end of the line, followed by the parameter setting that would make the parameter 

active. The absence of a semi-colon at the end of the line is interpreted as meaning that 

the parameter should never be “greyed-out”. 

If you want to change the displayed text to maximum liquid volume, then you 

must edit this file and enter in the new text string. This modification is shown in Figure 

11-3. 

 

Figure 11-3 – Modified mantipft.con File 
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DO NOT change the units.  The algorithm calculations where these variables are used 

assume certain units (ie. they are the preset units displayed in these files). 

The flags !MORE and !NOMORE are used to define which variables are moved to the 

secondary data forms accessed through the More… buttons.  

If you make changes of this type to .con, .ini, or .var files in the library 

subdirectories, you must re-start GPS-X in order for the changes to take effect. GPS-X 

reads this information once during program initialization. To preserve the original files in 

a library directory, you should make a back-up of the files you intend to change. If you 

inadvertently delete or corrupt these files, GPS-X can always be re-installed.  

Display Variable Menus and Forms 

Display variable menus and forms are also customizable. A typical display variable menu 

is shown in Figure 11-4. The text that is displayed in the Output Variables sub-menu 

can be changed by making modifications to the associated .dis file for that object and 

library. 

 

Figure 11-4 – Output Variables in Process Menu 

 

Figure 11-5 – Output Variables File (mantipft.dis) 

Figure 11-5 shows the .dis file which is used to build the menu shown in Figure 11-4. 

A .dis file contains a line for each display variable point in an object. Each display 

variable point is associated with a physical location or flow stream on the real object 

being modelled. Model variables are defined for each of these points because, in general, 

the variable values are different.  
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For example, plug flow tank influent values are different from the effluent values. Each 

display variable point is signified by a special identifier. These are as follows: 

• in – input flow stream for all objects, except pfm 

• i1 – first input flow stream of pfm object 

• i2 – second input flow stream of pfm object 

• rin – recycle flow stream 

• o – output flow stream 

• p – pumped flow stream 

• s – underflow stream 

• g – gas flow stream from digester objects (dig) 

• l – internal 

The identifiers are listed first on each line of the .dis file to indicate that what follows are 

a list of .var files (ie. the filename excluding the .var extension) contained in the 

same directory that should be used to construct the Output Variables sub-menu at that 

display variable point.  

For example, the last line of Figure 11-5 is used to construct the menu shown Figure 

11-4.  Each of the six identifiers separated by exclamation points are used to construct the 

name of a .var file where GPS-X gets information on how to construct additional sub-

menus (if desired) and the display variable forms.  

In this case, the files are: 

1. compmlssvector.var 

2. statevector.var 

3. mantisint.var 

4. cfstr.var 

5. aer.var 

6. ini.var 

The format for a typical .var file is shown in below. 
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Figure 11-6 – Output Variables Submenu File (compmlssvector.var) 

By making changes to the .dis and .var files in the appropriate model library you can 

customize and add to the text and variable values displayed in GPS-X display variable 

forms. Examine the format of the existing files to gain an understanding of the structure 

of these forms. You can make changes to the original files, but it is best to first backup 

these files or copy the library files to a different directory.12  If you inadvertently delete or 

corrupt these files, GPS-X can always be re-installed.  

CUSTOMIZING LAYOUTS 

For every model prepared in GPS-X a special file, called layoutname.usr file, is provided 

for entering code. This code is inserted into the model during the build process. This provides a 

mechanism for defining new equations, secondary variables, modifying the initialization process 

and even extensive code additions to add new capabilities such as an automatic controller.  

The .usr file is created for every model constructed in GPS-X and is stored in the same 

directory as the model layout. 

A typical .usr file is shown in Figure 11-7.  The file is divided into five different sections, 

corresponding to the four explicit structure sections of the ACSL simulation language13, plus an 

additional section for entering ACSL macro definitions. You can enter FORTRAN-language 

statements in these sections to define new variables using existing variables as building blocks. 

 
12 If you decide to create a new library directory and want to use this library with GPS-X, you must select  

View > Preferences >Layout, and then choose the appropriate library from the Default Library drop-down menu. 
13 See Chapter 3, Program Structure of the ACSL Reference Manual for more information on the explicit program 

structure in ACSL. 
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Figure 11-7 – Empty .usr File 

User Defined Macros 

The user defined macros section is used to define your own ACSL macros that can be 

called in other sections of the user file. 

Initial Section 

The initial section is used for calculations that only need to be performed once before the 

dynamic simulation process starts. Any variables that do not change during a simulation 

can be calculated in the initial section. 

Derivative Section 

The derivative section is where you place your modelling equations (or calls to macros 

that set up the modelling equations). You can define differential equations here and have 

ACSL integrate them. Also, you can place algebraic equations in this section and have 

ACSL solve them. The derivative section is executed at every integration step taken by 

ACSL. 
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Dynamic and Discrete Section 

The dynamic and discrete section is used for defining discrete events that happen at 

certain intervals and for performing output related calculations (e.g. unit conversions). 

For example, you can define a discrete section using the ACSL keyword, discrete, that 

executes code at a certain defined interval or according to a schedule.  

You can perform calculations that only need to be performed at every communication 

interval. The communication interval is the interval at which data is transferred between 

ACSL and GPS-X for the purposes of recording results for output. Any statements placed 

in the dynamic and discrete section that are not enclosed within an ACSL discrete 

statement are executed at every communication interval. 

Terminal Section 

The terminal section is for calculations that only need to be performed at the end of the 

simulation. 

In addition to ACSL statements, you can enter FORTRAN statements in the user file. 

The .usr file provides an easy way to extend the simulation capabilities of GPS-X. The GPS-X 

user-interface is designed to be a generic front-end to the simulator module. Currently, GPS-X is 

designed to address unit process objects and models in wastewater treatment; however, it is 

possible to extend the process object table and model library to include other types of unit process 

objects and models, for example, those used in the water treatment field.  

The next example looks at how a simple model can be added to the layout using these 

customization features. 

Adding a Simple Model to a Layout – Example 

Adding new models can be accomplished by entering the necessary code in the 

layoutname.usr, layoutname.con, layoutname.ini, and 

layoutname.var files.  

For example, assume you wanted to model a simple first-order decay process such as: 

)(Crate
dt

dC
=  

A decay constant must first be defined so that you can set its value in the GPS-X 

interface. An initial condition for variable C must be specified. To define these variables, 

and their default values, edit the layoutname.con file so that it looks like the figure 

below.  
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Figure 11-8 – Example of a Simple layoutname.con File 

If you want to make a more complex .con file, copy an existing .con file from one of 

the libraries located in the GPS-X installation directory, and use it as a template. 

Next, enter the rate expression by adding the following lines in the Derivative Section of 

the layoutname.usr file: 

dc = rate*c 

c = integ (dc, ic) 

The order in which you enter these lines of code is not important since the translator 

module automatically re-orders the equations as appropriate. 

The completed .usr file should look like the figure below. 

 

Figure 11-9 – Example of a Simple layoutname.user File 
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To be able to display the new variable, C, enter the following line in the 

layoutname.var file: 

display c !concentration !g/m3 

The completed .var file should look like the figure below. 

 

Figure 11-10 – Example of a Simple layoutname.var File 

If you want to make a more complex .var file, copy an existing .var file from one of 

the libraries located in the GPS-X installation directory and use it as a template. 

Once these changes are made, you must re-build the model.  

When you run the model, the simulator module will evaluate the equations you entered 

into the Derivative Section at each integration time step.  

You can set up output displays using the variable c and, since it is a valid model variable, 

you can use it in the evaluation of secondary variables. 

The variables, including constants, initial conditions and those for display, that were 

setup in the .con, .ini, and .var files can be accessed in the User section of the 

General Data  menu.  

 

Figure 11-11 – Accessing the User Menu 

The Input Parameters item allows access to the data entry form containing the variables 

entered in the .con file.  

The Initial Conditions item allows access to the data entry form containing the variables 

entered in the .ini file. 
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And the Output Variables item allows access to the form containing the variables 

entered in the .var file. 

Customizing Libraries 

When you make modifications to GPS-X libraries, they apply to any subsequent layout 

prepared using the modified library. This is significantly different from the 

customizations described in the previous sections, which dealt with modifications to a 

specific layout only.  

Library customization is used when you want to make re-usable changes to the model 

auxiliary files.  

You can also make changes to the model code but this requires a detailed knowledge of 

the lower-level macros used in GPS-X. If you wish to modify the model code, contact 

Hydromantis for assistance. 

To successfully modify an existing GPS-X library, it is important to have some 

familiarity with the models in the library and in general the common basis on which 

GPS-X organizes these libraries. Before starting this type of customization, it is a good 

idea to read the material on libraries in the Technical Reference. 

The steps to complete a library customization are listed below: 

1. Choose the library to modify and copy the necessary files to a different directory. 

2. Modify the appropriate model auxiliary files (i.e. the .ini, .con, .dis, and 

.var files) 

3. Start GPS-X and re-build the model. 

Modify the auxiliary files as discussed in Model Constants and Initialization Menus 

and Forms, and Display Variable Menus and Forms sections in this chapter. 

Once the changes have been made, you can start GPS-X with the new modified library 

and build the model from the GPS-X interface. To use the new library select  

View  > Preferences > Layout and then choose the appropriate library from the Default 

Library drop-down menu. GPS-X will automatically find all libraries in the GPS-X 

installation directory. 

TROUBLESHOOTING 

Here are some guidelines to correct common problems that occur in model customization: 

• Errors in the model library can cause GPS-X to terminate upon loading. If, after creating 

a new model, GPS-X does not start normally, carefully check that all appropriate model 
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files exist and that they have the proper format. If you discover errors of this type, make 

the necessary changes and reload GPS-X. If you continue to experience problems, move 

the new files to another directory and try again. If problems persist, they are due to 

corrupt files in your library directory. Either re-copy all the library files from the 

appropriate library directory or if you are working within the original library directory, 

reinstall GPS-X from the original distribution media. 

• During compilation of a layout with new user defined code, any ACSL error messages 

will be reported in the Building Model window (see Figure 8-12).  You will not be able 

to run a model until these compilation errors are corrected.  See the ACSL Reference 

Manual, Appendix F for a list of the ACSL error messages. 

Common compilation errors include the following:  

Undefined variables   

Check that all of the new variables have been correctly declared in your model 

file and that any variable that is an input to the model is defined and assigned a 

value in the .con file 

Syntax errors 

The Building Model window may display the location of the error. In any case, 

check for typing mistakes and for lines which may exceed the 72 characters 

maximum. 

Re-computing a variable defined as a constant 

This means that one of the variables defined in the .con file has been placed on 

the left hand side of an equal sign somewhere in the model file. 

• Run-time errors may be reported (when the model is loaded) in the Command Window, 

including immediate termination of the model load process.  These are due to ACSL run-

time faults. Common causes for ACSL run-time problems include the following: 

Uninitialized variables, Division by zero. 

If the model remains loaded when these types of errors occur, try displaying the values of 

any new variables that you have created. In the Command line of the Command 

Window, issue the display command by typing ‘display x2’, where x2 is the name of any 

new variable you have defined. Press return to issue the command. The variable and its 

value should be displayed in the Command Window. Repeat this process until you 

discover a variable which is uninitialized (equal to 5.55e 33), or equal to zero (as division 

by zero may be the problem). You can correct this fault by modifying the uninitialized 

variable in the layoutname.con file or the layoutname.ini file. If the model 

does not load, then it will be necessary to de-bug the model independent of the GPS-X 

program.  



198 On-line Data Reading Tools 

GPS-X User’s Guide 

CHAPTER 12  

Units Conversion 

INTRODUCTION 

When using GPS-X, a better understanding of the plant can be gained if the units are presented to 

the user in a form that is consistent with data available at the plant. This is useful for preventing 

data conversion errors, and for allowing the direct use of measured plant data, regardless of the 

units used for measurement. To facilitate this, unit conversion is provided in GPS-X. This allows 

the user to select which unit will be used to present a particular variable or parameter. 

UNIT SYSTEMS 

Two systems of units are provided with GPS-X, an SI system and a US system. These systems of 

units define the default set of units that appear in all menus, input controls, and displays. 

Current Layout 

The desired unit system is saved for each individual layout.  The current system for the 

layout is displayed (and can be changed) via the Units drop-down menu on the Main 

Toolbar as shown below. 

 

Figure 12-1 –Unit System for the Current Layout 

Default for New Layouts 

The default system that newly create layouts will use is selected in the View > 

Preferences dialog on the ‘Layout’ tab. 

SELECTING INDIVIDUAL UNITS 

Almost everywhere a unit is displayed (both inputs and outputs), you click left or right click on it 

to change it to a different compatible unit. 
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UNITS DATA FILE 

All the unit conversion information in GPS-X is in a data file called "units.cvt". There are 

two main parts to this file. 

The first section is used to define the default system of units. The file provided with GPS-X 

provides a list of SI units and US units. The SI units listed in this first section of the units file 

must not be modified under any circumstances. The SI unit list must not be modified since it 

corresponds to all the internal GPS-X units. All changes in units are based on conversions from 

the default SI units to the unit of choice. 

The second section of "units.cvt" contains conversion factors to convert from the SI units to 

any comparable unit. The default list is quite comprehensive, but the user may add other unit 

conversions if desired. 

The file "units.cvt" is located in the /bin/gpsx/resources subdirectory of the GPS-X 

installation directory.  

Customizing a Unit System 

In the units files, the first section begins with the header:  

!SYSTEMS: SI US 

On each subsequent line in this section of the supplied data file, the first unit is the 

default SI unit. The second unit is used for the US unit system. Any text that follows an 

exclamation mark (!) denotes a comment and is ignored by GPS-X. 

You may edit the US unit system, but DO NOT change the SI unit system.  The unit in 

the US column must be compatible with the unit in the SI column.  The compatible unit 

groups are listed in the second section of this file. 

Adding New Unit Conversions 

If you want to add new conversion factors to make them available in GPS-X, you can edit 

the second part of the file.  You can either just add new units to existing groups or create 

your own groups. 

This section, which constitutes the remainder of the file, starts at the line: 

!CONVERSIONS: 

The conversions part of the file is divided into sections of equivalent units (e.g., the flow 

units are grouped together).  

Groups of similar units are separated by a blank line.  
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The first line in each group lists the default SI unit followed by the value of 1.  DO NOT 

edit this line in the existing groups. 

The remaining lines in each group contain units and their related conversion factors.  

The default file contains a comprehensive, though not exhaustive, list of units. Some 

units are presented in multiple formats (i.e., million US gallons per day is given as 

MGD(US)and Mgal/d(US)). The user may wish to add extended ASCII characters to 

the file to improve the appearance of the units (i.e., for m3/d you may wish to provide an 

option for m3/day). 

The conversion factor is what the new unit is multiplied by to convert it to the default SI 

unit.  

For example, the unit conversion factor for Mgal/d (US) is 3785.41, which means 

that 1 Mgal/d(US) is equal to 3785.1 m3/d. 

Special Case 

A special case format for unit conversions is used when the conversion between units is 

not a simple ratio.  This is really only the case for temperature. 

For example, to convert degrees Fahrenheit (F) to Celsius (C) requires the equation: C = 

0.55556 (F - 32) which is represented by the conversion factor 0.55556/32 in the units 

file. Note that the slash (/) is not a divider but a delimiter that separates the multiplier 

from the constant.  
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CHAPTER 13  

On-line Data Reading Tools 

The GPS-X On-line Data Reading Tools are very powerful tools that are relatively easy to configure.  In 

normal “off-line” mode, input data files are read only once at the start of a simulation.  This requires the 

user to wait until all of the data that will be used in the simulation is collected, convert them manually to 

GPS-X .dat files, and then do the simulation runs.  The ability to read data directly from on-line SQL 

databases is also described. 

CONTINUOUS READING OF TEXT FILES 

In on-line mode these .dat files are growing continuously, line by line, and GPS-X keeps 

monitoring and reading them at a specified sampling rate.  If a new line appears in the data file, it 

will be brought in to GPS-X (the file input controller updated or the data appears as a new point 

on the graph) and the simulation advances to the new time.  Thus, the simulation would be 

continuously updated with data arriving in real time from a plant SCADA system, and real time 

simulation of the plant would be achieved.  

The user would see a data/model difference from the very moment it starts to emerge, indicating a 

problem. An additional tool called "sigtrack", found in the toolbox object, could be used to set up 

alarms if the data, simulation, or the error between them goes beyond certain limits. 

An advanced on-line application (which would require the Dynamic Parameter Estimator, DPE) 

can do a real-time simulation and calibration/optimization simultaneously. In this way, the model 

calibration would be automated using the most up to date plant data. 

To access the On-Line settings, select Layout > General Data > System > Input Parameters > 

Simulation Tool Settings.   

 

Figure 13-1 – Accessing On-line Operation Settings 
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Scroll down to the On-line Operation section.  This is where you can turn on/off the on-line 

run mode (ie. continuous data reading and automatic simulation until the last point) and 

access additional settings under the More button. 

 

Figure 13-2 – Simulation Tool Dialog 

The main on-line operation parameters include: 

• wait for all data to synchronize:  It is possible that not all data is coming in at the same 

rate. If ON, all of the variables on file input controllers must have data before the 

simulation will continue. This is meant to deal with small discrepancies in instrument 

logging frequencies. 

• waiting period:  The simulation will pause while it waits for data to accumulate in the 

input data file from the source (i.e. SCADA system). It will then continue only after data 

arrives that corresponds to at least the current simulation time plus the specified waiting 

period. 

• sampling rate from data base:  The file system is checked for new data at the specified 

rate. The default rate is 60 seconds. 

Input data files are typically created by ‘bridge’ software that converts data from a format in a 

SCADA system to the format used by GPS-X. The format of online input data files is the same as 

the standard GPS-X input data files. For a complete explanation of the format see Using File 

Input Controllers in Chapter 6.  

In on-line mode, it is possible to run multiple simulations concurrently and transfer data between 

simulations where the output from one layout is used as input file to another. (i.e. one layout 

optimizes settling, and then the next one uses optimized settling parameters). Typically, GPS-X 

reads data files with the naming convention <layoutname>_<>_<date>.dat and produces 

output files with <layoutname>_<>_<date>.out. To be able to use files generated by 

other layouts, GPS-X provides a way to specify non-default named files. 
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The user can enter the name of the layout that generates the .out file in the text field next to the 

plant #1 name (for data file) label. Click on More… to be able to add up to 10 file names.  The 

layout would have to be rebuilt once the file names are entered (i.e. plant file names cannot be 

specified in a scenario).   

One application of this functionality is to use a previously calibrated layout of a particular plant to 

generate real-time data that would otherwise be generated and read in from a real plant SCADA 

system.  For example, if the previously calibrated layout name is realplant.lyt, then the plant #1 

(for data file) field would be specified as realplant.  The data generated by this realplant layout is 

then read in by a second layout running in a separate application of GPS-X according to the On-

Line Operation settings in the second layout.  In this way the user can simulate the on-line 

operation of GPS-X without having access to an actual SCADA system.  The second layout will 

ignore any data files which are created after the simulation begins.  Therefore, empty data files 

may need to be created prior to starting the online simulation to ensure that data is monitored and 

read in from the appropriate files. 

USING AN SQL DATABASE WITH GPS-X 

NOTE: The database feature requires the “Advanced Module” license. This feature also 

requires the appropriate JDBC driver for your database. GPS-X ships with 

drivers for the MySQL and Postgresql databases.  JDBC drivers are readily 

available for other databases.  Contact your database vendor for the driver for 

your system. To register any other driver with GPS-X, copy the appropriate 

JDBC jar file to /bin/gpsx/jar/ directory and restart GPS-X. 

After creating your layout, select File > Database Setup…. 

This will open a dialog where you can specify how to connect to your database, as shown in 

Figure 13-3. The form defaults to settings for the MySQL database system.  
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Figure 13-3 – Database Setup Dialog 

JDBC driver: A unique driver path for each database system. Examples are: 

• My SQL –  com.mysql.jdbc.driver 

• Postgresql -  org.postgresql.driver 

Database URL:  Specifies which particular database to connect to and where it is located (local 

or remote) and port number. Examples are: 

• MySQL -  jdbc:mysql://localhost:3306/<DB> 

• Postgresql -  jdbc:postgresql://localhost:5432/<DB> 

Replace localhost with an IP address or name if the database is not on the local system. Replace 

<DB> with the database name. If the database is on a remote system, make sure a firewall is not 

blocking the port for your database.



 

 

User Name and Password is required for your database system.  

NOTE:  If you select Remember Password, the password is saved in clear text. 

AutoConnect if you want the connection to the database to be opened when the layout is loaded. 

Next, click on the Table tab. Here, you will specify the database table name where your data is 

stored along with mappings between database keys and GPS-X variable names. You can specify 

that the data is stored in a table that matches the current GPS-X scenario name or in a specific 

table, as shown in Figure 13-4. 

 

Figure 13-4 – Database Table Information Settings 

The format of the data in the database table is time-stamped columns of data. The table’s primary 

key is ‘t’ (time in days), and each column represents one GPS-X variable (in SI units). The 

Table Form (see Figure 13-5) allows for the GPS-X cryptic name and database key to be 

mapped, if required. In the above example, they are identical.  



 

 

 

Figure 13-5 – Table Form 

After you have defined controls and graphs for your layout, right-click on the control and change 

the controller type to “Database” for the desired control item, as shown in Figure 13-6. The 

control will now work like the usual file input controller, except that the data will be read from 

your database. 

 

Figure 13-6 – Input Control Settings (selecting database) 

If you require your database data to appear on a plot, access the Output Properties dialog and 

change the Data Points source to Database as shown in Figure 13-7. 

 

Figure 13-7 – Output Properties (displaying database data)  



 

 

CHAPTER 14  

GPS-X Python Integration 

INTRODUCTION 

Python integration directly into GPS-X allows you to build and run custom Python scripts 

directly within GPS-X. By allowing custom scripts to be run in GPS-X, you can use the tools 

available in Python to extend what is possible in GPS-X. Well the applications of GPS-X are 

diverse, it may not always be built generally enough to provide the exact analysis or data 

visualization options you would like for your project. By using Python, you can do things such as 

create custom plots, introduce new types of statistical analysis and automate repetitive tasks in 

ways that are not possible using only GPS-X.   

This chapter covers the tools that have been built into GPS-X that allow you to control Python. 

The material includes an explanation of the Python dedicated menus in GPS-X as well as the 

custom Python commands that are recognized by GPS-X. 

In general, this chapter assumes a more advanced level of understanding of both the GPS-X 

system itself as well as the Python programming. To use what is presented in this chapter, it is 

helpful if you have and understanding of the following: 

• Python programing language  

• Java programming language 

• An understanding of how GPS-X preforms simulations 

Python integration is an optional feature in GPS-X. If you do not have the Advanced Tools 

package, please contact Hydromantis for information about pricing.  

THE PYTHON SCRIPT MANAGER 

The Python Script Manager is used as the interface between GPS-X and Python. This tool is 

where you add, remove and run Python scripts in GPS-X.  

The Python Script Manager is accessed through the Tools menu on the main menu bar. GPS-X 

must be in Simulation Mode to open the Python Script Manager. 



 

 

 

Figure 14-1 - The Python Script Manager 

To create a new Python file in GPS-X, press the New button on the Python Script Manger. This 

will open a file manager window where you can choose where to save the script and what to 

name it. GPS-X will automatically apply the .py extension to the end of the file to signify that it is 

a Python Script file. 

When a new file is created using the Python Script Manager, the path to the file will be added to 

the Included files section of the Python Script manager. 

The Python Script Manager can also be used to regulate the Python script pathways available in 

the current layout by using the Add and Remove buttons. 

EDITING PYTHON SCRIPTS 

When a Python script is selected in the Python Script Manager, pressing the Edit button will open 

the Python script in the Notepad text editor by default. An unedited GPS-X Python script file 

produced by GPS-X can be seen in Figure 14-2.  

In the Python file generated by GPS-X, four functions will be included that are recognized by 

GPS-X when a Python script is run by the Python Script Manager. These functions are: 

start() 

The start function is called exactly once in each simulation initiated by the Python Script 

Manager. The start function is executed at the start of the simulation before the first 

communication interval. 



 

 

cint() 

The cint function is called multiple times in a GPS-X simulation initiated by the Python 

Script Manager. The cint function will be executed at each communication interval in the 

simulation. A communication interval occurs at both the start and end of each simulation. 

 eor() 

The eor function is called exactly once in each simulation initiated by the Python Script 

Manager. The eor function is executed at the end of the simulation after the final 

communication interval. 

runSim() 

The runSim function in Python initiates a GPS-X simulation. A new GPS-X simulation will 

be started each time the runSim function is called in the Python script. 

For a complete list of all the Python functions recognized by GPS-X and their functionality, refer 

to Appendix A at the end of the Chapter. 

 

Figure 14-2 - Python Script File Generated by GPS-X Open in Notepad 



 

 

RUNNING PYTHON SCRIPTS 

Python scripts in GPS-X are run through the Python Script Manager. To run a Python script: 

 1. Ensure the Python script is selected in the Include files menu. The selected script is 

indicated by the file being highlighted blue. 

 
2. Press the Run Script button to have the Python Script Editor execute the selected script.  

 
3. At any time well the Python Script Manager is running a script, you can terminate the 

script by pressing the Abort Script button. 

 4. At the end of the simulation, any results printed in the Python script will be displayed in 

the Output menu of the Python Script Manager, which can be opened by clicking on the 

output arrow below the Run Script button. If an error is experienced while running the 

Python script, it will be displayed here. 

Additionally, output displays in GPS-X will retain the results of the simulation when the 

script has finished running, allowing you to navigate the simulation results in GPS-X 

directly. 

 Note: When rerunning a simulation the Remove all Variables button can be used to reset the 

variable values from memory.   

 

PYTHON SETTINGS 

 
In the Python Script Manager there is a button to access the various settings available for the 

Python instance used by GPS-X. This menu can also be accessed by going to View > 

Preferences on the main toolbar and selecting the Python tab. 



 

 

 

Figure 14-3 - Python Preferences Menu 

Python Distribution 

The user has the ability to specify which distribution of Python they would like to use in 

GPS-X. Python has two versions that are currently supported: Python 2 and Python 3. 

The GPS-X instillation includes both versions 2.7 and 3.7 of Python. By default Python 

3.7 will be set as the active Python distribution used by the Python Script Manager. The 

user can easily toggle between these two distributions from this menu. 

If you would like to use a Python distribution other than 2.7 and 3.7; selecting the other 

option will allow you to specify the distribution. You must provide GPS-X with a path to 

the instance of Python on your machine that you would like to use. 

 Editor 

When using the Python Script Manager to edit Python Script files in GPS-X, the file be 

opened in the Notepad text editor by default. GPS-X has the ability to use any text editor 

you would like. To set a new default, press the Browse button next to the Editor entry 

field and provide GPS-X with a path to the Python Editor you would like to use.     

JAR Classpath 

There are instances where even Python is too limited to achieve what you would like. 

GPS-X accommodates the use of Java JAR files in Python. To include JARs, you must 

provide GPS-X a pathway to the JAR files. To do this, press the Browse button next to 



 

 

the JAR Classpath entry field. You can provide GPS-X with either a path to a single JAR 

file or a folder of multiple JARs.   

 

 

 

 

 

 

 



 

 

APPENDIX A: GPS-X RECOGNIZED PYTHON FUNCTIONS 

Table 14-1 - GPS-X recognised Python Functions 

Function Parameters Description 

gpsx.getVersion() ̶ Returns the current version of GPS-X as a string  

gpsx.getLibraryName() ̶ Returns the current library name as a string 

gpsx.iconize() ̶ Minimize the GPS-X interface 

gpsx.getLytName() ̶ Returns the current layout name as a string 

gpsx.getSigDigits(ndigits) ndigits: int Sets the number of Significant Digits GPS-X 

reports 

gpsx.createReport(name) Name: string (optional) Generates an .xls report. If no name is specified, 

the file will be saved with the name 

(layoutnme+scenarioname.xls) 

gpsx.exit(error) error: int (optional) Forces the GPS-X interface to exit. If no error 

code has been specified, it will exit with error 

code 0. 

gpsx.setScenario(scenario) scenario: string Set GPS-X to use the specified scenario. The 

scenario can not be changed once the simulation 

has started 



 

 

gpsx.sendCommand(command) command: string Execute a command in the GPS-X command 

window 

gpsx.setTstop(tstop) tstop: int, float  Set the simulation duration to the value of tstop 

in days 

gpsx.setCint(cint) cint: int, float Set the simulation communication interval to the 

value of cint in days 

gpsx.setDelay(delay) delay: int, float Set the simulation delay to the value of delay in 

seconds 

gpsx.setSteady(steady) steady: boolean Enable/Disable steady state in the simulation. 

Steady State can not be changed once the 

simulation has started 

gpsx.writeToCommandWindow(text) text: string Write the text to the command window 

gpsx.resetAllValues() ̶ Resets all variables back to their values from 

when first entering simulation mode 

gpsx.resetSim() ̶ Resets simulation mode 

gpsx.startSim() ̶ Starts the simulation. This is an alternative to the 

runSim() function, but runSim() is preferred 

gpsx.interruptSim() ̶̶̶̶ Interrupts the running simulation 



 

 

gpsx.setAnalyzeMode(type) type: string  

One of: (‘steady state’, ‘phase dynamic’, 

‘time dynamic’, ‘montecarlo’) 

Set the simulation to analyze mode. You must 

specify one which Analyze method you would 

like to use. 

gpsx.setOptimizeMode(type, objfun) type: string  

One of: (‘Time Series’, ‘DPE’) 

objfun: string  

One of: (‘Absolute Difference’, 

‘Relative Difference’, ‘Sum of Squares’, 

‘Relative Sum of Squares’, Maximum 

Likelyhood’) 

Sets the simulation to optimize mode. You must 

specify the type of optimization you would like 

to preform and the objective function you would 

like to use. 

gpsx.setValue(cryptic, value, units) cryptic: string  

value: int, double, Boolean, string  

units: string (optional) 

Set the value of a layout variable. The unit value 

specifies the units of the value you are entering 

and must use the same format as GPS-X ie 

‘MGD(US)’. If units are not entered, it is 

assumed that the data is in the default units of 

US/SI units set in the GPS-X interface. 

gpsx.setValueAtIndex(cryptic, index, value, units) cryptic: string  

index: int  

value: int, double, Boolean, string  

units: string (optional) 

Set the value of an element of an array at the 

specified index. The unit value specifies the 

units of the value you are entering and must use 

the same format as GPS-X ie ‘MGD(US)’. If 

units are not entered, it is assumed that the data 

is in the default units of US/SI units set in the 

GPS-X interface 



 

 

gpsx.getValue(cryptic, units) cryptic: string  

units: string (optional) 

Gets the value of a layout variable. The unit 

value specifies the units the value will be 

returned in ie ‘MGD(US)’. If units are not 

entered, it returns the value in the default units 

of US/SI units set in the GPS-X interface. 

gpsx.getValueAtIndex(cryptic, index, units) cryptic: string  

index: int  

units: string (optional) 

Gets the value of an element of an array at the 

specified index. The unit value specifies the 

units the value will be returned in ie 

‘MGD(US)’. If units are not entered, it returns 

the value in the default units of US/SI units set 

in the GPS-X interface. 

gpsx.getArrayValues(cryptic, n, units) cryptic: string  

n: int (optional) 

units: string (optional) 

Gets all the values of an array variable and 

returns them as a list. If a value of n is specified, 

the function will return the first n elements of 

the array. The unit value specifies the units the 

value will be returned in ie ‘MGD(US)’. If units 

are not entered, it returns the value in the default 

units of US/SI units set in the GPS-X interface. 

gpsx.createAnalyzeCode() ̶ Creates code to perform an analyze mode run by 

scanning for controllers set to the Analyze 

control type.  Analyze results will be copied to 

the Windows clipboard  

 


